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1 Introduction

Practice Builder 1-2-3™ is a picture archive and communication system (PACS) and teleradiology system
used to receive DICOM images, scheduling information and text reports, organize and store them in an
internal format, and make that information available across a network via web and customized user
interfaces. Practice Builder 1-2-3 is for hospitals, imaging centers, radiologist reading practices and any
user who requires and is granted access to patient image, demographic and report information. Practice
Builder 1-2-3 provides information management and distribution services. The system is comprised of
acquisition components, a central system manager component, diagnostic and review workstation
components and an archiving component.

The sections that follow provide instructions on installing, configuring and using the Practice Builder 1-2-3
viewer. Operator instructions for all versions of the viewing application are contained in this document.

1.1 General Safety Information
Practice Builder 1-2-3 system components are not approved for direct patient contact applications.

Do not operate the Practice Builder 1-2-3 system components and associated cables in the presence of
moisture.

To avoid excessive product leakage and maintain product compliance to medical protective guidance
requirements, the PACS and workstations power cords shall be connected directly to hardwired AC
receptacles.

Federal law prohibits this device from being sold to or used by anyone other than a medical professional.
Do not carry the Practice Builder 1-2-3 system components by the connecting cables.

Follow all safety labels on the equipment.

1.2 Indications of Use

Practice Builder 1-2-3 is a PACS software product used to receive DICOM images, scheduling
information and textual report, organize and store them in an internal format, and to make that information
available across a network via web and customized user interfaces.

The Practice Builder 1-2-3 viewer software is intended for use as a primary diagnostic and analysis tool
for diagnostic images. Practice Builder 1-2-3 is for hospitals, imaging centers, radiologists, reading
practices and any user who requires and is granted access to patient image, demographic and report
information.

The Practice Builder 1-2-3 viewer displays images from CT, computed radiography, MRI, mammography,
nuclear medicine, PET, secondary capture, ultrasound, x-ray angiography, x-ray fluoroscopy and visible
light modalities.

Lossy compressed mammography images and digitized film screen mammography images must not be
reviewed for primary image interpretations. Mammography images may only be interpreted using an FDA
approved monitor that offers at least 5 mega-pixel resolution and meets other technical specifications
reviewed and accepted by FDA.

1.3 Patient Contact

The PACS system components are not approved for direct patient contact applications. The user must
follow hospital cleaning and decontamination policies and procedures.
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1.4 Product Safety

The Practice Builder 1-2-3 system has been classified as an acceptable application of use in accordance
with Medical Device regulations. The use of accessory equipment and/or hardware not complying with the
equivalent product safety and EMC requirements of this product may lead to a reduced level of safety
and/or EMC performance of the resulting system.

1.5 Contact Information

For more information concerning Practice Builder 1-2-3, or to report a problem with this manual or the
software, contact technical support.

1.6 Abbreviations

The following abbreviations are used throughout this document:

DICOM...... Digital Imaging Communications in Medicine
HL7 ........... Health Level 7
PB123....... Practice Builder 1-2-3

1.7 References

The information contained in this manual references information from other sources, including Practice
Builder 1-2-3's online help and other paper documents. Refer to the following sources of information for
additional details on Practice Builder 1-2-3 viewer and server components.

e Practice Builder 1-2-3 Operator Manual

e Practice Builder 1-2-3 browser’s online help
e Practice Builder 1-2-3 viewer's online help
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2 Getting Started

The Practice Builder 1-2-3 viewer is an application that displays diagnostic quality medical images for
review by radiologists, clinicians and other healthcare personnel. Access to the data generated during an
imaging procedure requires a validated user session. The information in this section provides instructions
for setting up your workstation for Practice Builder 1-2-3 and initiating a user session. The instructions
that follow assume you have access to a workstation that satisfies the minimum required configuration.

Practice Builder 1-2-3 viewers have the following system requirements:

System Requirement Specification

Operating System 32-bit or 64-bit Microsoft Windows 2000, XP or 7

Minimum RAM 512MB

Recommended RAM 1GB or twice the size of the largest study loaded into the viewer
at one time. 2GB if the fusion or AVI plug-ins are used.

Recommended graphics For default EP viewer, Direct3D 9.0 and PixelShader 2.0, or

controller features later versions.

Browsers IE 7.0 or later, Mozilla 5.0 or later

Network A networked PC with a connection to the Practice Builder 1-2-3
server

Practice Builder 1-2-3 consists of two viewing applications. They are the active-X viewer and the
standalone viewer. The active-X viewer is a viewing application a user downloads and installs on any
compliant workstation. The active-X workstation executes alongside other applications running on the
same workstation.

The standalone viewer is designed to operate without communicating with a Practice Builder 1-2-3 server.
This version of the viewing application is used almost exclusively from a removable CD or DVD, and
displays only the study information contained on the CD/DVD media.

Both viewing applications share the same graphical user interface and offer similar toolsets. With few
exceptions, the instructions for setting up and controlling these viewing applications are the same. When
the instructions for one differ from the other, this manual makes note of the exception and provides
specific details concerning the feature.

2.1 Workstation Setup

Before starting, the workstation must be removed from its shipping package, assembled according to the
manufacturer’s instructions, powered on, and configured to boot up and allow a user to log on.
Furthermore, this manual assumes the workstation has access to the local area network or the Internet,
whichever is required. If the workstation does not meet these minimum requirements, contact your system
administrator, computer manufacturer or ISP for further assistance preparing your workstation for Practice
Builder 1-2-3.

The Practice Builder 1-2-3 viewer executes on supported Microsoft Windows platforms. The default
workstation configuration is often suitable. The area that most often requires modification is the monitor
and its display controller. Practice Builder 1-2-3 supports single and multiple monitor configurations, and a
variety of bit depths and resolutions. The instructions in this section describe how to set up Microsoft
Windows monitors to run Practice Builder 1-2-3.

There are differences between Windows operating systems that may impact the information contained in
this manual. By default, all Windows operations are shown for Windows 2000.
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2.1.1 ADJUSTING MONITOR CONFIGURATION

Before initiating Practice Builder 1-2-3, make sure your Microsoft Windows monitor settings are
configured for the best results. Your workstation should be configured for a 32-bit color map or the
highest possible color map if 32-bit is not available. For a single landscape monitor, it is best to set the
screen resolution for each monitor to at least 1280 by 1024. Smaller resolutions are supported if
necessary.

prm—— o 2= V0 check or change the resolution on your Windows computer:

Backgiound | Screen Saver | Appeaance | Web | Effects  Seting: ]

» Open the display settings panel from the desktop by right
clicking on a blank area and selecting Properties. You can also
open the display setting window from the Windows Control Panel.

» Select the Settings tab.

» Adjust the resolution with the slider bar under Screen
Area. The recommended screen resolution is 1280 by 1024

pixels.

Fh v Py Mo crIDIA GeFsce2 Ulr > Set the Colors drop down to 32-bit color, or the highest
Colors = o possible setting.
(EPTIEETI - b > Click Apply, and then OK. When prompted to save the
| g (. 10028 b THE pesals . .

: I I settings, click OK.

Tecubleshoot Sdvanced
or_ | _ees | we || If you are using a display controller with its own setup page, click

on Advanced and then select the tab that corresponds to the
display controller. Follow the instructions in the display controller documentation to set up the monitor.

2.1.2 CONFIGURING MULTIPLE MONITORS

The Practice Builder 1-2-3 viewer supports one to four monitors. Each monitor can run at different
resolutions. It is possible to mix color and grayscale monitors as well.

Practice Builder 1-2-3 uses the Microsoft Windows display settings to identify the monitors. In the Display
Properties window, when more than one monitor is available, Windows labels them, starting with ‘1’ and
continuing up to the maximum number available. Use these numeric labels when configuring monitors in
Practice Builder 1-2-3 as described in section 4.1.1.

For multiple monitor configurations, you can set the display settings for multiple, independent Microsoft
Windows environments on each monitor, or a single Windows environment that spans across all
monitors. If you select the single Windows environment, you will have to configure the Practice Builder 1-
2-3 viewer so it knows to split its user interface properly across the monitors. Refer to section 4.1.1 for
information on configuring monitors in Practice Builder 1-2-3.

2.2 Accessing Practice Builder 1-2-3 Server

Practice Builder 1-2-3 is a web-enabled system that the user accesses with a web browser. As a result,
many of the familiar conventions you find when visiting other web sites are available in Practice Builder 1-
2-3. There is the home page, which is usually the first page you encounter when you gain access to the
server. Most of the system’s information is collected in a hierarchy of other pages that you access by
clicking on hyperlinks. You can click on the browser’s Back button to return to the previous page. You can
save a particular page in your Favorites folder. You can even create a link to the Practice Builder 1-2-3 on
another web page.

The Practice Builder 1-2-3 server is organized by a set of tabs displayed across the top of the browser
window. The specific tabs that are available to you depend on the privileges your system administrator
assigned to your user account. The first row of tabs provides access to the general functional areas.
Examples include Worklist, Administration and Archive. The Practice Builder 1-2-3 viewer is available to
the information displayed on the Worklist page.
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2.2.1 INITIATING A BROWSER SESSION

To use the Practice Builder 1-2-3 active-X viewer, you need a workstation connected to a network with
access to the Practice Builder 1-2-3 server, and a supported web browser. Launch the web browser and
enter the URL of the Practice Builder 1-2-3 server into the address line. The URL depends on your
facility’s configuration. If it is not configured as the browser's home address, ask your system
administrator for the URL. The URL can be a hostname or an IP address. The following examples are all
acceptable Practice Builder 1-2-3 URLSs:

pacs.hospital.com

http://pacs.hospital.com B G ore @3- B & - "
https://192.168.0.1 80 naganstot o v|Be s &-

When the browser reaches the Practice
Builder 1-2-3 server, it displays the Main
page. Figure 2.2-1 shows Practice Builder
1-2-3's default Main page. Note that your Snonto
main page may appear different due to SEADRACE
customization. User 0

Password:

Regardless of which URL you entered, Startin e RAD

Practice Builder 1-2-3 forces your M Your workflow solution-
connection to use secure HTTP if the

server is configured to provide secure
communications to your workstation. If
HTTPS is required, you may be prompted
to verify the digital certificate. You can find [&= LT—
instructions on how to accept the digital

certificate and save it as a trusted key in

your browser in the Practice Builder 1-2-3 Operator's Manual.

Info

Sign of

Ut ot hin. sysinem in rexiicasd ta
Suhoried users sy

2.2.2 SIGNING ON FROM THE BROWSER

To sign on to the Practice Builder 1-2-3 server, you must possess a unique user account, assigned by
your system administrator. The user account is used to identify you throughout the system. This allows
Practice Builder 1-2-3 to download your personal profile from the server, providing you with the same
custom interface regardless of your location. Practice Builder 1-2-3 also uses your account information to
tag your actions automatically, so you do not have to explicitly enter your identification information each
time you create, modify or delete data.

All versions of the Main page contain sign on fields on the left side of the page as well as a series of tabs
near the top and running the width of the page. The tabs are used to access different Practice Builder 1-
2-3 pages. Before you sign on, the only pages available are the Main page and the Info page.

Enter your User ID and password in the fields on Practice Builder 1-2-3's Main page.

EZZ;f;rdﬁL Note that both the User ID and password are case sensitive. By default, Practice
Builde_r 1-2-3 takes you to the Worklist page after it verifies your account information. If

you wish to go to a different page, chose your preferred starting point from the pull-

l% down menu just beneath the account ID and password fields. Click on Sign On, or

press the return key, to continue.

Instruction Summary — Signing On
» Launch Internet Explorer or other supported browser.
> Enter your Practice Builder 1-2-3 server URL from your Favorites list, or by typing the IP address
into the address textbox.
» Enter your User ID and password. Both are case sensitive.
» Click the Sign On Button.

Page 11



P Practice Builder 1-2-3
(eRAD Viewer Manual
2.2.3 SIGNING ON FROM THE VIEWER

It is possible to log out of Practice Builder 1-2-3 while a study is displayed in P
the viewer. You can explicitly request to log out from the browser, or the o
Practice Builder 1-2-3 can automatically log you out after a period of inactivity.

If the Practice Builder 1-2-3 viewer is open when this happens, a login prompt Hame: 1512
appears on your screen. To log into Practice Builder 1-2-3, enter the password Passtrd
for the account displayed in the Name field, and click Sign On. Note that both Carcel

the User ID and password are case sensitive.

If you want to change the user account, cancel the popup window, and log on from the browser, or use
the Sign On item in the File menu.

2.3 Installing the Practice Builder 1-2-3 Viewer

The different Practice Builder 1-2-3 viewer applications have slightly differing installation procedures. The
sections below provide instructions for downloading the viewer initially, and for upgrading to a new
version when one is available.

The active-X viewer requires specific user privileges from Practice Builder 1-2-3. These are defined in the
user account section of the Practice Builder 1-2-3 Operator Manual. Differences exist when downloading
the viewer setup package depending on the browser version or operating system you use. While the
wording or figures may be different than shown in this manual, the general procedure is the same.

To install an application on a supported Windows workstation, the Windows user account must have
Windows Administrator or Power User privileges. Sometimes it is easier to run the Practice Builder 1-2-3
viewer setup program as an administrator while logged on as the current user, rather than logging in as
an admin. For instructions on how to run the setup program as an administrator in Windows, see section
2.3.1.

2.3.1 ADMINISTRATOR ASSISTED VIEWER INSTALLATION

On Windows systems, your Windows user account must have administrator or power user privileges in
order for you to install the Practice Builder 1-2-3 viewer. In most cases, the system administrator will log
into Windows using an account with these privileges to install the viewer. Sometimes, it is easier to
instruct Windows to install Practice Builder 1-2-3 viewer with an administrator account’s privileges using
the current account. Windows provides this function with the Run As command.

To use the Run As command, you need to know the ID and password of an account with administrator
privileges, but you do not have to log out of Windows. Follow these instructions to install Practice Builder
1-2-3 using the Run As command.

1. Download the Practice Builder 1-2-3 viewer by selecting the Download Viewer tab on the
worklist page, and select to save it to your workstation.

2. Locate the file, eradsetup.exe, using Windows Explorer, the Microsoft Management
Console (MMC), or the Control Panel.

3. Press and hold down the SHIFT key as you right-click the file icon, and select Run As from
the popup menu.

4. In the dialog box, select the option Run the program as the following user, and enter the
user name and password of a Windows account that has administrator privileges.

5. Click OK to start the installation process.

The install process proceeds as described in the section detailing the installation procedure for the
specific viewer you are installing or upgrading.
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2.3.2 INSTALLING ACTIVE-X VIEWER

To download and install the Practice Builder 1-2-3 active-X viewer, your Practice Builder 1-2-3 user
account must have Open privileges, which your system administrator can assign to you. If you have Open
privileges, Practice Builder 1-2-3 checks for the viewer on the workstation and attempts to install it
automatically if it is not found.

After logging onto Practice Builder 1-2-3, go to the Worklist page. A popup notice may appear on the
screen. If you do not have Windows administrator rights, the notice informs you that the viewer is
unavailable and instructs you to contact the system administrator to download and install a copy onto the
workstation. If you have Windows administrator rights, the notice prompts you to download and install the
latest viewer. When you consent to the upgrade, Practice Builder 1-2-3 downloads the viewer and
invokes the installation wizard. Depending on your version of Windows, you have the option to download
and store the Practice Builder 1-2-3 setup file and activate it manually, or download and activate (Open) it
when complete. There is no need to save the setup file to disk. Select to open the file when the download
completes.

In some instances, Practice Builder 1-2-3 initiates the viewer installation process without prompting the
user. This occurs when the workstation is running certain versions of Microsoft Windows and when using
certain versions of Microsoft Internet Explorer. When the download completes, the installation wizard
starts automatically.

To manually download and install a copy of the Practice Builder 1-2-3
viewer, click the Download Viewer tab in the second row of tabs under the
Corrections @ Worklist tab. Practice Builder 1-2-3 downloads the viewer and invokes the
installation wizard. If prompted, chose to open the file when the download

- Admin

completes.

The Practice Builder 1-2-3 installation wizard takes you through the installation process step by step.
Figure 2.3-1 shows the initial screen of the installation wizard. The process is as follows:

1. The installation wizard launches. Read the EEErrR =IEIx]
panel, take any necessary actions. Press the
Ctrl and Esc keys simultaneously to view the
task bar if you need to quit any other
applications. It is not required to quit the
browser. Click Next.

2. Read the License Agreement, check the box to
accept the terms, and click Next.

3. If the default location for Practice Builder 1-2-3
is acceptable, click Next. Otherwise, select a
new location and click Next.

4. Click Finish when the install is completed.

Welcome to the eRad PACS Viewer Setup
Wizard

The Setup Wizard will install eRad PACS Yiewer on your
computer, Click Next to continue or Cancel ko exit the Setup
Wizard,

ERAD

Back I O hest I Cancel

The viewer automatically starts. Its icon, & appears in
the system tray. If it didn’t start, either open a study or
manually start the viewer by selecting it from the
Program Files menu under the Start button in the task
bar.

Instruction Summary — Downloading the Viewer
1. Log onto the Practice Builder 1-2-3 server and go to the Worklist page.
2. If prompted to download the viewer, click Yes. Otherwise, click the Download Viewer tab.
3. If prompted to save or open, select Open. When the download completes, select Open to
run the setup program.
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4. Installation wizard takes you through the setup. Accept the terms, click on the Next button to

advance, and click Finish to complete.
5. Single-click on a patient name to launch the viewer and load the images.

2.3.3 INSTALLING STANDALONE VIEWER

The Practice Builder 1-2-3 standalone viewer is used most frequently to display images stored on
removable DICOM media such as a CD or DVD. You can create removable media containing images,
results, and an application to display them by following the instructions in the Practice Builder 1-2-3
Operator’'s Manual. The information in this section assumes the media was created according to the
instructions in that manual.

The Practice Builder 1-2-3 standalone viewer doesn't get installed on the workstation. Instead, it loads
directly from the media. Load the media onto your workstation. If you have the Windows auto play feature
enabled, the standalone viewer automatically launches itself. If you have disabled auto play from
launching the standalone viewer, start the viewer manually. Open a Windows Explorer window and
browse through the removable media drive for the file named pbcdview.exe. Click OK to start the Practice
Builder 1-2-3 standalone viewer.

If a copy of the Practice Builder 1-2-3 active-X viewer resides on the same workstation, the Practice
Builder 1-2-3 standalone viewer does not affect it. In order for the standalone viewer to execute properly,
the media must remain in the drive at all times.

Note: Removing the media from the drive when running the Practice Builder 1-2-3 standalone viewer may
cause the application to lock up. While the application is loaded, the media must remain in the drive at all times.

2.3.4 UPDATING THE ACTIVE-X VIEWER

Upgrades to Practice Builder 1-2-3 take place on the server. The workstation learns of an upgrade the
next time a it communicates with the server. This communication takes place when a user logs on to
Practice Builder 1-2-3, or even in the middle of an existing user session.

The first time you refresh your worklist after a Practice Builder 1-2-3
upgrade, a popup notice may appear on the screen for users with
Windows administrator rights. The notice asks if you want to download our eRAD PACS Yiewer Diagnostic Yiewer
and install the latest viewer. Perform the upgrade as soon as possible. Plugh s not up to date.

The option to skip an upgrade is available so you can download and Update to 5.2 [Build 02.B]?
install it when convenient. If you clear the notice without installing the
viewer, Practice Builder 1-2-3 will prompt you once each day until you L
do upgrade.

eRAD PACS Viewer

When you consent to the upgrade in this manner, Practice Builder 1-2-3 downloads the viewer and
invokes the installation wizard. Follow the prompts on the screen to complete the upgrade.

For users without Windows administrator rights, the upgrade procedure is performed from the viewer
itself. After opening a study, the viewer checks for a newer version. If one exists, a popup window
prompts the user to download it. Check the box labeled Upgrade Practice Builder 1-2-3 Viewer version N,
and click OK. Then proceed to work on the opened study. When you are finished and close the viewer,
the upgrade procedure starts. Follow the prompts on the screen to complete the upgrade.

On occasion, a Practice Builder 1-2-3 viewer upgrade is mandatory in order for it to communicate with the
upgraded server. When this condition exists, the prompt to upgrade is not displayed. The download and
install process initiates immediately when you access the worklist the first time after the server has been
upgraded.
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2.4 Uninstalling the Practice Builder 1-2-3 Viewer

To remove the Practice Builder 1-2-3 viewer from your workstation, use the Windows Add/Remove
Programs tool.
1. Open the Windows Control Panel. From Start, select Settings and then Control Panel.
2. Click Add or Remove Programs.
3. Select Practice Builder 1-2-3 Viewer on the list and click Remove. Follow any prompts that
appear.
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3 Viewer Overview

All versions of the Practice Builder 1-2-3 viewer contain the same basic components. They consist of the
main screen workspace, which contains the area for displaying images, the menu bar, the docked
toolbars, the thumbnail panel and the status bar. Figure 3-1 illustrates the basic parts of the Practice
Builder 1-2-3 viewer.

Image
frame

ar / view

The sections in this chapter provide information on the many components and constructs that make up
the Practice Builder 1-2-3 viewer.

3.1 Toolbars

There is an assortment of toolbars in Practice Builder 1-2-3 viewer. Most of the toolbars are available
from the main viewer workspace. A few are specific to one or more popup windows that you can display
at various times when using the viewer. The toolbars are defined as follows:

Standard Basic study and file control tools
Toolbox Cursor modes and general viewer control tools
Orientation Image orientation tools
Window/Level Window width and center controls
Annotation Annotation modes

Grid layouts General grid layouts

Tile layouts Tile modes for each frame in a grid
Templates Hanging protocol template controls
Report formatting Format report text

Cine controls Cine display controls

Link controls Frame linking controls

Audio controls Audio controls for dictation tools
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Status bar Dynamic status information

From the View menu, select the Toolbars item to display a list of available toolbars. If a check appears
next to the label, the toolbar is displayed in the main workspace. The toolbar is either docked to the
workspace’s border, or floating as a detached window somewhere on the monitor. Display toolbars on a
more permanent basis by selecting them in the Settings panel in the Customize Settings window. (See
section 4.1.1 for more information.) To hide a toolbar, select the item from the Toolbar item in the View
menu to remove the check mark, or uncheck the setting on the Settings panel in the Customize Settings
window.

Some toolbars are also available in different Practice Builder 1-2-3 viewer panels. To display a toolbar in
the respective panel, select the toolbar from the View menu item in the panel. For more information, refer
to the section in the manual that discusses the specific panel.

To relocate a toolbar in the Practice Builder 1-2-3 viewer’'s main workspace, click the surrounding gray
area and drag the toolbar to the desired location. To dock a toolbar to the workspace border, click and
drag it back to any location outside the main image area. The toolbar snaps back into place.

To show/hide a toolbar for this session only:
1. From the View menu, click on Toolbars, and select the toolbar you want to display. A
checkmark appears by the name when the toolbar is displayed on your screen.

To show/hide a toolbar for this and future sessions:
1. Select Customize Settings from the Settings menu.
2. Click the Settings tab to view the setting panel.
3. Inthe Toolbars section, click the checkbox to insert a check mark for the toolbar(s) you want
to display.
4. To hide a toolbar, click the checkbox to clear the check mark for the toolbar(s) you want to
hide.

3.1.1 STANDARD TOOLBAR

The Standard toolbar provides tools for opening and closing studies. It contains buttons to
w | display a list of studies available for display, close a study, open the next and previous
studies, bookmark the current study, and restore a bookmarked study. By default, the
E{; EE Standard toolbar is not displayed on the main screen. To display the Standard toolbar, select
Standard from the Toolbar item in the View menu at the top of the main screen. All the
Eﬂ functions controlled by the buttons on the Standard toolbar are also available from the File
menu, and in some cases via hot key sequences.

Function Button Menu ltem Hot Key Description

Show study list View->Study Panel F2 Display the list of available studies. In the
active-X viewer, this function displays the
browser’s worklist. In the standalone viewer
and in registered active-X viewers, this
function displays the Study List panel.

|

Close study 4 File>Close study Close all the studies that are currently
loaded in the viewer.

Bookmark study * File->Bookmark Ctrl-Alt-B Save the display state of the current study

H or studies, and allow the user to open a new

study. Refer to section 5.1.5 for more
information. All works in progress, including
report, dictation, key images, and
annotations are preserved. Bookmarking is
recursive, using a last-in, first-out order.

Restore book- File->Restore Ctrl-Alt-R Close the current study and restore the last
marked study = bookmarked study.
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Function Button Menu ltem Hot Key Description

Open next study EE File->Open next study Ctrl-Alt-Up Open. the next study on the user's active
H=l worklist.

Open previous ‘=w| File>Open previous study Ctrl-Alt-Down Open the previous study on the user's

study E; active worklist.

3.1.2 TooLBOX TOOLBAR

The Toolbox toolbar provides tools

for setting the Practice Builder 1-2- IE@'J U|3£|"‘-‘tl:‘% | | | | | | | | 4"|é'53|
3 viewer's cursor mode, adjusting

the image magnification ratio, resetting the display characteristics of an image frame, and displaying the
report panel. The various buttons are grouped into two main groupings, the cursor modes and the display
characteristics. To display the Toolbox toolbar, select Toolbox from the Toolbar item in the View menu at
the top of the main screen. The functions available in the Toolbox toolbar are also available from the
Settings and Tools menus, and in some cases via hot key sequences.

Function Button Menu Item Hot Key Description
Normal mode L\\b | Settings>Cursor>Normal  Ctrl-N This is the general cursor mode, used to select an
image or object within the display. Refer to section

3.9.1.1 for more information.

Magnify mode Q Settings>Cursor>Magnify  Ctrl-M Magnify the image. Left-click to apply an

automatic zoom factor. Right-click to define a
zoom region. Refer to section 3.9.1.2 for more
information.

Key image Settings—>Cursor->Report Attach the selected image along with its current
mode attachment display settings and annotations to the report.
Refer to section 3.9.1.3 for more information.

Link mode Settings>Cursor->Cine link Link one or more image frames together. Double-
click the Link mode button to automatically link all
related frames. Single-click the Link mode button,
and then click and drag the cursor between two
frames to manually link the data. Refer to section

3.9.1.4 for more information.

IE

ROI with W/L
mode

Settings—>Cursor->ROlI with Define a region of interest and apply the

Wi/L calculated window/level curve within it to the
image(s) in the frame. Click and drag the mouse
to define the region of interest. Drag the region
around to position it. Refer to section 3.9.1.5 for
more information.

ra

Crop mode Settings—> Cursor->Cropping Remove extraneous information from the viewable
image in the frame. Click and drag the mouse to
define the area to keep. Resize the area by
dragging the region’s borders. Double-click on the
image to restore the original image. Refer to

section 3.9.1.6 for more information.

ISy

Magic X mode Settings—> Cursor->Magic X Locate a defined point in one image on all other
images that share the same frame of reference.

Refer to section 3.9.1.7 for more information.

|

Magic glass View>Magic Glass Alt-M Display a floating magnifying glass for zooming in
mode on the image data behind it. Refer to section
3.9.1.8 for more information.

]

Fit image to Tools>Zoom->Fit to window Ctrl-F Fit the selected image to the size of the frame.
window e This is also useful to reset the image size after
using magnification and cropping tools.

A
]
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Function Button Menu ltem Hot Key Description

Actual image EE' Tools>Zoom—>Actual size  Ctrl-Alt-A Display the selected image at its real-world size.

size When active, the zoom mode renders the images
in real-world size. When inactive, the zoom mode
will render the images in pixel size, matching an
image pixel to a monitor pixel. Refer to section
5.5.5.4 for more information. For actual size zoom
mode to work, both the monitor and the image
need to be calibrated. When you first enable
actual size zoom mode, you are automatically
prompted to confirm the monitor calibration. If the
selected image does not already contain pixel size
and spacing information, you are also
automatically prompted to define it.

Reset image x| Tools>Reset->Image size Display the selected image with no magnification

size O or interpolation of any kind applied. The resulting
image contains only original pixel values.

Reset image v | Tools>Reset>Image Reset the image(s) in the selected frame to the

position L position original position, which usually means centered in
the image frame.

Reset image ¢ Tools>Reset>Image Reset the image(s) in the selected frame to the

orientation i_ orientation original orientation.

Reset image .. X|  Tools>Reset>Window/Lev Reset the image(s) in the selected frame to their

window/level el original window and level setting.

Invert |:|"*|| Tools—>Invert Invert the slope of the applied window/level curve.

grayscale

Cololr/grayscal Tools>Grayscale Toggle Ithe applied palette between color and

e palette grayscale.

Open report ’ View>Report Panel F8 Display the full size report panel. Note that the hot

panel B key displays the last report panel (full or compact)

used. Refer to section 3.6.3 for more information.

3.1.3 ORIENTATION TOOLBAR

J | 222

The Orientation toolbar provides tools for flipping and rotating images. To
display the Toolbox toolbar, select Orientation Tools from the Toolbar item in
the View menu at the top of the main screen. The functions available in the

Orientation toolbar are also available from the Tools menus, and via hot key sequences.

Function Button Menu Item

Hot Key Description

Flip horizontal 1Y Tools->Transform->Flip horizontally Ctrl-H Flip image(s) in selected frame horizontally.
Flip vertical . | Tools>Transform->Flip vertically Ctrl-U Flip image(s) in selected frame vertically
=
Rotate right + Tools-> Transform->Rotate right Ctrl-R Rotate image(s) in selected frame to the
= right 90°.
Rotate left +.| Tools>Transform—->Rotate left Ctrl-L Rotate image(s) in selected frame to the
- left 90°.
Flip overlay s Tools->Transform->Flip image info Flip the text overlay horizontally.
text = =

3.1.4 WINDOW/LEVEL TOOLBAR
The Window/Level toolbar

provides tools for adjusting | Window | 214
an image’s window center

J— Lewvel W '—J— Im Save |

and window width. The toolbar consists of text boxes for reporting the current window/level settings and
explicitly defining them, sliders for quickly adjusting them, and a text box for creating and applying preset
window/level settings. To display the Window/Level toolbar, select Window/Level from the Toolbar item in
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the View menu at the top of the main screen. Adjusting the window and level setting is also available
through mouse controls.

The left slider bar controls the window width. The right slider bar controls the window center. The drop-
down menu allows you to select a predefined window/level settings and create a label for the current
settings. Some defaults always exist, including Initial, and Actual Range. See section 4.3.1 for information
on creating and applying preset window and level values.

3.1.5 ANNOTATION TOOLBAR

‘_ " The Annotation toolbar provides tools for adding
ﬂ “*“|-’—'.(-|:[|®|DIQ|°\| T|133| 3 | graphics and measurements to images. You can add
annotated text to a key image attached to a report,
identify a specific region of interest (ROI), and calculate the average Hounsfield unit within a region of
interest. In addition, you can draw pointers to a specific viewing area within an image, and use the
measuring tools for determining the distance and angle between two points on an image. To display the
Annotations toolbar, select Annotation Tools from the Toolbar item in the View menu at the top of the
main screen. The functions available in the Annotation toolbar are also available from the Settings

menus, and via mouse controls.

Function Button Menu Item Description

Annotation ﬁ:-? | Settings>Cursor>Annotation> General annotation mode, used for adding new

mode Select annotation, and for selecting existing ones for editing and
deleting. When in this cursor mode, spin the middle
mouse button to flip through the individual annotation
tools. Refer to section 6.1.5 for more information.

Distance | Settings>Cursor>Annotation> Perform linear measurements. The image must be

measurement Measure distance calibrated in order for the results to appear in units of
distance.

Angle e Settings—>Cursor->Annotation> Perform angular measurements.

measurement : Measure angle

Cobb angle ;IJ Settings>Cursor->Annotation> Calculate and display a Cobb angle.

measurement == Measure Cobb angle

Hounsfield & Settings—>Cursor->Annotation> Calculates and displays the average pixel value within the

value Hounsfield value defined area.

Region of ) Settings—>Cursor->Annotation> Calculates the area within the defined region of interest.

interest area Region of interest The image must be calibrated in order for the results to
appear in units of area.

Free form 'C:J Settings—>Cursor->Annotation-> Calculates the area within the defined region of interest.

region of Freehand region The image must be calibrated in order for the results to

interest area appear in units of area.

Add pointer n\‘ Settings>Cursor>Annotation> Add a point graphic and an optional text string to the

Pointer image.
Add text T Settings—> Cursor->Annotation-> Define a text string and place it on the image.
Text

Key image 1% Settings—>Cursor->Annotation> Display a sequential number on the key image. This

index number Report figure number annotation tool is available only when applied to a key
image in the report panel.

Spine labeling l Settings>Cursor->Annotation> Display labels identifying vertebral disks and interspaces.

tool B Spine labeling tool

3.1.6 GRID LAYOUT TOOLBAR

The Grid Layout toolbar provides preset matrices for
displaying series in the main viewing workspace.
This toolbar is available by default in the layout
manager, and can be displayed in the main viewing area as well. The majority of the preset matrix options

05| m|s|m| 6| ||| =] |
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split the screen into symmetrical groups of image frames. The custom grid button, Q pops up a window
so you can define a custom grid by specifying the number of rows and columns you want to appear in the
workspace area. The button is used to apply a single grid layout across multiple monitors. For
example, if you use a 1-up grid layout with a 12-up tile layout, you get 12 images displayed on the current
screen, similar to a sheet of film displaying CT images. If you want the 12-up to continue onto a second
monitor, select the span multiple monitor button, and the second monitor displays the second set of 12
images.

To display the Grid Layout toolbar, select Grid layouts from the Toolbar item in the View menu at the top
of the main screen. In the layout manager, select Grid layouts from the View menu.

3.1.7 TILE LAYOUT TOOLBAR

The Tile Layout toolbar applies a tile pattern to a selected frame, controlling the number of
B Il| images displayed in the frame. This toolbar is available by default in the layout manager, and
m|mm| can be displayed in the main viewing area as well. With a 1-up tile mode, the image frame
displays the images in stack mode, facilitating cine operations. For any other tile mode, the
m| 2| specified number of images appears in the frame. When you scroll through the images, one
image is removed from the displayed set, the remaining images shift up or down, and one
image is added. The custom tile button, B, allows you to define a custom tile setting by
| B specifying the number of rows and columns you want to appear in the workspace.

To display the Tile Layout toolbar, select Tile layouts from the Toolbar item in the View menu at the top of
the main screen. In the layout manager, select Tile layouts from the View menu.

3.1.8 TEMPLATE TOOLBAR

The Template toolbar contains a list of available hanging
|MH Lumbar 5pine j Hl %l protocol templates and template sets. To display the Template
toolbar, select Templates from the Toolbar item in the View

menu at the top of the main screen. In the layout manager, select Templates from the View menu.

To apply a template to the loaded study, click the pull-down list and select the template. To save the
current layout as a template, click in the text box, enter the label, and click to save. To create a hanging
protocol set, click the create HP set button, select the templates to add to the set, enter a label, and save.
To advance to the next template in an applied set, click the next HP set button.

Function Button Description
Save u Save the current layout as a hanging protocol template.

Create HP set % Create a hanging protocol set from existing hanging protocol templates.

Modify HP set % Edit an existing hanging protocol set.

Next HP set q} Go to the next template in this applied hanging protocol set.
Previous HP % Go to the previous template in this applied hanging protocol set.
set

iz =

3.1.9 REPORT FORMATTING TOOLBAR
AD =(0OB

|F0rmat JlFont JISIIE!J B 7 U s | 5 x, ] E H @
The Report Formatting toolbar exists in the report panel, and contains text format controls. The available
controls are the text font type and size, bold, italic, underline, strikethrough, superscript, subscript, text
alignment, bulleted and numbered lists, indentation, color, separator, tables and show encoded source.
The formatting toolbar appears above any rich-text area, such as the report’s observation area.

11
1
Ty
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i

Page 21



((e RAD Practice Builder 1-2-3
' Viewer Manual

3.1.10 CINE CONTROL TOOLBAR

The Cine toolbar provides controls for automatic playback of a cine
J Flay lﬂ!l Speed ——— loop. This toolbar consists of a Play/Stop button, speed controls

prerrrrre and a loop direction control. To display the Cine toolbar, select
Cine control from the Toolbar item in the View menu at the top of the main screen. The Cine toolbar is
also available from the Cine menu, along with menu items for the functions found on the toolbar.

3.1.11 LINK CONTROL TOOLBAR

The Link toolbar provides controls for linking one
[ Auto Lnk1 ~| [ Mimor | Magicgless | Unhook | or more image frames together. Section 5.4.3
contains information on creating and using links.

To display the Link toolbar, select Link controls from the Toolbar item in the View menu at the top of the
main screen. Link controls are also available from the mouse.

Function Field Description

Auto link state Auto Auto link state is active. Series automatically link when loaded into image
frames.

Link group <pull down list> The link group assigned to the selected frame.

Mirror mode Mirror The cursor movement in linked frames mirror each other.

Magic glass mode Magic glass Each linked frame displays a Magic Glass panel.

Unhook link Unhook Temporarily suspend link functions for the frame.

3.1.12 Aubio CONTROL TOOLBAR
The Audio toolbar

on the full report ‘lIIOﬂ J| 3
panel provides
controls for recording and playing back dictation.

1.00

L

t

c
=
o

Function B
Record

n Menu Item Description
Audio>Record audio  Start and stop recording.

Audio>Record audio  Activate third-party speech recognition system by
writing the XML control file to the configured location.

Audio>Record audio  Activate third-party speech recognition system by

Activate speech
recognition
Activate speech

i ([0 o

recognition and writing the XML control file to the configured location

record dictation and start and stop recording dictation.

Play ﬂ Audio~>Play audio Play the recording from the current position, or from
the beginning if already at the end.

Pause ﬂ Audio-> Stop audio Pause the recording at its current position.

Delete ﬁ Audio>Delete rest Delete from the current position to the end of the
recording.

Position e The position in the recording in seconds

Speed [ The playback speed. A value of 1.00 replays at

the acquired rate. Slow down/speed up
playback by shifting the gauge to the left/right,
respectively.

The strength of the input signal the software is
receiving. If an acceptable level is detected, the
gauge displays green. Otherwise, no data is
being recorded.

Strength
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3.1.13 PRESENTATION TOOLBAR

The presentation toolbar provides access
to a number of image presentation tools.
To display the presentation toolbar, select

4 X %
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Presentation tools from the Toolbar item in the View menu at the top of the main screen.

Function Button Menu Item Hot Key Description
Show all localizer ﬁ] Settings—>Localizers> Show F12 Display the localizer line(s) of selected
lines localizer lines on all images images on orthogonal images
Hide all localizer |;E;§| Settings—>Localizers>Hide F12 Hide localizer lines
lines localizer lines on all images
Show all hash % Settings>Localizers>Show  Alt+F12 Display the localizer lines for all images in
marks hash marks on all images the selected series on orthogonal images
Hide all hash marks ‘% Settings—>Localizers>Hide Alt+F12 Hide all localizer lines

hash marks on all images
Show image info View->Show image info F10  Show/hide the demographic overlay data
Show scout @ View->Show scout overlays  Ctrl+F11 Show/hide scout images a overlays on
overlays select images in an image frame
Show orientation |L_"n| View->Show orientation F11 Show/hide the orientation markers on

images in an image frame

Show orientation ‘@ Alt+F11 Show/hide the orientation cube on images
cube in an image frame
Step scale rulers fsc| View->Show scale Ctrl+F10 Show/hide the scale rulers in image frames
Show annotations ‘ﬂ View->Show annotations F9 Show/hide annotations
Show |E| Show/hide mammography CAD markers
mammography CAD
Show overlays View->Show overlays Ctrl+F9 Show/hide image overlays defined for

images displayed in an image frame

Show presentation
state overlays

Show/hide presentation state details
(overlays, annotations, etc.) for images
displayed in an image frame

Create presentation T
state

File->Create presentation
state

Create a presentation state from the
selected image(s).

3.1.14 MACRO TOOLBAR

The macro toolbar provides access to the macro manager panel and tools for recording
macros. Display the macro toolbar by selecting Macro Tools from the Toolbar item in the

oM

Function
Start recording

View menu. The macro tools are also available from the Settings menu’s Macros submenu.

Menu ltem
Settings—>Macros-> Start recording

Button
o|

|

Show macro manager Iﬁ

Description
Start recording input sequence.

Stop recording Settings—>Macros-> Stop recording Stop recording input sequence.

Settings->Macros->Macros... Display the macro manager panel.

3.1.15CTRM TOOLBAR

The CTRM toolbar provides access to the critical test results management tools. It consists of a
(EH single button that launches the CTRM panel. The CTRM toolbar exists if the server is licensed for
CTRM support and the user is assigned the CTRM user permission.

For details about the CTRM feature, refer to the Radar Critical Test Results Management section.
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3.1.16 STATUS BAR

The Status Bar displays status messages as Practice Builder 1-2-3 performs some action. The status bar
location is fixed, at the bottom of the screen. It displays the current working state, the loading progress,
and the coordinates of the cursor in an image. Section 3.4.1 explains the information available on the
Status Bar.

3.2 Menus

The Practice Builder 1-2-3 viewer menus at the top of the application window organize all of the functions
and configuration tools. The list includes the File menu, View menu, Settings menu, Tools menu, Cine
menu, Collaboration menu, and the Help menu. Additional menus may exist depending on the plug-in
modules Practice Builder 1-2-3 loads when it initializes. An example is the Post-processing menu.
Information on conditional menus is available in Chapter 7. Other menus exist in the different Practice
Builder 1-2-3 panels, although many of them are repeated or subsets from the main application window,
included on the panel for convenience. Using the mouse, left-click on the menu label at the top of the
screen to reveal the available options and submenus.

The Practice Builder 1-2-3 viewer menus are available as a popup menu, accessible from anywhere in
the main viewer workspace. To display a popup menu, position the cursor over the main workspace and
click the right mouse button. The popup menu disappears when you click any mouse button. If you are
using a single-button mouse, hold down the Shift key and click the mouse button to display a popup
menu.

3.2.1 FILE MENU

Practice Builder 1-2-3's File menu provides access to functions to sign on and off, open and close study
files, bookmarking and restoring bookmarked sessions, saving images to files, printing images to
Microsoft Windows and DICOM-compatible printers, clearing the Practice Builder 1-2-3 viewer cache,
connect to collaboration session, and terminate the viewer session.

Menu Item Shortcut For details, see ...
Open previous study Ctrl+Alt+Up Section 5.1.3
Open next study Ctrl+Alt+Down Section 5.1.3
Close study Section 5.7
Close views Section 5.7
Bookmark Ctrl+Alt+B Section 5.1.5
Restore Ctri+Alt+R Section 5.1.5
Create presentation state Section 5.5.4
Send presentation state Section 5.5.4
Update plug-ins Section 7

Send image/series Section 5.5.12.1
Delete image/series Section 5.5.12.1
Save image Ctrl+Shift+l Section 10.1
Save series Ctrl+Shift+S Section 10.1
Copy image to clipboard Ctrl+Shift+C Section 10.1
Print Ctrl+P Section 11
Empty cache Section 4.1.8
Signon ... Section 2.2.3
Sign off Section 2.2.3
Connect to collaboration ... Ctrl+Alt+C Section 9

Exit Ctrl+Q Section 5.7.1
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3.2.2 VIEwW MENU

Practice Builder 1-2-3's View menu provides access to the toolbars, individual panels, the panning
magnifying glass, and controls for displaying and hiding different image overlays.

Menu ltem Shortcut  For details, see ...
Toolbars Section 3.1
Templates Section 3.1.8
Window/Level Section 3.1.4
Presentation tools Section 3.1.13
Annotation tools Section 3.1.5
Grid layouts Section 3.1.6
Link control Section 3.1.11
Cine control Section 3.1.10
Macro tools Section 3.1.14
Tile layouts Section 3.1.7
Toolbox Section 3.1.2
Orientation tools Section 3.1.3
Standard toolbar Section 3.1.1
Status bar Section 3.1.15
Magic glass Alt+M Section 5.5.5.3
Thumbnail panel Alt+T Section 3.4
Layout manager F6 Section 3.6.1
Information panel F7 Section 3.6.2
Report panel F8 Section 3.6.3
Off, Full, Compact Section 3.6.3
Show/Hide overlays Ctrl+F9 Section 6.1.5
Show/Hide annotations F9 Section 6.1.6
Show/Hide image info F10 Section 6.1.1
Show/Hide scale rulers Ctrl+F10 Section 6.1.3
Off, Left, Left+Top, Top, Top+Right, Right, Section 6.1.3
Right+Bottom, Bottom, Bottom+Left
Show/Hide orientation F11 Section 6.1.2
Show/Hide scout overlays Ctrl+F11 Section 6.1.6
Show/Hide annotation indices Section 6.2.1
Show/Hide tick marks Section 6.2.1

3.2.3 SETTINGS MENU

Practice Builder 1-2-3's Settings menu provides access to the customized settings window where you can
customize the viewer characteristics, select a cursor mode, calibrate the image and monitor, change the
grid and tile layouts, modify the localizer lines settings, and set series-specific settings.

Menu ltem Shortcut For details, see ...

Customize Settings Section 4.1

Cursor
Normal Ctrl+N Section 3.9.1.1
Magnifier Ctrl+M Section 3.9.1.2,5.5.5
Report attachment Section 3.9.1.3, 8.3.1
Cine link Section 3.9.1.4,5.4.3
ROI with WIL Section 3.9.1.5,5.5.2
Cropping Section 3.9.1.6, 5.5.7
Magic X Section 3.9.1.7,5.5.11
Annotations Section 3.9.1.9
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Menu Item Shortcut For details, see ...
Distance Section 6.2.2
Angle Section 6.2.2
Cobb angle Section 6.2.2
Housfield value Section 6.2.3
Region of interest Section 6.2.2
Freehand region of interest Section 6.2.2
Pointer Section 6.2.5
Text Section 6.2.1
Report figure number Section 6.2.4
Spine labeling tool Section 6.2.6
Multiple monitor Section 4.1.3
Calibration
Monitor Section 4.6.1
Image Section 5.5.10
Grid layouts
Tile across monitors Section 5.3.1
1-up, 2-up, etc., Custom Section 5.3.1
Split/Join selected cell Section 5.4.1.3
Tile layouts
2-up, 4-up, etc., Custom Section 5.3.2
Link properties
Auto link Section 5.4.3
Mirror Section 5.4.3
Magic glass Section 5.4.3
Localizers
Auto find localizers Section 4.1.3
Show localizer lines on selected image Section 6.1.4
Show hash marks on selected image Section 6.1.4
Show/Hide localizer lines on all images F12 Section 6.1.4
Show/Hide hash marks on all images Alt+F12 Section 6.1.4

Series

Auto split series

Section 5.4.1.1

Auto sort series

Section 5.4.2,4.1.3

Macros

Section 4.3.2.4

Macro manager

Section 4.3.2.4

Start/Stop recording

Section 4.3.2.4

Selected study assigned

Section 8.2.3

Warn when dictating to an addendum

Section 8.2.5

3.2.4 TooLs MENU

Practice Builder 1-2-3's Tools menu provides access to various tools that control the screen layout and
the manner in which it renders the images. This includes the ability to reset the image characteristics,
apply a zoom factor and an interpolation algorithm, invert the grayscale slope, apply color to the LUT,
reorient the image, and customize the set of images in a series.

Menu Item Shortcut For details, see ...
Reset
Image size Section 3.1.2,5.5.5

Image position

Section 3.1.2, 5.5.5.5

Image orientation

Section 3.1.2, 5.5.6

Window/Level
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Menu Item Shortcut For details, see ...
Transform
Flip horizontally Ctrl+H Section 5.5.6
Flip vertically Ctrl+U Section 5.5.6
Rotate right Ctrl+R Section 5.5.6
Rotate left Ctrl+L Section 5.5.6
Flip image info Section 5.5.6
Zoom
Actual size Ctri+Alt+A Section 5.5.5.4
N:1 Ctrl+<N> Section 5.5.5.1
1:N Alt+<N> Section 5.5.5.1
Fit to window Ctrl+F Section 4.1..4,5.5.5
Full screen F5 Section 5.5.5

Interpolation

Section 0 and 5.5

Nearest pixel

Section 4.1.4,5.5.5

Bilinear interpolation

Section 4.1..4, 5.5.5

Invert Section 5.5.2
Greyscale Section 5.5.2
Apply

QOrientation Section 5.5.6

Zoom factor

Section 5.5.5.1

Window/Level

Section 5.5.2

Invert Section 5.5.2
Greyscale Section 5.5.2
Series
Find all localizers Section 4.1..3
Find series localizer Section 4.1..3
Split all series Section 4.1..3
Split series Section 4.1..3
Sort all series Section 4.1..3,5.4.2
Sort series Section 4.1..3,5.4.2
Invert series Section 5.4.1
Cut series Section 5.4.1

Join series forwards/backwards

Section 5.4.1

3.2.5 CINE MENU

The Practice Builder 1-2-3 Cine menu provides controls for displaying stack views. The menu includes
controls for cycling through the images in the stack view, which simulates playing a cine loop, controlling
the looping mode, altering the playback speed, and displaying the cine controls as a floating or docked

toolbar.

Menu Item Shortcut For details, see ...
Play/Stop cine Section 5.5.1
Next/Preceding frame Down/Up Arrow  Section 5.5.1
Cycle/Reverse mode Section 5.5.1
Faster/Slower speed Section 5.5.1

Link Section 3.9.1 and 5.4.3
Toolbar Section 3.1.9
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3.2.6 COLLABORATION MENU

The Practice Builder 1-2-3 collaboration menu enables a user to create a collaborations session, connect
to an established collaboration session, and disconnect from a collaboration session. Refer to section 9
for complete details on collaboration sessions.

Menu Item Shortcut For details, see ...
Connect Ctrl+Alt+C Section 9
Disconnect Ctrl+Alt+D Section 9

3.2.7 HELP MENU

Practice Builder 1-2-3's Help menu provides access to information about the Practice Builder 1-2-3
viewer. It contains detailed information on the available features, a summary of the newest features
added in the last upgrade installed on your server, plus details about its version, which is helpful in the
event you need to contact customer support. For complete details on Practice Builder 1-2-3 Help, refer to
section 12.

3.2.8 POST-PROCESSING MENU

The Post-processing menu is a conditional menu that exists if you have certain licensed plug-in modules
installed on your workstation. Examples of post-processing plug-in modules include multi-planar
reconstruction, fusion and image stitching. After the plug-in module downloads onto your workstation, the
respective sub-menu is added to the Post-processing menu. If no post-processing plug-in module exists,
then the Post-processing menu does not appear on your viewer's title bar. For details on each of the sub-
menus listed in the Post-processing menu, refer to the respective section in chapter 5 or chapter 7.

3.2.9 SPEECH RECOGNITION MENU

The Speech Recognition menu is a conditional menu that exists if you have the embedded speech
recognition plug-in module installed on your workstation. For details on this menu, refer to Section
8.2.4.1.

3.2.10 CONTEXT MENU

Users can assign tools to the context menu that appears when right-clicking the mouse. To assign a tool,
create a keyboard macro and assign it to the custom context menu. For details, refer to section 4.3.2.6.

3.3 Image Viewing Area

The Practice Builder 1-2-3 image viewing workspace makes up the majority of the user interface, as
shown in Figure 3-1. This is the area that renders the full fidelity image data, along with applied
annotations, overlays, and other enhancements to the image data set. The main viewing area is the one
area of the Practice Builder 1-2-3 viewer that you cannot hide or close.

The user can customize the image viewing workspace. The area can be subdivided into multiple areas
called image frames. On multiple-monitor workstations, it is possible to define one image frame that
spans across all the monitors. Each image frame can display the images in a number of tile modes. The
default tile mode is 1-up, also called stack mode, meaning only one image appears in the frame. A 4-up
tile mode displays two rows and two columns of images, displaying four successive images loaded into
the frame. By scrolling through the image frame, the user can display all the full-fidelity images loaded
into the image frame. Section 5.2.4 contains information on modifying the grid and tile modes.

To load an image into the main viewing workspace, you need to drop a thumbnail image into it. See
section 5.2.1 for details on loading images from the thumbnail panel and the layout manager.
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3.4 Thumbnail Panel

The Practice Builder 1-2-3 viewer includes a panel in the main viewing workspace for displaying the
thumbnail images of each series. When displayed, the thumbnail panel is located on the left border of the
main viewing workspace, as shown in Figure 3-1.

A thumbnail image is a sub-sampled rendering of an image in the study used for quick identification of the
full-resolution image. The thumbnail panel consists of one or more columns of thumbnail images, scrolling
off the bottom of the panel if too many exist. Each image in the thumbnail panel corresponds to a single
series in the study, a group of post-processed images, presentation states, or a collection of key images.
The image group contains an optional header. If multiple studies are loaded, a study identification header,
listing the patient name and study date, separates each study.

To display the thumbnail panel, place the cursor over the leftmost border of the main viewing workspace
until the cursor changes to a bi-directional arrow, click the left mouse button and drag the border to the
right, revealing the thumbnail panel. You can also show and hide the thumbnail panel by clicking on View
menu and selecting Thumbnail Panel, or by entering Alt-T on the keyboard. Change the thumbnail image
size with the magnification tool, 2, by applying it directly to the thumbnail image, or by setting the default
thumbnail size on the Customize Settings’ Layout page.

Each image cell in the thumbnail panel consists of the following markers, as shown in Figure 3.4-1.

1. A key image indicator if the image is selected as a
key image in the report. 1.

2. A series indicator if the series contains more than
the displayed image.

3. An image viewed indicator if the image has not
been rendered at full resolution during the viewer
session.

4. A blue progress bar along its bottom edge showing 2ll
the status of the image loads.

Load a thumbnail into the main viewing workspace before or after the progress bar completes. Practice
Builder 1-2-3 displays the data that has downloaded from the server, and automatically updates the
image when the rest of it data arrives. The download completion percentage is available as part of the
overlay data.

On the upper left edge of the thumbnail image is a multiple-image series indicator. Three lines intersect
the left edge of the thumbnail image when the series consists of multiple images. Scroll through multiple-
image thumbnails by selecting the frame and moving the mouse’s wheel.

If the image represented by the thumbnail image is stored as a key image, the top left corner contains a
key image indicator. Key images are also displayed as a separate series in the thumbnail image. This
series contains a key image icon on top of the thumbnail image.

The red dot in the top right corner indicates the image has not been displayed at full resolution in the main
viewing area. A red circle applies only to a series of images, and means at least one image in the series
remains unviewed in the main viewing area. Once all images have been fully rendered, the red circle
disappears.

The color of the frame surrounding each of the thumbnail images is for visual delineation only with one
exception. The thumbnail corresponding to the image in the selected image frame is highlighted in white.
Section 4.1.7 contains additional information on thumbnail frame colors.

Presentation state thumbnail images appear in the thumbnail panel under the Presentation Group header
and have a presentation state icon, ﬂ on top. One thumbnail series exists for each series containing an
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image with a defined presentation state. Load the thumbnail into an image frame to render the series.
Double-click the presentation group header in the thumbnail panel while pressing the Ctrl button to render
all presentation groups for the study in a single image frame. Hide presentation state series from the

Presentation Group by clearing the Show Presentation Thumbnails box under the Settings tab in the
Customize Settings panel.

Key images appear in the thumbnail panel after the Presentation Group header and have a key image

icon, I, on top. One thumbnail series exists for each report component containing key images. Load the
thumbnail into an image frame to render the series like other images. Double-click the presentation group
header in the thumbnail panel while pressing the Ctrl button to render all presentation groups for the
study, including the key images, in a single image frame. Hide key image series from the Presentation
Group by clearing the Show Presentation Thumbnails box under the Settings tab in the Customize
Settings panel.

For information on loading images from the thumbnail panel into the main viewing workspace, refer to
section 5.2.1.

3.4.1 THUMBNAIL PANEL HEADERS

The series thumbnails displayed in the Thumbnail panel contains an options header. e —
The header can be positioned above or below the thumbnail, or as information at the
top or bottom of the thumbnail image.

To configure the header, do the following:

From the Settings menu, select Customize Settings.

:

1.
2. Select the DICOM Fields tab.
3. Select the position from the Display Location list. The available options are } '
a. Thumbnail Header — Header appears above the thumbnail image '
b. Thumbnail Footer — Header appears below the thumbnail image
c. Thumbnail Top — Header appears as image information at the top of ;
the thumbnail image
d. Thumbnail Bottom — Header appears as image information at the
bottom of the thumbnail image
4. Define the value displayed in the header by selecting a field in the Tag or Info
sections and clicking the respective Add button. The fields appear in the area
on the left.
5. Click OK.

By default, the thumbnail header appears above the thumbnail image and contains the Series Description
value.

When displayed as image information at the top or bottom of the thumbnail image, the value subject to
the Show/Hide Image Info setting. When image information is hidden, so are the thumbnail headers.

Each of the available header positions supports a single line of text. If more information is needed,
activate additional header positions. Additionally, multiple field values can be concatenated onto a single
line. As with the study header, if the header value exceeds the width of the header area, position the
mouse over the header and the field will be extended to display the full value.

3.5 Status Bar

The status bar, located at the bottom of the Practice Builder 1-2-3 viewer, displays the current status of
an action. When the viewer is idle, the status bar displays Ready. When the viewer is downloading
images from the Practice Builder 1-2-3 server, the status bar displays a blue progress bar. The progress
bar moves across the status bar, indicating the percentage of the study information transmitted. When the
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progress bar completes, the thumbnail images are available for viewing. Note that when using image

compression, the images may arrive at your station in waves of increasing fidelity. The individual progress
bars in the thumbnail images indicate the progress of the individual image decompression.

On the far right side of the status bar is a quantitative indication of the download completion. When this
value reports 0%, the transmission has not begun. In some cases, the Practice Builder 1-2-3 server may
take some time to collect the selected study from its storage location. Once the data is ready for
download, this field shows the progress.

3.6 Independent Popup Panels

A number of control panels exist in the Practice Builder 1-2-3 viewer. These include the layout manager,
the report panel, the object information panel, and the print control panel.

Each of the control panels appears as an independent popup window. You can display or hide them as
needed. Most of them contain a setting to keep the window on top of the other Practice Builder 1-2-3
windows, including the main viewing workspace. If you want to keep the window displayed while you click
on buttons and menus outside the window, pull down the first menu in the popup window and select Keep
on Top. If a checkmark appears next to this item, the window will remain in the foreground. Clear the
checkmark to allow the window to move to the background when you select another window on your
workstation.

3.6.1 LAYOUT MANAGER
The Practice Builder 1-2-3 layout manager is a popup pane| IR E

for previewing images loaded into the viewer, and organizing El|DJ|E,|EE|EE|E;,3|@|@|‘§|@|
them in the main viewing workspace. The layout manager
provides controls to select the monitors to use, the grid to
apply to each monitor, the tile mode of each image frame,
and the images to load into each image frame. After defining
a layout, the layout manager can store the configuration as a
hanging protocol template, which you can apply when
loading a subsequent study, making it unnecessary to define
the configuration again.

SEEmEEEEL]

The layout manager window has three sections. The top part
of the window contains the menus and toolbars. These are
the same toolbars available in the main viewer, as described
in section 3.1. The menus are similar to those in the main viewer as described in section 3.2, although
some reorganization has been applied.

The center section of the layout manager contains an emulated display. These emulated monitors look
and behave like the main viewer screens, but appear in the layout manager for simplicity. There is one
emulated monitor for each real monitor. You have almost all the functionality present in the main viewer
as you do in each of the emulated monitors, including window and level, scrolling and resizing.

The bottom section of the Layout Manager contains all the images as stacked thumbnails. This section
has the same functionality as the thumbnail panel, as described in section 3.4.

When you load a study into the Practice Builder 1-2-3 viewer, the layout manager automatically appears
unless you explicitly instructed the viewer not to do so, or Practice Builder 1-2-3 automatically applied a
hanging protocol. To manually display the layout manager, select Layout Manager from the View menu,
or press the F6 function key. You can close the layout manager by clicking the Close button in the top
right corner of the window, pressing the F6 function key, or, if the Keep on Top setting in the Layout
Manager menu is unchecked, clicking outside the layout manager window.

For information on loading the images from the layout manager, see section 5.2.2.
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3.6.2 INFORMATION PANEL

The Practice Builder 1-2-3 information panel contains a dump of = ]
all the attributes in each of the images loaded in the viewer. The : i
information panel is primarily used for support and debug
purposes, although the information is available to users as well.
There may be times when you need to investigate the image
object’s technical data. Perhaps you need to find the field used
to store a particular data value you want to display in the overlay
information. You can also use the information panel to see how
some numeric data changes from one image to the next, without
having to make changes to the overlay configuration.

ImnmedrentatlanFatient 13261701 3e-1 72,301 5AGe-1 040,907 71 440007 3230197 =

To display the information panel, select an image currently

loaded into the main viewing workspace, and press the F7 function key, or select Info Panel from the
View menu. The information panel is a text dump of the object’'s attribute list, sorted alphabetically.
Private attributes inserted by the device that created the object that Practice Builder 1-2-3 does not
interpret appear with a DICOM tag rather than an attribute label. To locate a particular field in the
information panel, use the scroll bar on the right to move through the data. To hide the information panel,
press the F7 function key again, or, if the Keep on Top setting in the Info Panel menu is unchecked,
clicking outside the layout manager window.

3.6.3 REPORT PANEL

The Practice Builder 1-2-3 report panel displays reports associated with prior studies opened in the
viewer, as well as records reports for the new studies. The report panel includes the text of the main
report, the text of the addendums to the report, the original dictations, if available, and the key images.

To open the report panel, click the report button, " in the toolbox toolbar, press the F8 function key, or
select Report Panel from the View menu. By default, the report panel appears in the Full mode. A smaller
version exists using compact mode.

== The full report panel contains the report and access to

e — reporting functions. In the full report panel, users can

— e z| record and edit a voice dictation, type and edit report

e ——— | and addenda text, review the patient demographic

T e ggenns o 0o | information, obtain information on who created the

e report, update the study state, and perform simple

management functions such as submitting the report

osseRvATION manually to the server, clearing all the changes and

R e starting over. The full view report panel also provides
wengssion “ == access to the study’s key images.

e S —_ The full report panel layout is defined by a customizable

template. Your report panel template may appear with
more or less information than this manual describes.

The full report panel’s report toolbar provides support to general reporting
tools as described below. @ && QOE ﬂ

Button Description

Compact panel Toggle between the compact report panel and the full report panel.

Send Report Submit the report to the Practice Builder 1-2-3 server.

Reload Report Erase all the changes and restore the original report.

Save report locally  Save the report to your workstation's hard disk.

Restore saved If you previously saved a report to your local workstation (using the Save to
report hard disk tool), read it from disk and load it in this report panel.
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Button Description
Spell check Perform spell checking on the report’s text fields.

The full report panel’s report template toolbar creates, modified and applies canned report templates. This
toolbar is described in section 8.2.2. The report panel also supports an audio control, annotation, toolbox
and orientation toolbar. These toolbars are described in detail in section 3.1.

The full report panel contains the reports for each of the studies loaded into the viewer. A tab at the top of
the panel displays the patient's name, study date and modality. Click the tab to see or edit the report for
the corresponding study.

The full report panel displays the main report, addenda and attachments as defined by the customizable
XML template. Generally, these components appear sequentially on a scrollable web page or under
individual tabs available immediately below the study identification tab. If tabs are available, click one to
display the specified data.

The compact view report panel is a smaller version of the report panel, A
consisting primarily of the most common tools needed to dictate and  »|o[x| }\— [
submit a report. If using embedded speech recognition, the compact report _

. . R IUnwewed 'I Send report Full
panel also includes a text box showing the converted text. For less image B
frame obstruction, dock the compact view report panel as a toolbar by dragging it to the outside of the
main viewing workspace.

The compact report panel contains the following tools:

Button Description

Full Toggle between the compact report panel and the full report panel.

Send Report Submit the report to the Practice Builder 1-2-3 server.

Audio toolbar Start and stop dictation, play dictation, edit dictation.

State Select the study state.

Report text Displays the last few words of the report text. Available when configured

to use embedded speech recognition.
Input strength indicator Audio input strength indicator.

Configure the default report panel mode by selecting Compact or Full in the Report Panel section of the
View tab in the Customize Settings window.

3.6.4 PRINT PANEL

The Practice Builder 1-2-3 print panel is a staging area used I ———— iy
to collect images and format sheets of film for printing. The ¢ Y= ocn I e el Lk
print panel provides tools for selecting and organizing the %‘ — —"ﬂﬂ:;;

images, specifying the film sheet layout, and selecting a  fume
Windows-based or DICOM compatible printer along with its
respective print parameters. The images in the print panel
have most of the functional characteristics of images in the
thumbnail panel and main viewing workspace, allowing you
to enhance the display characteristics, such as change the
window or level and adjust an annotation, prior to submitting
the print job to the printer.

To open the print panel, select Print... from the File menu.
By default, no images are loaded, unless you have already
selected one of the series in the main viewing workspace.
The process is to load the selected images into the print panel from either the thumbnail panel or the
main viewing workspace, adjust them as necessary, select the print parameters, which differ depending
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on whether you are printing to a DICOM or Window printer, and then submitting the print job. The print

panel remains displayed until you submit the print job. Close the print panel without submitting the print
job by clicking on Cancel or the close button on the top right corner of the window.

Refer to section 11 for detailed instructions on how to build a film sheet and submit a print job.

3.6.5 PATIENT FOLDER

A patient folder lists details about the patient history including a list of prior and future orders and studies,
technologist notes, reports, scanned documents and demographic information. The patient folder can be

launched by clicking the Patient Folder button, QJ The button exists in the following locations:

Worklist page In the button section on the left of each study row.
Quick View page In the study manipulation tools section
Viewer In the Toolbox toolbar.

The patient folder is a templated web page. It consists of three independent templates. Refer to the
Practice Builder 1-2-3 XML Template Customization Manual for details on customizing web pages.
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The default patient folder consists of the following sections:

Tabs Available when launched from the viewer, each tab represents the patient
folder for each unique patient with a study loaded.

Buttons Available when launched from the browser, these buttons are links to
available web pages.

Study list The selected study and all related orders and prior exams, as defined by

the relevant exam matching criteria. Studies are listed by procedure date
starting with the current date or future date if there are pending orders.
Patient demographics Specific patient information such as name, date of birth and history.

Study information Specific study information pertaining to the selected study in the Study
List, such as exam date, modality and study description.
Attachments List of attachments pertaining to the selected study in the Study List.
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All report components pertaining to the selected study in the Study List.
Notes pertaining to the selected study in the Study List.

Readable view of the selected attachment, report component or note.

The properties of each section are described in the table below.

Section Property Description

Tabs Left-click Display the information for the patient listed on the tab.

Buttons - Go to the Quick View page for the selected study. Available
from browser-launched patient folder only.

& Retrieve the selected study from the archive.

=3 Open the selected study in the viewer. Available from browser-
launched patient folder only.

[g| Load the selected study to the current viewer session.

— Available from viewer-launched patient folder only.

- Return to the worklist page. Available from browser-launched

T patient folder only.

Study list Left-click Make the study the selected study. Updates the study

information, attachments, reports and notes sections.

Left-click+drag Available in the viewer only. Load the study into the current
viewer session. The study is loaded when the series appear in
the thumbnail panel.

Folded top-right Primary study. This is the study selected from the worklist. All

cell frame corner  prior exams and orders are relevant to this study.

Red border The selected study

al Relevant by modality to the Primary study.

L5 Relevant by matching criteria to the Primary study.

”‘j-’_, Relevant by body part to the Primary study.

=) Study contains a Final report.

G Study contains an attachment.
Study contains a note

Bar on left edge Final study.

Grey background  Study is not loaded in the viewer and not available on the
server.

Light blue The study cell represents a pending order.

background

Blue Study is not loaded in the viewer.

Yellow Study is loaded in the viewer.

Dark Yellow Study is loaded in the viewer and is currently displayed in the
selected image frame.

Patient v & If expand/collapse buttons exist in this section, click to

demographics ’ show/hide patient information obtained from the RIS. An
interface must be configured to use this feature.

Study v & If expand/collapse buttons exist in this section, click to

information ' show/hide study information obtained from the RIS. An
interface must be configured to use this feature.

Attachments Mouse-over Position the mouse over the attachment icon to display a
larger view of the attachment when the attachment is an image
objects, such as JPEG or DICOM. Non-image objects, such as
PDF display the attachment’s filename.

Left-click Display the attachment in the image area.

Left-click+drag

Available in the viewer only. Drag the attachment to an image
cell in the viewer.

Left/Right arrow

Scroll the attachments list to the left or right.
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Section Property Description
Reports Mouse-over Position the mouse over the report icon to display a larger
view of the report component.

Left-click Display the full report, including all components and key
images, in the image area.

Left-click+drag Available in the viewer only. Drag the report to an image cell in
the viewer.

Left/Right arrow Scroll the report components list to the left or right.

Notes Mouse-over Position the mouse over the report icon to display a larger
view of the report component.

Left-click Display the full report, including all components and key
images, in the image area.

Up/Down arrow Scroll the notes list up or down.

. Add a note to the study. A text field appears in the image
section. Enter your note and click Save. The note gets tagged
with timestamp and your account ID, and appears at the
bottom of the Notes list.

Image area Left-click Available when displaying an attachment in the image area

only. Click to toggle through the available image sizes: fit-to-
window; fit-width; and full-resolution.
'_@Jl Available when displaying a note in the image area only. If the
— user has Admin permissions, click the Delete button to
permanently remove the note from the study.

When displayed from the Viewer, the patient folder automatically updates to reflect additions to the
relevant studies.

To force the patient folder to the foreground independent of other viewer panels, open the Customize
Settings panel from the Settings menu, click the View tab, and check the Patient Folder on Top box in the
General section.

When launching the viewer, the patient folder initializes in the state and location used when the viewer
was last closed.

3.7 Plug-in Modules

Practice Builder 1-2-3 supports independently licensed plug-in modules that offer a suite of functions not
available in the baseline viewer. An example of a plug-in module is multiplanar reconstruction. When you
install a Practice Builder 1-2-3 viewer on your workstation, it queries the server for a list of licensed plug-
ins. If the viewer determines you are licensed to use a plug-in, or if a newer version of the plug-in exists
on the server, the Practice Builder 1-2-3 viewer prompts you to download and install it. The prompt
window is shown to the left. The window displays the
available plug-ins, along with their respective version
numbers. To install or update a plug-in, check the box
to the left of the plug-in module and click OK. Note that
some plug-in modules consist of an extra install
process. If this is necessary, another prompt may
appear asking if you want to install the additional
component. Click on OK to install the application.

I Reload Multi Planar Reconstruction by eRAD/Imagemedical version 1.0.0.11
™ Reload Basic 30 Plugin by eRAD/imagemedical version 1.1.0.7
I Reload OrthoView Stub Plugin by eRadfimageMedical version 1.0.2.1

I Reload Stitch Image stitching tool by eRADimageMedical version 1.0.0.20

I” Reload Spellex Spellchecker Module by eRAD{ dical - Spellex version 1.0.0.2

To see a list of available plug-ins, select Update plug- Carcal
ins from the File menu. Once installed, the plug-in

automatically initializes and makes its functions available.

You can find a complete list of Practice Builder 1-2-3 viewer plug-ins in section 7. Refer to the relevant
subsection for specific details on how to use the features in the plug-in.
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3.8 Display Modes

Normally, the Practice Builder 1-2-3 viewer shows the default display mode, consisting primarily of the
main viewing workspace. Additional display modes exist. These display modes offer an alternative view of
the data, usually for a specific, short-term purpose.

3.8.1 FuLL SCREEN MODE

Practice Builder 1-2-3 offers a full screen display mode that eliminates all extraneous information from the
monitor and uses all the space for displaying the image. When active, the menus and toolbars disappear
from the screen, but all mouse controls remain available and you can apply them to the image.

Full screen display mode applies to an image frame. First load the image or series into an image frame,
and apply a tile mode if necessary. To active full screen mode, select the image frame and press F5. To
return to the normal display mode, press F5 again, or hit the Esc button.

3.8.2 CALIBRATION MODE

One of Practice Builder 1-2-3 viewer's zoom modes supports rendering the image using a real-world
scale. To support this zoom mode, both the image and the monitor must contain calibration information. If
either is not calibrated, the Practice Builder 1-2-3 viewer notifies you and invokes a wizard to collect the
requisite information. You can also run this wizard manually. The calibration wizard uses two display
modes, each different from the default display mode. The monitor calibration display mode consists of a
set of rulers you adjust to indicate the actual size of an object on the monitor. The image calibration
display mode displays the image in need of spacing information, and a tool for defining measured objects
on the image, which Practice Builder 1-2-3 uses to define the physical size of the pixels.

Section 4.6.1 contains detailed information on the monitor calibration and instructions for calibrating one
or more monitors. Section 5.5.9 contains additional information on image calibration and the image
calibration display mode.

3.9 Mouse Operations

The mouse is a powerful tool in the Practice Builder 1-2-3 viewer. A large number of the most common
functions available from menus, toolbars and function keys are also available from the mouse. With a little
practice and some dexterity, you should be able to accomplish the majority of your task simply through
the use of a three-button mouse with a wheel.

Practice Builder 1-2-3 is able to support a large number of functions on the mouse because it supports
multiple cursor modes. Each cursor mode assigns specific functions to each of the mouse buttons. By
changing the cursor mode, the different Practice Builder 1-2-3 functions become active. The following
section outlines each of Practice Builder 1-2-3's cursor modes.

3.9.1 CuURSOR MODES

Practice Builder 1-2-3 viewer has a number of cursor modes available to control which functions get
applied when clicking one of the three supported mouse buttons. The cursor icon identifies the active
cursor mode. There are a few ways to activate a cursor mode.

Select the cursor mode from the Cursor submenu in the Settings menu.

Select the cursor button in the Toolbox toolbar.

Press the hot key combination (available for a limited number of cursor modes).
Click the middle mouse button to toggle through the cursor modes.

YVVVY

Some users select a cursor mode and want to use it until they explicitly select another cursor mode.
Others prefer the cursor mode automatically reset to the default mode after applying an action. Practice
Builder 1-2-3 lets the user specify whether the mode resets to the default or persists in the selected
mode. When clicking the mouse button, the cursor mode automatically resets to the default when you
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release the button. If you hold down the ALT key while pressing the mouse button, the cursor mode

remains active after performing the action. This is useful when adding annotations or attaching multiple
key images to a report.

Hold down the Alt key to remain in the cursor mode for magnify, key image, link, ROl with W/L, crop,
magic X. The annotation cursor mode persists automatically, although it retains the specific annotation
tool if you hold down the Alt key.

3.9.1.1 Normal Cursor
Use the Normal (arrow) Cursor to click and select menus, menu items, buttons, slider bars, images,
D‘&‘ and to click and drag to relocate toolbars and resize the Image and Thumbnail Windows. This is
the default cursor mode.

3.9.1.2 Magnification Cursor
The magnification cursor mode is for zooming in and out on images. The magnification is based on
the position of the cursor, so position the cursor over the point of interest before clicking the
~—— mouse.

When magnifying an image, a small plus sign (+) is attached to the cursor and a dotted white line appears
in the image in the thumbnail panel, indicating the viewable magnified image in relation to the original
image. Click the left mouse button to apply a 2x magnification to the displayed image, centered on the
cursor location. Hold the Shift key down when clicking to double the magnification to 4x. The cursor
displays two plus signs to indicate the 4x zoom factor.

To decrease the image size incrementally, hold down the Ctrl key when clicking the mouse. The icon
includes a small minus sign (-) next to the cursor. Hold the Shift key with the Ctrl key to zoom out by a
factor of 4x.

Clicking the right mouse button draws a zoom region. When you release the mouse, an image in the
defined region is magnified to fit into the image frame.

Reset the image size by reloading the image into the frame from the thumbnail panel, clicking on the
Reset Image Size button or menu item, or use the magnification mode to apply a reverse zoom.

3.9.1.3 Key Image Selection Cursor
The key image selection cursor lets you attach an image to a report. When activated, the cursor
J looks like a paper clip. To attach an image to a report, click on the image. When attached to the
report, a key image icon is displayed in the top left corner of the image to denote the image is
attached to the report exactly as rendered in the image frame. A paperclip icon appears in the top left
corner of the image to denote the image is attached to the report, but not as it appears in the image
frame. Click the key or paper clip icon on the image to remove it from the report.

3.9.1.4 Link Cursor

The link cursor is for linking one or more studies together so a single scroll command applies
=r H to all linked image frames. When auto-link is active, series in the same plane and sharing the
i same frame of reference are linked automatically. Double-click the link cursor button to
automatically link together all series in the same plane and within the same frame of reference. To
manually link image frames together, select the Link cursor mode, move the cursor to the first image
frame, press and hold down the left mouse button, drag the cursor to the frame you want to link, and
release the mouse button. To link a third frame to the first two, repeat by starting with one of the two
original frames, and releasing the mouse when the cursor is in the third image frame. To remove a link,
double-click on the link icon in the top-left corner of the image.
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3.9.1.5 ROI With Window/Level Adjustment

A user can set the window width and center values for an entire image or study based on the
~=| dynamic range of a specified region of an image using the ROl with window/level adjustment

cursor mode. After selecting the ROI with W/L mode, position the cursor over the image, and click
and drag to define the region of interest. When you release the cursor, the pixels within the region are
used to define the window width and center. These values are applied to the entire image. The region
defining the area remains on the screen. Resize it and drag it around to change the window and level
settings. Click anywhere on the image outside the region of interest to remove it.

3.9.1.6 Crop Image Cursor Mode
Remove extraneous information from the viewable image in the frame with the crop image cursor
'E: mode. Click the image and drag the mouse to define the image region. When you release the
mouse, all image data outside the defined region disappears from view. Click on the region border
and drag it to resize the crop region. Select the Fit to Window mode to display the image as large as
possible in the image frame. Double-click anywhere in the image frame to remove the crop region.

3.9.1.7 Magic X Cursor Mode

— Locate a defined point in one image on all other images that share the same frame of reference
using the Magic X cursor mode. Select Magic X mode, and click on an image. All series currently
displayed in other frames scroll to the image closest to the selected point. If you click and hold the

mouse button, the Magic X marker is displayed in each image frame. If you drag the mouse while holding

down the button, the images update dynamically as the reference point moves.

3.9.1.8 Magic Glass Cursor Mode
Magic Glass cursor mode is actually a panning magnifying glass, zooming the image behind it.
After activating the magic glass window, click on the popup window and drag it to move it around.
The area under the image is magnified by a factor defined in your customize settings table. Only
image data is magnified. Clear the magnifying glass by left-clicking anywhere outside of the zoom area.

Resize the magic glass window positioning the mouse over the edge of the window until it changes to a
bi-directional arrow. Click the left mouse button and drag to resize the window. A large Magic Glass
window may result in ghosting as you drag it around. If you find this distracting, reduce the size of the
magic glass window.

3.9.1.9 Annotation Cursor Mode
The annotation cursor mode is the general cursor mode for all annotation tools. The general
J annotation mode is needed to move and edit existing annotations. To apply a specific annotation,
select the desired annotation from the annotation toolbar, or spin the wheel on the mouse when
general annotation mode is active.

3.9.2 MOUSE FUNCTIONS

The following table lists Practice Builder 1-2-3 viewer’s default mouse functions and actions based on the
location of the cursor when the action is requested.

Cursor Mouse Middle Right Left + Right
Mode Location Left Button Button Button Button
Pointer Main Viewing Click: Select image frame Click™: Toggle Click: Features
Workspace cursor popup menu
Image Click: Select image/series Click™: Toggle Click: Features | Drag: Dynamic
Drag: Scroll images (image fit-to- | cursor popup menu zoom
window), or Pan (resized image) Roll: Scroll Drag: W/L
Ctrl-Drag: Scroll images images image/series
Drag? Scroll
images
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Cursor Mouse Middle Right Left + Right
Mode Location Left Button Button Button Button
Layout Click: Select image/study Click™: Toggle Click: Features | Drag: Dynamic
Manager Dbl-click: load image/series cursor popup menu zoom
Drag: Load image/series Roll: Scroll Drag: W/L
images thumbnail
image(s)
Toolbars Click: Select Click™ Toggle Click: Features
Dbl-click: Detach/attach toolbar cursor popup menu
Drag: drag toolbar
Elsewhere Click: Select Click: Popup
menu
Magnifying Image Click: Zoom up and center Click™ Toggle Click: Features | Drag: Dynamic
Glass Shift-click: Zoom up 2x and cursor popup menu zoom
center Roll: Scroll Drag: Size
CTL-click: Zoom down images zoom area
Shift-CTL-click: Zoom down 2x Drag”: Scroll
ALT-<cmd>: Stay in magnify images
mode after click
Layout Click: Zoom up Click™ Toggle Click: Features
Manager Shift-click: Zoom up 2x cursor popup menu
CTL-click: Zoom down Roll: Scroll
Shift-CTL-click: Zoom down 2x images
ALT-<cmd>: Stay in magnify
mode after click
Annotation Image Click: Apply annotation graphic Click™: Toggle Click: Drag: Dynamic
Mode Drag: Reposition annotation cursor Annotation zoom
graphic/move graphic Roll: Scroll popup menu
endpoint/move annotation annotation tools Drag: W/L
label/text Drag? Scroll image/series
images
Key Image Image Click: Select image as key image | Click™: Toggle Click: Features
Selector ALT-click: Stay in key image cursor popup menu
mode after click Roll: Scroll Drag: W/L
images image/series
Drag? Scroll
images
Layout Click: Select image as key image | Click™: Toggle Click: Features
Manager ALT-click: Stay in key image cursor popup menu
mode after click Roll: Scroll Drag: W/L
images image/series
Magic X Image Click: Display location of image in | Click™: Toggle Click: Features | Drag: Dynamic
all displayed frames cursor popup menu zoom
Drag: Dynamically display Drag”: Scroll Drag: W/L
location of images is all displayed | images image/series
frames
ALT-click: Stay in Magic X mode
after click
Link Image / Click-Drag-Release: Click on first | Click™: Toggle Click: Features
Layout series, drag to series to link, and cursor popup menu
Manager then release Drag? Scroll Drag: W/L
ALT-click: Stay in Link mode images image/series
after click
Cursor Toolbar | Dbl-click: Auto-link all series in
same plane
Magic Glass Image Drag: Move the magnification Drag: Dynamic
window zoom

! Middle mouse click action applies when Advanced Middle Button Tools setting is enabled.
% Middle mouse drag action applies when Advanced Middle Button Tools setting is disabled.
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3.10 Hot Keys and Macros

A number of default accelerator key combinations are available. The Practice Builder 1-2-3 accelerator
keys operate within Practice Builder 1-2-3 viewer, and may be in conflict with hot keys employed by other
application installed on your PC. By default, the following hot keys are included in the Practice Builder 1-
2-3 viewer.

F2 Show study list (Ded. WS only) F10 Show image overlay info
F5 Full-screen mode Ctrl-F10 Show scale graphic

F6 Show layout manager F11 Show orientation

F7 Show image information dump Alt-F11 Show orientation cube

F8 Show report and key images F12 Show localizer line

F9 Show annotations Alt-F12 Show hash marks

Ctrl-F9 Show embedded overlay Alt-T Show thumbnail panel
Ctrl-1 Zoom1l:1 Alt-2 Zoom1:2

Ctrl-2 Zoom?2:1 Alt-4 Zoom1l:4

Ctrl-4 Zoom4:1 Alt-8 Zoom1:8

Ctrl-8 Zoom8:1 Ctrl-Alt-A  Actual size zoom

Ctrl-H Flip horizontally Ctrl-M Magnification cursor mode
Ctrl-U Flip vertically Ctrl-Alt-Up  Open previous study
Ctrl-L Rotate left Ctrl-Alt-Dn  Open next study

Ctrl-R Rotate right Ctrl-Q Close viewer

Ctrl-F Zoom fit to window Ctrl-P Print (selected images)
Ctrl-N Normal cursor mode

Home Show first cine frame Up Show previous cine frame
End Show last cine frame Down Show next cine frame
Ctrl-F Fit image to window Ctrl-Alt-B Bookmark study

Alt-M Magic glass window Ctrl-Alt-R ~ Restore bookmarked study
Ctrl-Shift-1 Save image Ctrl-Alt-C ~ Collaborate

Ctrl-Shift-S ~ Save series Ctrl-Alt-D  Disconnect collaboration

Ctrl-Shift-C ~ Copy image to clipboard

Refer to section 4.3.2.4 for details on setting up and modifying preset keyboard macros and hot keys.

3.11 Running the Viewer

Each of the Practice Builder 1-2-3 viewers uses a different mechanism to start and terminate.

3.11.1 STARTING AND TERMINATING THE ACTIVE-X VIEWER

As the name indicates, the active-X viewer uses Windows Active-X controls to start. When you install the
software, a file type is registered in Microsoft Windows. The default application for that file type is the
Practice Builder 1-2-3 viewer. When you select certain items on the Practice Builder 1-2-3 worklist, the
browser downloads a file of the registered type. As a result, Windows automatically launches the viewer.

To get to the worklist so you can load a study in the active-X viewer, you must log onto Practice Builder 1-
2-3. Select the hyperlink that is the patient’'s name on the worklist, or click on the Open button, and the
viewer starts. If you run the viewer in Standby mode, as described in section 4.1.1, the viewer is always
loaded in memory and launches faster than it otherwise would.

To start the Practice Builder 1-2-3 active-X viewer without loading a study, go to the Windows Start
button, and select Programs. A list of available programs appears. Select Practice Builder 1-2-3, and
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Practice Builder 1-2-3 again from its submenu. If configured to run in Standby mode the viewer loads, but
remains minimized in the system tray.

To terminate a viewing session, close the viewer application by selecting Exit from the File menu or
clicking on the Close button in the top right corner of the application window. If running in configured for
Standby mode, the active-X viewer doesn'’t really terminate. It closes the open study and then returns to
Standby mode. To completely terminate the active-X viewer, find the Practice Builder 1-2-3 icon in the
system tray, right click on it, and select Exit.

3.11.2 STARTING AND TERMINATING THE STANDALONE VIEWER

The Practice Builder 1-2-3 standalone viewer is found on DICOM-compliant media such as CD and DVD.
To launch the viewer, load the media onto your workstation. If you have Windows autorun enabled, the
viewer automatically loads. If this does not happen, open a Windows Explorer window and browse to
d:\pbuilder.exe, where “d:" is the drive label for your removable media.

When the standalone viewer initiates, the study panel appears. The studies listed in the media’'s
DICOMDIR file appear in the study panel. If no DICOMDIR file is found, use the browse button on the
study panel to find a DICOMDIR file or the DICOM object files. Refer to section 5.1.1 for details.

To terminate the standalone viewer, select Exit from the File menu, or click on the close button in the top
right corner of the application window.

Page 42



((e RAD Practice Builder 1-2-3
' Viewer Manual

4  Configuration Settings and Options

The Practice Builder 1-2-3 viewer supports a customizable graphical user interface (GUI). The user has
the ability to define the screen layouts, toolbar arrangements, preset values, custom handing protocol
templates, network settings, overlays, and other settings that make the GUI better suited to specific uses.
Practice Builder 1-2-3 records much of a user’s specific profile on the server, and downloads it to the
workstation when a user logs in. This permits each user to customize their workspace without imposing
their preferences on other users.

The sections in this chapter provide details for customizing the Practice Builder 1-2-3 viewer settings.
These settings are available on all versions of the Practice Builder 1-2-3 viewer, except when noted
otherwise.

4.1 Customize Settings Window

The customized settings window contains settings governing the viewer's default behavior and
appearance. Open the customize settings panel by selecting Customize Settings from the Settings menu.
The customize settings window consists of tabs for each settings group plus an OK, Cancel, and Reset
All button. The Reset All button resets all the viewer’s settings on that page to their original settings.

4.1.1 GENERAL SETTINGS

The general settings page in the customize settings s | || st | o | v | e |
window contains parameters that affect the way |
specific functions behave in the Practice Builder 1- 7 Gttty e P bl acted sty ey
2-3 viewer. To display the general settings page, S e AT men st
select Customize Settings from the Settings menu, 7 St et mahorim I v midte oo
and click on the Settings tab. S e
In many cases, the general settings toggle the P soow o P s prssrmen e
behavior of functions that different users prefer to S S
be enabled or disabled, depending on the manner % Corsroom moen % ot cvh oy
in which they wuse Practice Builder 1-2-3.
Specifically, the general settings are follows: —Tmeiddn <
o Coeel | Reeis |
Setting Default Description

Enable standby mode  Enabled Standby mode starts the viewer when Windows starts, and loads it in memory.
This permits the viewer to launch quicker when opening a study. When
disabled, Windows load the viewer from disk each time the user opens a study.

Use HTTP proxy Enabled If a proxy server exists between the workstation and the server, certain
communications actions are needed. This setting should be enabled at all
times.

Show tool tips Enabled Tool tips are popup text strings that help identify the function of a tool. When

enabled, tool tips appear one second after you place the cursor over a button,
field or gauge in the viewer. When disabled, no tool tips appear.

Show ant line marker Enabled The ant line marker is the moving, dotted white line that marks the view area in
a thumbnail image. When enabled, the ant line marker denotes the location and
size of the image area displayed in the window when a zoom factor is being
applied to the image. If disabled, the markers appear as a solid line the
thumbnail image.

Show annotation Enabled Image annotations include indices for reference. When enabled, an

indices automatically incremented index is displayed with every annotation applied to
an image. When disabled, the index is not displayed. Override this setting on an
individual basis by right clicking on a specific annotation and select Show Index
to toggle the setting.
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Setting Default Description

Show ruler tick marks ~ Disabled Linear measurement annotations support tick marks to assist in calculating
distances. When tick marks are enabled, the marks appear on linear
measurement annotations. Override this setting on an individual basis by right
clicking on the specific annotation and select Show tick marks to toggle the
setting.

Show report note Enabled Pop up report note if present and Impression and Observation are empty.

Show radiologist Enabled Include the radiologist selection menu on the report panel

Show transcriptionist Enabled Include the transcriptionist selection menu on the report panel

Persistent frame Disabled Frame settings remain applied after dropping a new thumbnail set into an

settings initialized image frame.

Center zoom region Enabled The center zoom region setting defines the focal point location when
establishing a zoom region. When enabled, the location of the cursor when you
first click is set as the center of the defined region. When disabled, the location
of the cursor when you first click is set as the corner of the defined region.

Enable dictated study  Enabled When multiple studies are loaded and the report panel is opened, display a

listing selection list so the user can choose which report to edit.

Select primary study Enabled When Enable dictated study listing setting is active, enabling this setting sets

as default the primary study as the default in the Study Selection panel. When disabled,
set the study associated with the selected image as the default in the Study
Selection panel.

External level allowed Disabled The external level allowed setting provides you with the ability to set your
window center value outside the defined region.

Advanced middle Enabled When enabled, click the middle mouse button to toggle through the cursor

button tools modes. When enabled and cursor mode is Annotation, spin the middle mouse
wheel to toggle through the annotation tools.

Continuous image Disabled  Scrolling through images in an image frame can progress smoothly by

scrolling rendering every image, or quickly by skipping through the images at a rate
based on the speed the user scrolls. When continuous image scrolling is
enabled, the viewer displays every image in the stack. When disabled, the
viewer may skip images to keep up with the scroll speed.

Keep cursor Disabled When checked, the cursor mode persists after applying the function. When
unchecked, cursor mode returns to Normal mode. Default is unchecked

Show document Disabled  When checked, display DICOM image objects marked as scanned documents

thumbnails (ConversionType=WSD) in the thumbnail panel.

Show presentation Enabled When checked, display presentation state objects as independent series in the

thumbnails Presentation Group section of the thumbnail panel.

Show key image Enabled When checked, display all key images (per report component) in an

thumbnails independent series in the Presentation Group section of the thumbnail panel.

Create log files Disabled  Record user actions in an activity log file.

Create crash dump Enabled When the viewer crashes, dump the details to a crash log file.

Proposed states -- The Proposed states button opens the window used to set the states to
propose when closing a study. See section 4.1.1.1 for more information.

Magic glass zoom 2:1 The magic glass zoom factor defines the magnification applied to the data

factor

inside the magic glass window. The default is a 2x magnification.

4.1.1.1 Proposed States

When closing a study, Practice Builder 1-2-3 attempts to set
the study state to its new state based on the information added
during the viewer session. For example, if you opened a study

x
Nochange  Viewed Read Dictated  Preliminary Final
Study opened ol ol & ol ol ol

. . J Key image (2l (2l (<l o o o

that was in the Unviewed state, and you dictated a report, you g f e e e e

can automatically set the state to Dictated when you close the Hete & o o o o r

VleWer Observation/Impre:ssian (2l (2l (2l (2l (ol (2l
Cancel

To set the states, open the proposed states window and select

the state for each of the conditions. The conditions available for setting the state are as follows:
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Condition Description

Study Opened The study was opened in the viewer.

Key Image A key image exists for the current report component
Dictation A dictation exists for the current report component
Note A note exists for the current report component

Observation/ Impression  Observation or impression text exists for the current report component.

4.1.2 VIEW SETTINGS

The view settings page contains monitor == ) S | s L e L s L omE |

configuration parameters, plus controls for setting - Gor

viewing characteristics of the many panels et L G Pl e

available in Practice Builder 1-2-3. To display the [Herteriz ) TR S siotvnd

view settings page, select Customize Settings from iyl F

the Settings menu, and click on the View tab. e Doas @ Cotiraon oot
oy e fered e —

The majority of the settings on the view page & i) —:M r:m

determine how Practice Builder 1-2-3 uses the 0 Sl F e

monitors. In a multiple monitor workstation, the e,

Practice Builder 1-2-3 viewer can appear on one or i Lo —

more of the monitors. By identifying the primary o] B PR

monitor and which others to enable, the user can CIATE ™ 5.5 e

run Practice Builder 1-2-3 while leaving other

applications, such as the procedure order ]| v | meen |
information or the patient history, displayed on the remaining monitors.

Section  Setting Default Description

Monitors  Number of monitors  1x1 The number of viewer windows to display on the current monitor.

Useful to split a single 2560x1024 Windows monitor into two
1280x1024 monitors. Only active on single-monitor workstations.

Monitor # -- Select the monitor to configure. Numeric index refers to the
Windows monitor number. See Windows Display properties.

Auto/BW/Color Auto Set the monitor type to greyscale, color, or auto detected.

Primary Monitor Monitor #1  The selected monitor is the primary monitor, and will display the

popup windows, display the thumbnail panel, and handle other
functions. Primary Monitor can be selected for only one monitor.

Disable Disabled Do not display the viewer on the selected monitor.
Templates Enabled Show/Hide the templates toolbar on selected monitor.
Window/Level Enabled Show/Hide the window/level toolbar on the selected monitor.
Presentation Enabled Show/Hide the presentation toolbar on the selected monitor.
Annotation Enabled Show/Hide the annotation toolbar on the selected monitor.
Grid Layouts Disabled Show/Hide the grid layouts toolbar on the selected monitor.
Tile Layouts Disabled Show/Hide the tile layouts toolbar on the selected monitor.
Link Disabled Show/Hide the link toolbar on the selected monitor.
Cine Disabled Show/Hide the cine toolbar on the selected monitor.
Macro Enabled Show/Hide the macro toolbar on the selected monitor.
Toolbox Enabled Show/Hide the toolbox toolbar on the selected monitor.
Orientation Enabled Show/Hide the orientation toolbar on the selected monitor.
Standard Disabled Show/Hide the standard toolbar on the selected monitor.
Status bar Enabled Show/Hide the status bar on the selected monitor.

General  Show Thumbnail Disabled Show/Hide the thumbnail panel on the primary monitor.
Panel
Layout Manager on Enabled Keep the layout manager displayed on top of other windows.
top
Info Panel on top Enabled Keep the information panel displayed on top of other windows.
Report Panel ontop  Enabled Keep the report panel displayed on top of other windows.
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Section  Setting Default Description
Print Panel on top Enabled Keep the print panel displayed on top of other windows.
Collaboration Panel Enabled Keep the collaboration panel displayed on top of other windows.
on top
Patient folder ontop  Enabled Keep the patient folder displayed on top of other windows.
Report Full Selected Default to the full report panel when opening the report panel.
Panel Compact Unselected Default to the compact report panel when opening the report panel.
Audio Enabled Show/Hide the audio toolbar on the report panel.
Annotation Disabled Show/Hide the annotation toolbar on the report panel.
Report Enabled Show/Hide the report toolbar on the report panel.
Orientation Disabled Show/Hide the orientation toolbar on the report panel.
Template Enabled Show/Hide the canned report templates toolbar on the report panel.
Toolbox Disabled Show/Hide the toolbox toolbar on the report panel.
Layout Templates Enabled Show/Hide canned report templates toolbar on the layout manager.
Manager Grid Layouts Enabled Show/Hide the grid layouts toolbar on the layout manager.
Tile Layouts Enabled Show/Hide the tile layouts toolbar on the layout manager.
Image Size 25% Size of orthogonal image displayed as an overlay in image frame
overlay Bottom Left/Right Right Default location of orthogonal image overlay
Button Auto/Big/Small Auto Button size used on the selected monitor. Auto tells the viewer to
size automatically apply large buttons and thumbnail images when the
monitor size is greater than the value defined in MPx.
MPx 25 The point at which Auto button size uses the Big button size,

specified as mega pixels.

4.1.3 LAYOUT SETTINGS

The layout settings page contains settings for
presenting information in the Practice Builder 1-2-3
viewer. The page provides parameters for properly

Advancet d | Sspine | Dictation | Speech recogrition |
| DICOMfelds | Hashmaks | Prefetch | Cache

Auto PS |
| Memoy |

Colors |
Settngs | View

organizing series and image data, default sizes for
thumbnail and report images, selecting default grid
layouts, and identifying default hanging protocol
templates. To display the layout settings page,
select Customize Settings from the Settings menu,
and click on the Layout tab.

The settings on the layout page apply to specific
image types. Practice Builder 1-2-3 identifies an
image type by the modality values stored in the
series object. To assign settings to a particular
image type, you must first select the modality type
from the pull-down menu on the layout page. A

Mentor setting Settings for:  [MR -
%' Mulile monter mage layout
-
Automatic settings -~
7 Findlocalzers - - -
7 Spit series P - -
[7 Sort series & ~ ~
eres spit lengin: [0
o) T row T column:
Thumbnai si o
W Use defauk size iz
== ~
Sae: [ 64— pock
Report figure size
W Use defauk size I
Sze: [ 256 pocels
= ¥ Autodoad localizers
Report panel
perp ¥ Use hanging protocol assistant
¥ Uss defauk setting
i B e |
oK Cancel | Resctl |

general image type, called Default, appears at the beginning of the pull-down menu. When this value
appears in the pull-down menu, the setting applies to all image types unless overridden with a specific
setting. There are checkboxes on this page labeled Use Default. When checked, Practice Builder 1-2-3
uses the default setting for the selected image type. In other cases, a gray check appears in the
checkbox, indicating the selection is actually defined by the default setting.

The table below provides detailed information on each of the settings on the layout page. There are two
settings that apply to the entire page, and therefore are not assigned to any single section. The Settings
For: menu contains all of the supported modality types that the settings on this page can apply to. The
Use hanging protocol assistant checkbox enables and disables a number of the sections on this page. If
the hanging protocol assistant is enabled, the hanging protocol template defines many of the settings.

When disabled, the user settings take precedence.
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Section Setting Default Description

Panel Settings for: - Select the modality the settings on this page apply to. Select the
modality type Default to set the default settings for all the
undefined parameters.

Monitor Multiple monitor Enabled Permit the viewer to appear on all enabled monitors for the

setting selected modality type. This setting is effective only when multiple
viewer monitors are configured enabled, or the number of monitors
configured on the view page is greater than 1.

Automatic  Find localizers Enabled When enabled, separate localizer images grouped in series with

settings non-localizer images into their own series. When disabled,
localizer images are grouped as specified by the object data.

Split series Disabled Some series contain images in different planes, or using different
acquisition parameters. The viewer can sometimes identify these
series. When Split series is enabled, the images are grouped
together into individual series and made available to the user.
When disabled, the series are grouped as specified by the object
data.

Sort series Disabled When enabled, always sort the images by image position, or slice
number when position information is unavailable. When disabled,
the series is ordered as it arrived at the server.

Series split length 0 For series with fewer images than specified in the Series split
length setting, separate all images into their own series. Useful for
separating CR series into single images. Maximum value is 12.

Thumbnail _Use default size Enabled  Use the default thumbnail size.

size Size - Override the default thumbnail size for the selected modality. The
value is defined in pixels-squared

Report Use default size Enabled Use the default image size.

figure size “gj;¢ - Override the default figure size for the selected modality. The
value is defined in pixels-squared.

Report Use default setting Enabled Use the default BIRAD setting

panel Show BIRADS - Display BIRADs list on the report panel for the selected modality

Image Use default setting Enabled  Use the default image layout setting.

Layout Tile across monitors ~ -- When selected, the selected tile mode is applied across all
enabled monitors.

N-up - The default grid layout for the selected modality type.

Custom - Define a custom grid layout for the selected modality type.

Template  Use default template  Enabled  Use the default hanging protocol template setting.

Template menu - Select the hanging protocol template to apply to studies of the
selected modality type.

Show layout Enabled When enabled, display the layout manager after applying a

manager hanging protocol template. When disabled and a template was
automatically applied, do not show the layout manager.

General Auto-load localizers Enabled When enabled, include localizer images when automatically
loading series into image frames.

Use hanging protocol Enabled  When enabled, the hanging protocol assistance attempts to select

assistant

the best-defined hanging protocol template based on previous
usage. When disabled, the Template settings take precedence.

Reset hanging
protocol rules

Reset the learned hanging protocol rules to the default values.
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4.1.4 |IMAGE SETTINGS

The customize setting window’s image settings page
contains image communication and interpretation
information, including defaults for compression modes,
interpolation algorithms, and default window and level
settings. To display the image settings page, select
Customize Settings from the Settings menu, and click
on the Image tab.

These settings apply to specific image types, identified
by the modality parameter stored in the series objects.
To assign settings to a particular image type, select the
modality type from the pull-down menu on the image
page. A general image type, called Default, appears at
the beginning of the menu. When selected, the settings
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apply to all image types except those overridden with a specific setting. The Use Default checkboxes on

this page refer to these default settings.

The table below provides detailed information on each of the settings on the image page. There is one
setting that applies to the entire page, and therefore is not assigned to any single section. The Settings
For: menu contains all of the supported modality types that the settings on this page can apply to.

Section Setting Default Description
Panel Settings for: - The modality settings on this page apply to. Select Default to set
the default settings for all the undefined parameters.
Apply VOI LUT Enabled When checked, apply the VOI LUT, if present, to the image when
displayed. Default is checked.
Use W/L Range Min 0 When overriding the defined window/level setting for an image, this
is the lower window width setting. Total range cannot exceed 32K.
Max 4096 When overriding the defined window/level setting for an image, this
is the upper window width setting. Total range cannot exceed 32K.
Automatic Enabled When enabled, use the actual pixel range as the window width and
automatically calculate the level. When disabled, use the values
defined in Min and Max. This setting applies only when no default
window width and center value exists in the image object.
Interpolation Use default Enabled  Use the default interpolation algorithm.
Nearest pixel Use pixel replication to create pixels.
Bilinear Default Use a bilinear interpolation algorithm to create pixels.
Compression Use default Enabled  Use the default compression algorithm.
Uncompressed Do not use any compression on the image data.
Wavelet Compress the image data using a progressive wavelet algorithm.
Auto Default The viewer selects the best compression setting based on network
configuration and utilization.
Auto WIL Setting  Use default Enabled  Use the default auto W/L override setting.
No override Default Do not override the W/L setting defined in the image object.
Override by When the entire study defines a full window width, replace it in
study each image with a calculated histogram equalization value.
Override by When the entire series defines a full window width, replace it in
series each image with a calculated histogram equalization value.
Override by When the image is defined with full window width, replace it with a
image calculated histogram equalization value.
Override all Replace the W/L values for each image in the study with its auto
range value, regardless of the default values.
Wavelet Quality Use default Enabled Use the default wavelet quality setting.
Lossless Default When using wavelet compression, use bit conserving quality factor.
N:1 Lossy When using wavelet compression, terminate the decompression
when the selected ratio is achieved.
Auto W/L Range  Use default Enabled  Use the default automatic window/level range.
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Section Setting Default Description
Distribution 95% To eliminate the noise that may exist at the extreme ends of the
distribution curve, reduce the data set to the defined distribution
range.
Zoom mode Use default Enabled  Use default zoom mode.
Fit to window Default Fit the image to the image frame. Use the interpolation algorithm
selected for this modality type to create additional pixels.
1:1 Display only original pixel data, with no zoom factor applied.
Actual size Display the image in the actual image size. This requires the

monitors be calibrated for size before opening a study, and the
image objects include pixel size information.

4.1.4.1 Ignore Default Window/Level Setting

Some modalities explicitly define a window width that reflects the full range of the pixel data, or a center
value outside the window range, even if these settings result in poor image quality. By default, Practice
Builder 1-2-3 applies predefined window width and center values, regardless of the results. To avoid
applying bad window and level values, use the Auto W/L Setting tool to ignore the predefined values and
use its own histogram analysis to set the initial window and level.

On the image settings page, go to the Auto W/L Setting area, select one of the override settings. No
Override instructs Practice Builder 1-2-3 to use the window and level setting predefined in the image
object. Override by Study/Series/Image means use the internal histogram analysis algorithm when the
entire study, series or image defaults to a full window width. (The optimal setting is Override by Series).

4.1.4.2 Correcting Invalid Window and Level Settings

Some imaging modalities and PACS systems change the original image data, causing rendering
problems in a third party system. If this occurs when using Practice Builder 1-2-3, you can force a
correction that adjusts the window and level settings. From the image settings page, go to the Use W/L
Range field, and set the minimum and maximum window and level settings for each modality. If you need
to use the defined range, select Automatic, in which case Practice Builder 1-2-3 uses whatever the image
object has defined for itself.

4.1.5 DICOM SETTINGS

The DICOM fields settings page contains tools for — e« | smed | e | s || tmemnn |oper
defining the overlays that appear on the images in the — Do boen ——

viewer and on printed film. To display the DICOM fields o) e =

settings page, select Customize Settings from the AT

Settings menu, and click on the DICOM Fields tab. Frma .

The settings on the DICOM fields page apply to specific

image types, identified by the modality parameters stored

in the series object. To assign settings to a particular

image type, select the modality type from the pull-down

menu on the DICOM fields page. A general image type,

called Default, appears at the beginning of the pull-down hi
menu. When this value is selected, the settings apply to
all image types except those overridden with a specific
setting. When checked, the box Use the default list for this display location instructs Practice Builder 1-2-3
to use the default setting for the selected image type.

Cancel Reset A |

The table below provides detailed information on each of the settings on the image page.

Setting Description

Settings for: Select the modality the settings on this page apply to. Select the modality type Default to set the
default settings for all the undefined parameters.
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Description

Use the default
list for this display
location

Instructs the viewer to use either the default setting for the specified Display Location, or to
customize the Display Location for the selected modality type. When checked, the default
settings are used. When cleared, the control panel is activated and you can customize the
attributes. The default is checked.

[Control panel]

Work area for organizing the selected attributes to display in the area specified in Display
Location. Clear the check in the Use the default list... box to activate this area.

Display Location:

The areas of the image and film that you can place demographic and study information. The
available options include top-left, top-right, bottom-left and bottom-right corners of an image,
and the header on a printed sheet of film. Select the appropriate location from the menu before
making changes to the control panel.

Character Size:

The font size of the overlay data. The font type is not configurable.

Tag:

List of available attributes tags from the DICOM object. This list is created from the attributes
defined in the object loaded in the viewer. If the attribute does not exist in this list, it is not
defined in the DICOM object.

Info: List of calculated values that can be used in overlays.

Add Tag Click this button to add an attribute from the Tag list.

Add Info Click this button to add a value from the Info list.

Add Text Click this button to add a text string.

Break Click this button to insert a carriage return (new-line) character.
Remove Click this button to remove the item selected in the control panel.

Up/Down arrow Move the selected item in the control panel up or down the list.

Defining overlays for images and film consists of selecting the area of the image or film on which you
want to display some data, selecting the information you want to display, and then formatting the
information. Practice Builder 1-2-3 comes with a default overlay defined for all modality types. You can
modify the general overlay specification, and also customize each overlay for specific modality types. The
rules for doing either are the same.

Start by selecting the modality type from the Settings for: menu, or chose the default if you want to
change the common overlay definition. Then, select the location of the overlay from the Display Location:
menu. The control panel updates to show the current settings for that location. If the control panel is
inactive, remove the check from the Use the default list for this display location box. The control panel can
contain literal stings, such as labels, patient demographics, study information, calculated values, and
new-line characters. Use the buttons to the right of the control panel to add and remove these fields.

When you want to insert an attribute, find it in the Tag or Info list, and click on the respective Add button.
To insert a literal string, click on the Add Text button. A popup window appears. Enter the text, and click
OK. The string appears in the control panel in quotation marks. Move the fields around the control panel
by selecting the attribute and clicking on the up and down arrows to the right of the control panel. To
insert a carriage return between two attributes, insert a new-line character by clicking on the Break button
and moving it to the appropriate location. Remove any attribute in the control panel by selecting it and
clicking on the Remove button.

The Info list contains calculated values, generated by Practice Builder 1-2-3 and based on the loaded
study. The list of available values in the Info list is as follows:

Processed keyword value used by hanging protocol assistant to identify
the series description.

The percentage of the image that has already downloaded to the viewer.
The compression ratio applied to the image.

If an annotation is currently selected, the value of that annotation (i.e.,
the length, area, text string, etc.) appears in the overlay.

Hanging protocol’s matching criteria information.

Augmentation
Completion
Compression
Current Annotation

HP Series Info
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Image Index The position of the image in the series. This is different from the Instance

Number in the Tag list. The Instance Number is a value defined by the

modality, and is not guaranteed to be sequential. The Image Index uses
the position in the series, and therefore is always sequential.

Level Current window center setting.

Packet Size Size of the network packets in the download transmission.

Renderer Image rendering method: sw (software), bd (hardware) or d3d (Direct3D).

Series Size Total number of images in the series.

Window Current window width setting.

Zoom The zoom factor currently applied to the image.
The example of the overlay settings shown here includes Ea—— Ep—— N
the control panel for the top right and bottom right image  [&@ = [Topran G AEDOIMER PHE
areas, and the resulting image. In the top-right, a carriage [ uss he defautst for this display location cT
return separates each of the three fields, and there are no  [Sapesiin 7| [
literal strings displayed. As a result, in the event the value |seisDesciion ]
is empty, the field on the image will be blank. Sometimes it [+ AT

is better to include a label so when no value exists, it is
more obvious to the user.

Settings for, Digplay Location:

5] | | Botlom Rkt »

™ Use the default list for this display location

In the bottom-right, a literal string exists to separate the two

. . R R . ¥ Image Index H Add Tar
fields. With no carriage return included, all three fields |+ [
Add Infe

appear on a single line when displayed on the image.

4.1.6 HASH MARK SETTINGS

The hash mark settings page defines the parameters o Mt || b | e | e |
the Practice Builder 1-2-3 viewer uses to calculate ' oo
spacing limits for hash marks and other positioning
features. You can define the distance that defines
intersecting image planes and when the Magic X
positioning tool is out of range. This setting page also Lo s

sets the defaults for which kind of hash marks to st ool MW o
display. To display the harm mark settings page, select
Customize Settings from the Settings menu, and click
on the Hash Marks tab. iy e,

Hash madk spacing

Mrarum dutarcs betweer: hash mahs D= o

Practice Builder 1-2-3 makes a distinction between
hash marks and localizer lines. A localizer line is
graphic that shows the intersection of one image on ot | e | rees |
another. This setting applies to the selected image and results in a single line on the intersecting images.
Hash marks are the collection of multiple localizer lines. This setting applies to all the series of images in
the selected frame. The result is one or more lines draw in the intersecting images, with the displayed
image (in the stack frame) displayed using a bold line.

The following table describes the fields that appear on the hash mark settings page.

Section Setting Default Description
Hash Mark ~ Minimum distance 0 mm Too many hash marks in a small area obscure the radiograph
Spacing between hash marks behind them. This setting defines the minimum spacing permitted
between hash marks.
Localization Minimum angle 90° Some images are not completely orthogonal to others. This setting
Criteria between image defines the angle of incidence between two intersecting planes that
planes qualifies for displaying a localizer line denoting the intersection. If

the two planes intersect at an angle greater than that defined, the
localizer line appears on the image.
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If the current position of the Magic X tool is more than the specified
distance from the last image in a series, the graphic dims to a light
gray. The graphic remains gray until the current position is within
the defined distance, or it reaches the Disable distance.

Section Setting Default Description
Magic X Dimmed Magic X out 10 mm
Limits of N mm.

Disable Magic X out 100 mm

of N mm.

If the current position of the Magic X tool is more than the specified
distance from the last image in a series, the graphic disappears.

4.1.7 PREFETCH SETTINGS

The prefetch settings page in the customize settings .7

window configures the server setup for prefetching
images. The page contains the server address, the
protocol used to communicate with the server, prefetch
settings and compression settings. To display the
prefetch settings page, select Customize Settings from
the Settings menu, and click on the Prefetch tab. Refer
to section 4.5.1 for information about setting up
prefetch.

The Compression section settings apply to specific
image types, identified by the modality parameters
stored in the series object. To assign compression
settings to a particular image type, select the modality

oK ] Cancal |_ Fasst A -:

type from the pull-down menu in the Compression section. A general image type, called Default, appears
at the beginning of the pull-down menu. When Default is selected, the settings apply to all image types
except those overridden with a specific setting. There are checkboxes on this page labeled Use Default.
When checked, Practice Builder 1-2-3 uses the default setting for the selected image type.

The table below provides detailed information on each of the settings on the prefetch page.

Section Setting Default  Description
General Server http Use a secure (HTTPS) or open (HTTP) connection to the server.
(protocol)
Server NULL The server address. This value can be a hostname, such as
(address) pacs.hospital.com, or an IP address, such as 10.0.0.1.
Note: The format (IP address or domain name) of this address must
match the format used in the URL line of the browser.
Cycle time 30 The time between queries for new studies. The more frequent the
minutes  query cycle, the more traffic that results on the network.
Intensity Max The amount of available bandwidth to use while prefetching.
Enable Disabled Turn prefetching on and off. When checked, the workstation queries
prefetch the server once every cycle for new studies as defined by the
prefetch worklist filter. When unchecked, no checking occurs.
Prefetch in Enabled  When prefetching is enabled, the query and subsequent downloads
standby mode can take CPU cycles away from other viewer activities. On slower
only machines, this can impact the GUI performance. When Prefetch in
standby mode only is checked, the query executes when the viewer
is inactive and in standby mode. Clear this checkbox to continue to
query and download studies when the viewer is open.
Check server - This button checks to see if the configured server is available. Use it
to verify your configuration of the server.
Study Data Settings for: - The modality the settings in this section apply to. Select Default to
Download/Image set the default settings for all the undefined parameters.
Same as Enabled When checked, the viewer ignores the compression settings on this
Image settings page and defaults to those on the Image settings page. To activate
the settings on this page, clear the checkmark.
Compression Use default Disabled Use the default compression algorithm.
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Section Setting Default Description
Uncompressed Do not use any compression on the study data.
Compressed Compress the study data. This uses lossless wavelet.
Wavelet Compress the image data using progressive wavelet algorithm.
Auto Default The viewer selects the best compression setting based on network
configuration and utilization.
Wavelet Quality  Use default Enabled Use the default wavelet quality setting.
Lossless Default When using wavelet compression for the image data, use a bit
conserving quality factor.
N:1 Lossy When using wavelet compression for the image data, terminate the

decompression when the selected ratio is achieved.

4.1.8 CACHE SETTINGS

The cache settings page defines the parameters the — o= | we= | s | e
Practice Builder 1-2-3 viewer's cache uses to manage
the study and image data. The page contains the location
of the disk cache, its size and some control parameters. e
To display the cache settings page, select Customize
Settings from the Settings menu, and click on the Cache .
tab. =——— e

F Ptasfomtecachester | 10 do

The workstations’ data storage cache uses a portion of
the available disk space. When you open or prefetch a
study the first time, Practice Builder 1-2-3 transfer the
data from across the network and stores the data in the
cache. For subsequent opens, Practice Builder 1-2-3
uses the data in the cache, eliminating the network
transfer. Unless you have a complete understanding of the ramifications of changing the size of the disk
cache, ask your administrator for assistance.

oK Cocel | Hestna |

Practice Builder 1-2-3 manages the cache itself, so user maintenance is not required. The cache settings
page allows you to change the default cache settings, and to reclaim the cache space by clearing it. If you
clear the cache, the data downloads across the network from the server the next time you open the study.
Note that when upgrading the viewer to a new version, the cache may be cleared automatically.

Section Setting Default Description
Cache Directory C:\Program Files\ The directory used for the disk cache. If the default directory does
name PracticeBuilder\ not contain enough disk space, change the setting to a disk drive
PBCache\ that does. Create the directory before entering it here.
Directory 10 GB The size of the disk cache. It should be large enough to store all the
size images you want to be available locally at any one time. If too small,
redundant image downloads result. If too large, other applications on
the workstation may not have the disk space they need.
Sync cache - Rebuild the cache directory.
Empty -- This function empties the cache. Use it to recoup disk space taken
cache up by cached data.
Purge files Enabled, setto 3 To purge the data from the local disk cache on a regular basis,
from cache days. check in the box and enter the number of days between purges.
after N days Minimum setting is 1 day.

4.1.9 COLOR SETTINGS

The color settings page contains tools for customizing the colors of the different parts of the viewer. To
display the color settings page, select Customize Settings from the Settings menu and click on the Colors

tab.
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You can customize many of the colors used in the =z @ | e | oouee | e | S ]

Practice Builder 1-2-3 viewer. The list below defines
each of the areas. When you select an area, the current
color setting appears to the right of the area list. The

Ciier sebtencn

color panel that pops up contains a list of predefined e okl
colors, and an option for defining custom colors. LT
Annotations Image
annotations
Background Viewer
background
Calibration rulers Calibration ruler
annotations T

Current image

Grid splitter

Hash line shadow
Hash lines

HP series info

Image background
Information overlay text

Information panel background

Information panel text
Marker line

Orientation information
Overlay #1-16

Report panel background
Report panel text

Scale markers

Selected annotations
Selected image

Series #1-4

Tab text deselected
Tab text selected
Viewed marker
Visible image

Frame color of

selected frame’s thumbnail image

Image grid border

Used when only part of the localizer line intersects the image
Localizer lines and hash marks

Hanging protocol’s matching criteria information

Color of the image frame that does not contain image data
Color of the overlay text displayed on an image

Background color of the information (info) panel

Color of the text in the information (info) panel

View area border displayed on thumbnail images, when Ant Line
Marker setting is disabled

Color of the orientation (left-right) markers overlaid on the image
The 1% through 16" embedded overlay

Background color of the report panel

Color of the text in the report panel

Rulers indicating image size

The active annotation, when creating or editing

Grid border color of the selected image frame

Color of the thumbnail border for 1% through 4" series. Colors
repeat starting with the 5™ series.

Tab text color for unselected patient folder and report panel tabs.
Tab text color for the selected patient folder and report panel.
Image viewed indicator on thumbnail image border

Color of the thumbnail image border for a series loaded in the
selected image frame

The table below provides detailed information on each of the settings on the colors page.

Section Setting Description
Color Settings Area list A list of areas that can be customized.
Change This button pops up a window from which you can set the color.

Reset selected color

Resets the selected area to the default value.
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4.1.10 MEMORY SETTINGS

Memory settings control EP’s memory allocation. They — w. | wew | s o
impact the performance of the viewer and its interaction o
with other applications executing on the workstation. Do
not modify these settings without some understanding of
Microsoft Windows' memory management system. To
display the memory settings page, select Customize
Settings from the Settings menu, and click the Memory

e

| et e memory sed by temporary images

tab. el T

ESIE L
Setting Description
Override default mapping Check this box to define a memory allocation limit different from the default 16MBs.
limit
Try to map no more than The value of N specifies the total amount of memory allocated. Additional memory will
N MBytes be allocated only as needed.

Limit mapped memory
used by temporary images

Check this box to define a memory allocation limit different from the default 953MBs.

Try to use no more than N
MBytes

The value of N specifies the amount of memory allocated for image bitmaps.
Additional memory will be allocated only as needed.

4.1.11 ADVANCED SETTINGS

The advanced settings page defines miscellaneous =, '™ Jam )/ mo LTt LD Lt L |
Practice Builder 1-2-3 viewer parameters. To display the
advanced settings page, select Customize Settings from rke ow o
the Settings menu, and click on the Advanced tab. T o ¥ w ik compmsen
The data packet size settings define the network packet Z
size best suited for fast data transfers. The study data

download section controls the compression used on the {3 e e e
control data downloaded to the workstation each time you ; 2 Sy
open a study. The progress of the control data download o
is denoted by a blue progress bar displayed in the Status
bar along the bottom of the main viewing area. The

following table explains these settings and the others on e
this page.
Section Settings Default Description
General Settings for: - Select the modality the settings on this page apply to. Select the
modality type Default to set the default settings for all the undefined
parameters.
Annotation font 8 point Font size for the text used for annotations.
size
Keep last N 25 Keep the specified number of print logs on the workstation. Print
DICOM print logs show the results of a DICOM print request, and may be useful
logs in the event a problem occurred.
Keep last N text 20 Keep the specified number of text annotations in the annotation text
annotations list.
Connect to Disabled When a proxy server is involved in the routing between two

collaboration
peer directly

collaborating workstations, the viewer needs to know to attempt to
connect directly. When a check appears in the box, the workstation
attempts to connect to the other workstation directly.
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Section Settings Default  Description
Adjust thread - Adjust the viewer process’s thread priorities. See section 4.1.11.2.
priorities

Data packet Auto Auto Viewer selects the best packet size to use when transferring data

size from/to the server based on network configuration and utilization.
Size Override the automatic packet size setting and force packets to the

specified size. Smaller packets are best used in slow, busy
networks. Larger packets are best used in fast, quiet networks.

Study data Use default Enabled Use the default compression algorithm to download the control data,
download thumbnails, etc.
Uncompressed Do not use any compression on the control data.
Compressed Compress the control data. This uses lossless wavelet.
Auto Default Viewer selects the best compression setting based on network
configuration and utilization.
D3D Usage Disable startup  Disabled Disable the warning notifying you that Direct3D is not available on
warning your workstation.
Disable D3D Disabled Disable support for Direct3D. Some display controllers report they
rendering support Direct3D, but actually do not, resulting in invalid images.
41.11.1 Automatic Communication Optimization

Practice Builder 1-2-3 attempts to optimize the communications between the server and the viewer
according to the available bandwidth, the network speed, location of the workstation, etc. You have the
ability to override the optimization, but it is not recommended. To have Practice Builder 1-2-3
automatically perform this optimization, set the Data Packet Size to Auto and the Study Download Data to
Auto.

When set to optimize the communications, Practice Builder 1-2-3 packages the initial study information it
sends to the viewer when loading the study based on the network performance. For example, if the
Server detects that the workstation is located on the same local area network (as defined in the LAN-
accessible IP Addresses section of the System Options on the Server page), the study information is
transferred uncompressed in large data blocks, which improves the delivery time over a fast LAN. If the
connection between the server and viewer is across a slow wide area network, Practice Builder 1-2-3
opts for compressed data and smaller packet sizes.

41.11.2 Thread Priorities

The Practice Builder 1-2-3 viewer consists of multiple
threads, or processes, that perform specific functions.
The system assigns a priority to each of these threads
that the operating system uses to know which one to | "=
execute before the other. Since every platform is
affected by numerous issues such as other running | "o
programs, amount of RAM, free disk space, and |
network performance and reliability, it may be | i
necessary for a user to override the default priorities
and customize them for the specific environment. s

@i @ Lowet @ Belowromsl @ Noma O Aboveroms @ Highest @ Time criical

TE | Cocel | [ Resmt |

Practice Builder 1-2-3's default thread priorities are set
to work best across all supported platforms. This
generally means the default settings are not optimal for any specific platform. Tweaking the thread
priorities may improve your viewer’s performance.

The thread priority setup tool is available from the customize settings’ advanced page. Click on the Adjust
Thread Priorities button to display the configuration window. The window contains two color-coded bars
and a number of actions, as shown in the image to the right. The left bar controls the rendering and
loading functions. The right bar controls the decompression process. The colors in the bars indicate the
priority. Blue indicates the lowest thread priority, red the highest. The actions are listed in the table below.
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Load visible images

Loading images that are visible in the viewer, such as on the top of a
stack in an image frame.

Load opened images

Loading all images in the selected frame, including those that are not
currently visible on the user interface.

Load images

Loading all other images in a study.

Prefetch images

Prefetching studies from the EP server to the workstation.

Decompress visible images

Decompress images that are visible in the viewer.

Decompress open images

Decompress images in the selected frame.

Decompress images

Decompress all other images in a study.

To adjust the priority, left-click on the circular knob and drag it along the color-coded bar until the action is
within the priority level you want. Since the priority levels cannot cross each other’s border, it may be
necessary to move multiple knobs to get the action within the correct priority range. Start by moving the
lower-priority knobs first. When you've set the priority level for all of the actions, click on OK to save them.
To reset the priority levels to the manufacturer’s default, click on Reset.

4.1.12 SPINE TOOL SETTINGS
The spine tool settings page defines default settings for ™ ' "1 .3

DEOMteids | Hashmaks | Pocletch Cache |
Dhcladion Sprechemeogben | AdsPS |

i
i
gf

the spine labeling annotation tool. The configuration

defined on this page is reflected in the spine labeling

window when you activate the annotation tool. To display 3 3

the advanced settings page, select Customize Settings T e, =
from the Settings menu, and click on the Spine tab.

The spine labeling function is an annotation tool used to e wan [T e
quickly label the components of a spine. When activated,

& Cervcal venetrae " Sacral veriebrae

™ Thatesl vatsbess [l LR

the user clicks on an image, and the next spine label — imavon € cous
appears. Subsequent clicks add the next label. To

progress smoothly through the spine without requiring
user interaction, defaults are needed. This page provides

[ Coced | Pemd |

the default settings used by the spine-labeling annotation tool.

Section  Settings Default  Description

Initial Vertebra Enabled This is the starting point for the vertebral labels. Select the

Settings starting vertebra. If the Vertebra radio button is selected,
the tool defaults to labeling vertebral disks.

Disk Interspace Disabled This is the starting point for the disk interspace labels.
Select the starting disk interspace. If the Disk Interspace
radio button is selected, the tool defaults to labeling disk
interspaces.

Include L6 Disabled If checked, include L6 in the list of lumbar disks. If clear,
L6 is not included in the default list of lumbar disks.

Reverse Direction Disabled If clear, labeling progresses in the direction from cervical
to sacral disks. If checked, labeling progresses in the
reverse direction.

Show lines Disabled If clear, labels appear with no lines connecting the label to
the focal point. If checked, lines connecting the label to the
focal point appear.

Label Cervical C Default prefix for new cervical disk labels
Texts Thoracic T Default prefix for new thoracic disk labels
Lumbar L Default prefix for new lumbar disk labels
Sacral S Default prefix for new sacral disk labels
Size Height/Width - The height and width of the vertebra and interspaces,

used when locating the intersecting points on orthogonal
images. The value corresponds to the selected radio
button.
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Description

Cervical, Thoracic, Lumbar, -
Sacral vertebra, C-C Interspace,
and Other Interspace

The object that corresponds to the reported height and
width setting.

4.1.13 DICTATION SETTINGS

The dictation settings control the tools available for s [ | e | | omous | e | buss | com | e |
recording dictated reports, including Philips i
SpeechMike and general microphone controls, foot S e — .
pedal settings and control of the rewind and fast- o 2
forward tools. For backward compatibility, the ' =
default settings conform to previous behavior. To
display the dictation settings page, select e ) _
Customize Settings from the Settings menu, and e =i e
click on the Dictation tab.
These settings are part of the user profile, so they e S e 2 o [ 500 s
follow the user to each workstation. This could be a ot P
problem for the selected foot pedal device. If a
device is selected on one workstation and does not : |
exist on another, the foot pedal setting may need to ERN] o ]
be changed each time the user switches workstations.
Section Settings Default Description
SpeechMike Type None Type of Philips SpeechMike device used. Options are None, Push
button and 4-position switch. See section 8.2.3.1 for details.
Control mode — Disabled  SpeechMike’s record button toggles the state, On or Off. Toggling
State based the state requires the SpeechMike be activated by pushing to top
middle button. When active, the red light is on and steady.
Control mode - Enabled Speechmike’s record button is On only when the button is pressed.
Persistent
SpeechMike button  Enabled Controls the audible click when pressing a button on the
click SpeechMike. When enabled, a click sound is heard for each button
click. The click sound is controlled by Windows, and can be
changed from the Sounds entries in the Windows control panel.
SpeechMike pause Enabled Controls the audible feedback while the SpeechMike is in pause
tick mode. When enabled, a click sounds every two seconds when the
SpeechMike is in pause mode. The click sound is controlled by
Windows, and can be changed from the Sounds entries in the
Windows control panel.
Record start/stop Disabled  Play back an audible sound every time the record button is pressed
tick or released.
Keep Speech-Mike  Enabled Keeps the SpeechMike activated when you pause your recording.
active
Foot pedals  Type None List of installed foot pedal devices. Select the applicable one.
Playback mode — Enabled Each push of the foot pedal changes the state, from play to stop
Play/Stop playing.
Playback mode — Disabled  Recording plays only if the foot pedal is pressed.
Push-to-play
Rewind/Fast Steps Enabled Each push of the rewind/FFW pedal advanced the set number of
forward seconds in the records. Holding down the pedal for the Hold Down
period rewinds or fast forwards to the beginning/end of the stream.
Continuous Disabled  Rewind/FFW continues as long as the pedal is pushed.
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4.1.14 SPEECH RECOGNITION SETTINGS

The speech recognition settings control both the — sew |vec | e | e | oo | o | s | oo | oy |
embedded speech engine plus all supported third- =l o e
party speech recognition systems. To display the

speech recognition settings page, select Customize s teril o SR
Settings from the Settings menu, and click on the = [
Speech Recognition tab. f et s

The embedded speech recognition feature supports s s o

multiple options. The workstation must have both the ey |

engine’s client and the Practice Builder 1-2-3 = .. ]

Embedded Speech Recognition license installed.
When both are present, the option and its
configuration parameters are enabled.

ok | Cacel Reset 4 |

Some embedded speech options include application
speech control. The custom commands can be downloaded from this window but need to be installed
from the engine’s command browser. Details on this and other features of the embedded speech
recognition tool can be found in section 8.2.4.1.

Practice Builder 1-2-3 supports third party speech recognition packages by initiating the speech system'’s
client using information about the loaded study. If the client application and the associated Practice
Builder 1-2-3 third-party speech recognition license are installed on the workstation, the option and its
associated configuration parameters are enabled in the settings window. In the case of third party
solutions, EP does none of the voice to text conversion. How and where that operation takes place is
defined by the third party application. For information on which third party speech recognition systems EP
supports, refer to section 8.2.4.3

Section Settings Default Description
3" Party Account ID <EP user ID> Account ID sent to the speech recognition engine or
Speech third-party system.
Recognition  Password Password sent to the speech recognition engine or
third-party system.
Use Speech Recognition None A list of configured and available speech recognition
System systems. Options might include the following:

None: Record voice stream as a WAV file, and do
not convert any of it to text.

Dragon: Activate the embedded Dragon speech
recognition engine.

Fluency Direct: Active the embedded Fluency Direct
speech recognition engine.

Powerscribe: Activate Nuance’s Powerscribe client
application.

SpeechMagic: Active the embedded SpeechMagic
speech recognition engine.

VR1 or VR2: Activate eRAD’s VR2 or VR2 client
application.

XML Interface Speech Recognition: Activate the
(generic) XML file-drop integration method.
Works for Fluency Direct, Powerscribe, VR1
and VR2 as well.

Auto Record WAV when Disabled When using Dragon, also record the voice stream as

dictating save it as a WAV file on the server.

Show Full report panel Disabled After disabling the SpeechMike, the full report panel

after dictating opens automatically. This works best when the
SpeechMike is configured in State-based control
mode.
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Section Settings Default Description

Setup for XML File C:\Dictaphone\ XML file written to disk when an integrated speech
Dictaphone study.xml recognition system is selected as the default.
Dragon Download Voice - Download the Viewer voice commands to the local
Naturally Commands disk for importing into Dragon’s Command Browser.
Speaking Listen for Command — Default Speech recognition engine accepts input only when

While dictating

the Record button is pushed.

Listen for Command —
Always

Speech recognition engine is always listening and
responding to commands.

4.1.15 PRESENTATION STATE SETTINGS

The presentation state settings page contains default setting for ==
the presentation state creation panel
automatically creating presentation states and key images. To
display this settings page, select Customize Settings from the
Settings menu, and click on the Presentation State tab.

When the user manually creates a presentation state, the
presentation state creation panel pops up. The settings default
to the values defined in the Default Settings of PS Creation

section on this panel in Customize Settings.

Presentation states and key

and settings for

on e | _Posun

images are automatically

generated when the user drops a select annotation onto an image. When you set the option to create
presentation states or key images, a list of annotation buttons appear. Click the annotation tool that, when
used on an image, will automatically save the image and annotation as either a presentation state or key

image.

Key images are attached to the study’s report. They are uploaded to the server when the report is saved.
Presentation states are created on the workstation and uploaded when the user explicitly saves them
(from the File menu) or if the viewer is configured to upload presentation states automatically when

created.
Section Setting Default Description
Default Selected image/ Selected Set the default image selection setting to be the
settings of PS Selected frame/ All  image single image, all the images in the selected frame or
creation frames all images in all frames (for the study).
Send presentation Disabled When checked, the created presentation state is
states to the server automatically sent to the server.
Automatic PS Do not generate Enabled The system will not generate presentation states or
creation presentation state key images automatically. Users will have to explicitly
settings or key images save these.
Generate Disabled The system automatically saves the presentation
presentation state state of the image when one of the annotations
selected in this panel is dropped on an image in an
image frame.
Generate Disabled The system automatically attaches the image as a

(presentation states
as) key images

key image to the report when one of the annotations
selected in this panel is dropped on an image in an
image frame.

4.2 User Profiles

Practice Builder 1-2-3 supports customizable user profiles. A user profile contains the configuration data,
viewer settings, hanging protocols, preset values and other information that make the user environment
unique for each individual.
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The system stores the profiles on the Practice Builder 1-2-3 server(s), and downloads them to the
workstation when the user logs on. As a result, changes a user makes to his or her profile while logged in
at one workstation automatically propagates to the next workstation when the user changes location.

4.2.1 CREATING USER PROFILES

Practice Builder 1-2-3 automatically creates a user profile when the administrator creates the user
account. A system default user profiles exists. After the user logs on and makes changes to the default
profile, the changes are stored back on the server. It is possible to use a user profile from an existing
account as the default when creating a new user account. This provides a method for setting up a set of
default user profiles, such as one for technologists, one for radiologists, and another for orthopedists, and
using this as the baseline profile when creating a new user account. For detailed information on creating
user accounts, refer to the Practice Builder 1-2-3 Operator’s Manual.

4.2.2 APPLYING USER PROFILES

When a user logs into Practice Builder 1-2-3, the user profile for that account automatically downloads to
the workstation and remains there until the next user logs in. The user does not need to take any explicit
action to apply their user profile.

Practice Builder 1-2-3 does not support the application of another user’s profile to your account. If you
want to add another user’s setting to your profile, such as a hanging protocol template or series of preset
window width and center values for a particular modality, you must set it up manually under your own
account, or remove your entire account and recreate it using the other user’s profile as the default.

4.3 Presets

Practice Builder 1-2-3 supports preset settings for window width and center, and hanging protocol
templates. Preset settings allow you to group together one or more settings to a specific function, and
then apply those settings all at once by selecting the tag from a list. In the case of preset window and
level, you can create modality specific window/level pairs, and apply them to a selected image by
selecting them from the list. In the case of hanging protocols, you can save the layout used to display a
particular study, and then apply it to another study by selecting the tag from the list. If the hanging
protocol assistant is active, it may apply the hanging protocol template automatically. In all cases, presets
speed up image organization and presentation.

4.3.1 WINDOW WIDTH AND CENTER

The preset list of window and level values provide a list of all saved window/level settings for a specific
modality type. The preset window/level list appears in the window/level toolbar. The list of preset values is
in the pull-down menu. A few default values exist in the preset window/level list.

e Initial corresponds to the default window width and center values applied when the image is first
displayed. These values come from, first, the window width and center values explicitly defined in
the image object, and, if none are explicitly defined, the actual or auto range, depending on the
settings in Customize Settings.

e Actual Range corresponds to a full window width, centered in the middle of the maximum range,
as defined by the encoded image information.

e Auto Range corresponds to the result of a histogram equalization analysis performed on the data.
In most cases, this results in a smaller distribution than the actual range due to the interpretation
of the pixel data values.

To create a preset window/level entry, load an image into the image frame, and adjust the window width
and center to the desired values. On the window/level toolbar, click the Save button, located next to
presets list. An information box appears prompting you to enter a label for the settings. By default, the
label appears as the window width and center separated by a slash. If you want to use something other
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than the default label, clear it and enter a new name. Complete the process by clicking on Add. The label
appears in the presets list.

To change the settings for an image, set the window width and center in the selected image, and enter
the name in the text field in the window/level toolbar. Click the Save button. A notice appears prompting
you to confirm overwriting the original settings. Click Yes to complete the change.

Instruction Summary — Creating and Changing Preset Window/Level Settings
» Load image in an image frame and set the window width and center.
» Enter the preset window/level setting label in the text field on the window/level toolbar.
» Click Save.
» If the label already exists, confirm the change by clicking Yes on the popup confirmation notice.

To remove a preset window/level setting, select it from the preset list. The button next to the list changes
to a Delete button. Click on the Delete button. A notice appears prompting you to confirm the delete
request. Click on Yes to remove the preset setting.

The Initial, Actual Range and Auto Range settings cannot be deleted or modified.

4.3.2 HANGING PROTOCOLS

Hanging protocols refer to the way Practice Builder 1-2-3 displays the images on the screen. It consists of
the grid layout, which series are loaded into which frames, the tile mode of each frame, the visible image
in an image frame, series links, window/level (if saved as presets), zoom factor, and panning position.

Hanging protocol templates are available from the template toolbar. The template toolbar exists in either
the main viewing area or on the layout manager. Once you define your layout and load the images into
the image frames, save the layout.

1. Organize the images in the viewer's image frames. Enter the name of the layout:
2. Inthe Template toolbar, enter a label for the hanging protocol. MR Defaul
3. Click the Save button, E in the Template toolbar. ¥ Available for speciic modaitics
4. To create a modality-specific hanging protocol, check the box s
labeled Available for specific modalities and select the modalities
from the list. Leave it unchecked to create a generic hanging
protocol.
5. Click Save.

oK | Cancel |

When applying a hanging protocol, the hanging protocol manager removes

white spaces, if present, from the Series Description attribute of the first image in the series, converts it to
lower cases, and compares it against a list of predefined values saved for the hanging protocol. If a match
is found, the corresponding series is loaded into the assigned image frame. If no match is found, the
frame remains empty, indicating the specified series does not exist in the study.

Note: Hanging protocols created prior to v7.0 contain no series description information.
Update pre-7.0 hanging protocols by applying them, adjusting the position of the
series in the Viewer, and clicking the Save button.

4.3.2.1 Hanging Protocol Sets
Hanging protocol sets are an ordered collection of hanging protocol templates. You can apply each one
using a single mouse or button click. To create a hanging protocol set, follow these steps:

Create and save the individual hanging protocol templates to include in the set.

Press Create a New Hanging Protocol Set button ‘@
Enter the name of the layout set in the Layout Set name field.
Add at least 2 templates to the layout set to form the sequence.

rpON =
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5. Press the Save button E

Apply a defined hanging protocol template by selecting one from the pull-down list on the template
toolbar. Refer to section 5.2.3 for additional details on applying a hanging protocol template or set.

4.3.2.2 Default Hanging Protocol Template

If you use one hanging protocol template more often than any other, you can define it as the default for
studies acquired from a particular type of modality. By doing so, the hanging protocol assistant
automatically applies the default template when you load a new study of the specified type. If you decide
to use another template, simply select it from the template list in the Layout Manager.

To define a default template, do the following:

Create and save the template you want to use as the default.

Go to the Layout page in the Customize Settings window.

Select the modality the default will apply to, or choose Default to set the viewer default template.
Disable the hanging protocol assistance.

Select the template from the pull-down list.

Re-enable the hanging protocol assistant to make the default apply only when no specific
template exists.

ogkrwNE

Practice Builder 1-2-3 records the window and level settings in the hanging protocol template if the
window width and center values exist as preset window/level setting. Before saving the template, define
and save the window and level settings as a preset W/L value. Apply the W/L settings to the images in a
frame. Then save the template as previously defined. The next time you apply the template, Practice
Builder 1-2-3 looks to see if the recorded W/L setting in the template matches a preset W/L setting for the
modality type. If defined, Practice Builder 1-2-3 applies it to the image. Since Practice Builder 1-2-3 stores
a separate list of preset W/L values for each modality type, it is likely that you will not have the same
named W/L preset for more than one modality. As a result, Practice Builder 1-2-3 usually applies preset
WIL values to studies from the same type of modality that you used to create the template.

4.3.2.3 Hanging Protocol Assistant

The hanging protocol assistant is an automated pattern-matching algorithm that matches existing hanging
protocol templates to the characteristics of the study. When opening a study, the hanging protocol
assistant searches the defined templates to find the one that best matches the study. If it finds a good
match, it automatically applies it to the study. If no good match is found, the hanging protocol assistant
uses the configured default settings for the study’s modality type. If no match is found and no default
configuration exists, the assistant displays the layout manager so you can manually organize the study.

Turn the hanging protocol assistant on and off using the Use hanging protocol assistant checkbox on
Customize Settings’ Layout page. When enabled, the hanging protocol assistant inspects the
characteristics of the existing study and selects the template you used in the past for a study with similar
characteristics. The assistant looks at the following study characteristics:

e study description e number of series in study
e body part e localizer image(s)

e modality e number of monitors

L] [ ]

number of studies monitor orientation

The hanging protocol assistant learns by observing your behavior as you apply templates and creating
rules it can follow. As in any learning experience, the assistant initially knows very little about your reading
behavior. By defining, saving and applying templates appropriately, the hanging protocol assistant should
correctly select the best template after a short period of time. The hanging protocol assistant learns by
analyzing the study’s characteristics and which template you applied, and adds it to its rules base. If
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necessary, you can reset the rules to the factory default by selecting Reset Hanging Protocol Rules from
the Layout panel in the Customize Settings window.

4.3.2.4 Custom Keyword Dictionary
The dictionary the hanging protocol assistant uses to identify series is customizable. To modify the built-in
default dictionary, export it from the viewer as follows

1. From Windows Start, open a command prompt window. The location of this tool depended on
your version of Windows.

2. Change the directory to the one in which Practice Builder 1-2-3 is installed. The default is
c:\Program Files\PracticeBuilder or c:\Program Files (x86)\PracticeBuilder.

3. Run the following command: .\pbuilder.exe —osdk series_description_keywords.xml

4. From a Windows Explorer window, launch the series_description_keywords.xml file in a text
editor and make changes. For details on the file format, refer to the Practice Builder 1-2-3
Hanging Protocol Series Matching Configuration Manual.

5. Save the changes to the same file in the same folder.

When this file is found in the workstation’s PracticeBuilder folder when the viewer launches, it overrides
both the built-in default and the customized version on the server.

4.3.2.5 Display Hanging Protocol Matching Criteria

For debug purposes, you can display the criteria the hanging protocol manager is using to identify a
series for a specific image frame. The value is available as an overlay field. It can be compared to the
actual Series Description value to see why they match or don’t match.

To display the hanging protocol’s series description criteria, do the following:

1. From the View menu, select Customize Settings.

2. Select the DICOM Fields tab.

3. Select the Display Location that will display the matching criteria.

4. In the Info section, select HP Series Info and click Add Info. The field appears in the displayed
values list on the left.

5. Click OK.

When the hanging protocol manager determines a series belongs in an image frame but the current study
does not contain a series matching the criteria, the image frame is left blank. Some users might think this
is confusing or even an error. To eliminate the confusion, users might consider displaying the series
description criteria in empty image frames. When enabled, a frame without any data will display either the
description of what should be there but isn’t present in the study, or nothing indicating no assignment was
made for that cell.

To enable the series description in an empty image frame, do the following:

From the View menu, select Customize Settings.

Select the Colors tab.

In the Color Settings list, select HP Series Info.

Set the color to anything other than the image frame background color. Since the default image
frame background color is black, set the color to white.

5. Click OK.

rPONPE

4.3.2.6 Hanging Protocol Debug

If the viewer uses a custom hanging protocol dictionary file and it contains the debug tag, the viewer
creates a log file containing hanging protocol details you can use to debug the HP decision making
process.

Insert the debug tag in the HP keyword dictionary as follows:
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1. Create alocal copy of the HP keyword dictionary, series_description_keywords.xml, as described
in section 4.3.2.4.
2. Edit the HP keyword dictionary and insert the debug tag in the Default section:
<DebugLevel>x</DebuglLevel>
where x is one of the following
1 - List the scores for each combination of template’s series to study’s series
2 - List the score of each keyword by keyword comparison
3. Restart pbuilder.exe.

The hanging protocol debug log is found the ...\PracticeBuilder\DescriptionMatchingLog.txt

To disable debug logging, remove the customer HP keyword dictionary file or remove the debug tag from
the file.

4.4 Keyboard Macros

Keyboard macros are collections of existing tools applied through a single keyboard entry. For example,
reset the zoom factor, orientation and window/level setting by pressing Ctrl-Z. Keyboard macros functions
are available on the Macro toolbar (see section 3.1.14) and the Settings menu (see section 3.2.3).

To create a keyboard macro, load a study into the viewer and perform the following:

1. Click the Start Recording button, °|. o T — X
2. Apply each command in the order it is to be executed in the
macro. Fleaze enter a unique name for thiz macro.
3. Click the Stop Recording button, ﬂ The Save Action ||
Macro pane] pops up_ Accelerator key
4. Enter a macro label. <nanes Change
5. Click the Change button to define the shortcut input
sequence. This can be any combination of Ctrl, Alt, Shift and Cancel | Save |
alphanumeric key.
6. Click Save.

To apply a keyboard macro, press the input sequence assigned to the macro.

Macros are available for reviewing, editing, deleting and assigning to the context (right-click) menu from
the Macro Manager, available from the Macro toolbar or Settings menu.

To edit a keyboard macro, follow these steps:

1. Click the Show Macro Manager button, 1 i '
2. Select the macro from the Recorded Macros list.
3. Click the Edit button. -
4. Change the macro’s settings. To disable the macro but —
keep it defined, click the Change button and press ESC. |
5. Click Save. G
6. Click Close.
To delete a keyboard macro, follow these steps: e
1. Click the Show Macro Manager button, 1
2. Select the macro from the Recorded Macros list.
3. Click the Delete button.
4. Click Close.
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To assign an existing macro to a context menu, follow these steps:

Open the Macro Manager panel, ’141_

Select the context menu you want to configure from the pull down list.

Select the keyboard macro from the Recorded Macros list.

Click Add. The macro appears in the Custom Context Menu list.

Move the macro to the preferred position in the list by selecting it and using the up/down buttons.
Click Close.

ok wnE

Macros are user-specific and follow the user to each workstation automatically.

4.5 Prestaging

Practice Builder 1-2-3 workstations support prestaging technology via the viewer prefetch function. The
viewer prefetch function consists of a prefetch worklist filter defined by each user, and a query initiated by
the viewer. When the query request yields information on new studies that match the prefetch filter,
Practice Builder 1-2-3 viewer retrieves the studies to the workstation and prestages them for viewing.

In addition to the prefetching function, a registered viewer supports auto-routing. The auto-routing
function permits the workstation to have a prefetch filter, in addition to the user’s prefetch filter. Auto
routing transmits the studies that satisfy the workstation’s prefetch filter when they arrive on the Practice
Builder 1-2-3 server.

4.5.1 PREFETCHING

To turn on prefetching, enable the prefetch setting in the Customize Settings’ Prefetch panel, and
configure the Practice Builder 1-2-3 viewer to run in standby mode from the Customize Settings’ Settings
panel.

When the user enables prefetching from the prefetch page in the Customize Settings window, Practice
Builder 1-2-3 uses the worklist's filter definition labeled Prefetch to select the studies to send to the
workstation. Define a filter that includes all the studies you want to prestage on the workstation, such as
all high priority (STAT) studies, or all unviewed studies that take place during your reading hours, and
save it as the prefetch filter. When the Practice Builder 1-2-3 viewer queries the server for new studies, it
applies the user’s prefetch filter and downloads the first 20 studies that exist on the list, if not already in
the viewer’s cache.

The prefetch settings page provides the only means for enabling and disabling prefetching. An
administrator can disable prefetching by logging in from the prefetching workstation as the user who
enabled it, and clearing the checkbox.

When enabled, prefetching occurs when the Practice Builder 1-2-3 viewer is loaded with a study and
when it is running in standby mode. Depending on the resources and performance of your workstation,
you may experience interference due to the background prefetch processing when using the viewer. If
this happens, select Prefetch in Standby Mode Only in the Customize Settings’ prefetch page. When
selected, prefetching will cease when you open a study in the viewer and automatically restart when the
viewer returns to standby mode.

When prefetch is enabled and the viewer fails to connect to the configured prefetch server, a message
appears in the system tray. The message appears for 30 seconds or until the user dismisses it with a
mouse click. The message is repeated hourly.

Since prefetching continues to function after the user logs off of the workstation, excess data traffic can

result when too many workstations have prefetching enabled. Reduce the network traffic by increasing
the prefetch cycle time.
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45.2 AUTO-ROUTING

A registered Practice Builder 1-2-3 viewer can have its own prefetching worklist, independent of a specific
user. Practice Builder 1-2-3 calls this form of prefetching auto-routing. The registered viewer controls
auto-routing through an auto forward filter configured on the Practice Builder 1-2-3 server.

Start by defining a filter for all the studies you intend to auto-route to the workstation. Assign a label and
save the filter. On the Other Lists page, select the Auto Forward function for the new filter. In the popup
window, select the specific Practice Builder 1-2-3 viewer device you want to route the matching studies
to. Note that the registered viewer must exist in the device table on the Devices web page. Click Apply to
save the settings. From the viewer’'s Customize Settings panel, enable prefetching from the Prefetch tab.
When the workstation boots and the viewer enters standby mode, it periodically polls the Practice Builder
1-2-3 server. The default poll period is once every 30 seconds. When new studies matching the filter
appear on the EP server, they are immediately downloaded to the workstation.

When a user logs into a registered viewer, auto-routing adds the user’s personal prefetch worklist filter to
the query requests. When the user logs off of the workstation, prestaging returns to the workstation’s
auto-routing configuration.

4.6 System management

Under normal circumstances, the Practice Builder 1-2-3 viewer handles all the routine maintenance and
system management functions. Nevertheless, a number of tools exist for manually verifying or overriding
the viewer’s regular procedures.

4.6.1 MONITOR CALIBRATION

Some digital modalities such as CT and MRI convey actual pixel size and spacing information. The
Practice-Builder 1-2-3 viewer uses this data to automatically render images using the correct aspect
ratios, calculate distances and area measurements, and display objects at their actual size. Some
devices, such as frame grabbers, including ultrasound, and film scanners, do not. For the modalities that
do not provide this information, Practice Builder 1-2-3 provides a calibration tool that the user can use to
help the viewer generate it. For detailed information on image calibration, refer to section 5.5.8.

Once the pixel size and spacing information is available, Practice Builder 1-2-3 still needs to have
information about the monitor in order to render images properly. For this reason, the user has the ability
to calibrate the monitor. While image calibration is needed for each study, monitor calibration is only
needed once for each monitor. However, for safety reasons, Practice Builder 1-2-3 prompts the user to
confirm the monitor calibration for each study. Since Practice Builder 1-2-3 records the previous monitor
calibration settings, if the monitor or display resolution has not changed, the user simply needs to confirm
the setting. Crrr— 2
To calibrate a monitor, select the Calibration item on the Settings (5 Soom i00mm
menu, and select Monitor. A notice appears explaining how to use

the monitor calibration tool. If you do not want this notice to appear

each time, click on the checkbox that indicates you do not want to Y conclirs et by sy

display it again. Then click on Next. Using a ruler held up to the s

monitor glass, drag the horizontal and vertical rulers on the screen

using the mouse until they reflect the actual size. When finished,

click on OK. s |
Repeat this process for each monitor, using the Settings menu at the top of each monitor to open the
monitor calibration window for each respective monitor. Once you have calibrated all of the monitors, you
will not have to do it again until you either update the Practice Builder 1-2-3 viewer, or modify the
hardware or display settings.
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4.6.2 EMPTYING CACHE

The Practice Builder 1-2-3 viewer cache can hold a lot of data, and therefore it may consume substantial
amounts of disk space. If you share your PC with other applications, you may find it necessary to reclaim
the disk space allocated to the viewer cache. Additionally, for security reasons, you may want to erase
image files from your system after you have finished using them. Typically, Practice Builder 1-2-3
manages its cache by clearing unnecessary files on an as-needed basis. Therefore, no intervention is
needed. Nevertheless, Practice Builder 1-2-3 provides manual and scheduled cache clearing functions to
remove lingering data files from the disk.

To manually remove the data from the Practice Builder 1-2-3 cache, select the Empty Cache function
from the File menu or from the Customize Settings’ cache page.

To schedule a recurring purge of the cache, do the following:

From the Settings menu, select Customize Settings

Select the Cache tab

Check the box labeled Purge Files From the Cache After N Days
Enter the number of days after which a purge will take place
Click on the Settings tab

Click to put a check in the box labeled Standby Mode

ok wbdE

As long as Practice Builder 1-2-3 is running in standby mode, it will automatically empty the cache every
Nth day.

4.6.3 RUNNING OTHER PROGRAMS

The Practice Builder 1-2-3 active-X and standalone viewers are both designed to function alongside other
Windows applications. Provided the other applications are designed to do the same, any user should be
able to run any application while the viewer is running, whether it is in standby mode or active with a
study loaded.

4.6.4 LICENSING

The use of the Practice Builder 1-2-3 viewers require a valid license. All Practice Builder 1-2-3 licenses
are customized for and installed on the server. When the user logs into Practice Builder 1-2-3, the server
checks that the license is installed and permits the operation requested. Administrators can review the
licensed components in the User License Information section of the Server web page.

The Practice Builder 1-2-3 active-X viewer requires the standard viewer license. The standalone viewer's
license is embedded in the viewer installed on the media.

Plug-in licenses are managed separate from the basic and workstation licenses. A user is licensed to use
the specified plug-in module if the server the user is logged into has the plug-in license installed. Since
the plug-in license is server-based, it is possible for a user to have access to the plug-in module when
logged into one server, and not have access to it when logged into another.

4.6.5 PERMISSIONS — OPEN RIGHTS, REPORT RIGHTS

Use of the Practice Builder 1-2-3 active-X viewer is a privileged operation. To invoke the viewer, the
administrator must have assigned Open rights to your account. If you receive a notification when
attempting to open a study in the viewer informing you that you are unable to access the viewer
application, contact your system administrator and request Open privileges..

The viewer has the ability to edit reports. Note that editing a report includes changing the state, adding a
key image, saving a processed series back to the server, dictating a report, approving a report or making
notes on the report page. Report edits require Report rights. If you are unable to save changes made to
the study from the Practice Builder 1-2-3 viewer, contact your system administrator and request Report
privileges.
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4.6.6 NETWORK TRANSFER OPTIMIZATION

The best setting for optimized data downloads across a local area network is to use no compression and
large data packets in the network transfers. Conversely, the best setting for optimized downloads across
a wide area network is compressed data and small packet sizes. Practice Builder 1-2-3 automatically sets
these settings based on its configuration and on measured feedback it obtains during each download
operation. Nevertheless, it is possible to override these and force a specific compression application or
network packet size.

Practice Builder 1-2-3 supports settings to define what address ranges constitute the local area network.
They are defined in the LAN domain field on the server’s Server web page. Any IP address not on this list
is deemed accessible via a wide area network. Practice Builder 1-2-3 uses these settings to automatically
adjust the compression setting and the initial network packet sizes for data transfers between its server
and viewer.

The user can override these automatic settings from the customize settings window in the Practice
Builder 1-2-3 viewer. The Advanced page controls the compression setting for download of the study
summary information, and the packet size for all transfers. The Prefetch and Image pages control the
compression setting for the download of the image data. When set to Auto, these settings are dynamically
set based on the Practice Builder 1-2-3 LAN domain setting, plus the measured feedback Practice Builder
1-2-3 obtains during each download operation. In almost all situations, Auto yields the best overall
download performance.
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5 Displaying Images
The primary function of the Practice Builder 1-2-3 viewer is to display full-fidelity images for primary

interpretation. This section contains information on how to open and manage the viewing area, load a
study, organize the images once they load, manipulate the data, and save your changes before closing.

5.1 Opening a Study

How you load a study into the Practice Builder 1-2-3 viewer depends on which viewer you use and where
you start. In all cases, the first step is to display a list of available studies. The tools available for
displaying the study list differ slightly among the different viewers. The sections that follow describe how
to select one or more studies to load into the Practice Builder 1-2-3 viewer, how to navigate to other
studies once you have one open, and what the different viewing modes mean.

5.1.1 OPENING A STUDY FROM THE STUDY LIST PANEL

In both registered active-X and standalone viewers, display the list of available studies from the Study List
window, shown below. The study list contains a table of studies that exist on the CD/DVD (standalone
viewer) or in the local cache (registered active-X viewer). In the registered viewer, it is possible to obtain a
list of all available studies on the server by clearing the Local Only checkbox at the top of the study list
window.

Study Panel
Study Panel
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To load a study, open the study list window by clicking the button, , in the Standard toolbar, or selecting
CD Contents or Study Panel from the View menu. The study list has many of the functions available on
the browser worklist, including sorting and filtering (registered viewer only) capabilities. Using these
functions, locate the study you want to load. On some versions of the standalone viewer, a browse
function is available. If it is, the Browse button, &, appears at the top of the study list. Click this button,
and use the Windows explorer window to locate either a DICOMDIR file, or specific DICOM object files.
Click Open to make these studies appear in the Study Panel.

Click on the patient name, or the open button, &, on the left side of the row. To open multiple studies at
one time, use the batch open function in the study list window. Using the list filter and sorting functions,
get all the studies you want to load onto a single page in the study list. For each study, click to put a
check in the box on the far left of each row. When all the studies are marked, click on the batch open

button, E in the top left corner of the study list.

If Practice Builder 1-2-3 finds prior studies when attempting to open a study in the registered viewer, it
displays them in the study list. The study you select is indicated by the shaded row. The other studies are
relevant priors that have been prestaged from the archive. Clear the Local Only setting to get the server
worklist, and load the study.
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Practice Builder 1-2-3 does not support adding a new study to a list of studies already open in the viewer.
If you need to add a study to your viewer, you must save your work, close the current study, and open it
again, this time adding the additional study to your list of selected studies.

5.1.2 OPENING A STUDY IN THE ACTIVE-X VIEWER

The Practice Builder 1-2-3 active-X viewer is a downloadable application that displays images stored on
the Practice Builder 1-2-3 server. You are advised to always download and install the latest version of the
Practice Builder 1-2-3 viewer. Follow the instructions in section 2.3.2 to install the active-X viewer. Once
installed, you are ready to open studies.

Opening a study in the Practice Builder 1-2-3 active-X viewer starts with the worklist page in the web
browser. Request a study by clicking on the hyperlink in the Patient Name column, or click on the Open
button to the left of the study information on the worklist. To open multiple studies at one time, use the
worklist filter function and page size field to get all the studies listed on one worklist page, and then check
the box on the far left side of each row. At the top left corner of the worklist, click on the batch open
button. The Practice Builder 1-2-3 viewer loads all the selected studies.

When opening a study from the hyperlink, Practice Builder 1-2-3 checks the database for relevant priors
that match the selected study. If it finds any, it displays the list in a new worklist. The study you selected is
identified by the shaded row. Select the studies you want to include by putting a check in the box to the
left of each line, and click on the batch Open button at the top left corner of the worklist. If you want to
open just one of the listed studies, click on the patient name hyperlink, or the Open button in the study’s
row.

For additional information on selecting a study list from the Practice Builder 1-2-3 worklist, refer to the
Practice Builder 1-2-3 Operator's Manual.

If the Practice Builder 1-2-3 active-X viewer is running in standby mode, it will appear on the screen rather
quickly. If standby mode is disabled, Windows will load the program into memory, and then it will appear
on the screen. Since this involves reading the application from disk and loading it, it may take a
considerable amount of time to launch the viewer, depending on the configuration of the workstation. To
improve the time to launch the viewer, run it in standby mode. See section 4.1.1 for information on
enabling standby mode.

There are two stages to opening a study. The first is the transfer of the study information from the server
to the viewer. This occurs regardless of the whether or not the study already exists in the viewer’s local
cache. The progress of this download is shown by a blue line progressing across the Status bar, and by a
completlon percentage displayed in the far right of the Status bar. When the transfer completes, the
viewer has all the information it needs to display the thumbnail
images, select a hanging protocol template, and start loading the
images and report data.

The second stage of opening a study in the Practice Builder 1-2-3 viewer is the loading of the image and
report data. First, Practice Builder 1-2-3 checks the local cache to see if the data is already on the
workstation. If found, the data is loaded from disk. Otherwise, the viewer pulls the data across the
network from the Practice Builder 1-2-3 server. If redirection is enabled, the viewer pulls the data over
from the closest server to minimize network traffic and download time. A blue progress bar
located along the bottom edge of each thumbnail image shows the progress of each image
download. To instruct Practice Builder 1-2-3 to download a specific image first, load that
thumbnail into a frame in the main viewer workspace. All the series loaded into the main
viewing workspace go to the front of the download queue, and the images displayed at the
top of each frame get downloaded first.
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5.1.3 OPENING A STUDY FROM THE PATIENT FOLDER

Studies available on the server but not loaded into the current viewer session are indicated in the patient
folder with a defined background color, blue by default. Load these into the current viewer session as
follows:

e Drag the study cell in the patient folder into the thumbnail panel, or

e Select the study cell in the patient folder and click the Load button, @' at the top of the study
list.

5.1.4 OPENING NEXT AND PREVIOUS STUDY

In the Practice Builder 1-2-3 viewer, the user can immediately open the next study in the worklist by using
the Ctrl-Alt-Down keys. Similarly, the Ctrl-Alt-Up keys open the previous study in the worklist. These

functions are also buttons available in the Standard toolbar, and .

To determine the next study, Practice Builder 1-2-3 first applies the current filter to the database, then
finds the study you currently have open, and finally, opens the study that immediately follows it on the
worklist. For the previous study, Practice Builder 1-2-3 does the same except it chooses the study that
immediately precedes the current study on the worklist. The viewer does not qualify the study, meaning it
is not possible to use the next/previous feature to open, say, the next Unviewed study. To accomplish
this, you need to apply the appropriate worklist filter prior to using the next/previous function.

When you use the next/previous function, you are required to respond to any prompts that appear before
Practice Builder 1-2-3 will close the open study. For example, if you have entered a report but failed to
send it to the server, the viewer prompts you to either send it or delete it. Once you have cleared all the
prompts, the current study closes and the next one opens without having to re-launch the viewer.

5.1.5 SAVE CURRENT WORKSPACE TO OPEN ANOTHER STUDY
A user can bookmark his or her work, and return to it later. To bookmark the active study,

1. Click on the Bookmark button, @, select Bookmark from the File menu, or press the Ctrl-Alt-B
keys.

The viewer saves the study’s current state, including the image layout, selected key images, annotations,
dictations, and study state on the local workstation. After bookmarking a study, it is safe to close the study
and open the viewer again with another study, log out of the system, or open the same study again.

To restore a bookmarked study,

1. Close the study you opened after bookmarking the original, =

click on the Restore button, , or press the Ctrl+Alt+R keys.
2. If multiple bookmarked sessions exist, the selection list pops
up.
a. From the list, select the bookmarked session
b. Click Restore to restore the selected session.
c. Click Delete to remove the selected session. If
changes were made but not saved, they might be lost. [ Moo | o | =
d. Click Cancel to close the popup window and return to
the current viewer session.

If you changed user accounts, you need to re-login in as the original user to return to the bookmarked
study state.
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If the viewer is open with a study that contains edits when the auto-logout timer expires, Practice Builder

1-2-3 bookmarks it for the user automatically. To restore the study, log in, open the viewer from the
system tray, and click on the Restore button.

5.1.6 STUDY LOCKING AND READ-ONLY MODE

If you open a study but cannot make changes, the study is in read-only mode. This applies when you
open a study from a CD, do not have report editing privileges or some other user has the study open

already. When in read-only mode, you receive a notification x|
informing you of this. You can continue to look at the study, but no e sl of Eceiman Laia

changes you make are recorded. Some users may be given the & has been locked by Admiristator

ability to override the read-only privileges. If you have this ability, fortmn

the notification informs you of who currently controls the editable [ Ereakiok | Open Read Ol

version of the study, and prompts you to break the lock, as seen in
the screen shot shown here.

If you opt to break the lock, you have the only write-enabled copy of the study. The other user receives a
warning that you have taken the lock, but is unable to stop you from doing so. He will be unable to save
his work to the server. It is advisable to verbally notify the user listed in the natification that you intend to
break their lock before doing so. This provides him with an opportunity to save his work.

If you receive a notice indicating another user has taken editing rights (i.e., the study lock) away from you,
you can save your work to your local workstation. When you open the study again and are granted the
editing rights to the study, you can import the saved changes (provided you are working on the same
workstation), and then save them.

5.2 Organizing the Study Data

Displaying images with Practice Builder 1-2-3 is completely customizable. You can change the
characteristics of the display area, and specify how much of the window you want an image to occupy.
You can stack images, tile them, increase and decrease image size, flip, rotate and invert images,
change the window width and center, invert the grayscale slope, run a cine loop for a set of images,
magnify images, change image attributes, and more.

The primary tools for organizing the images are the thumbnail panel, the layout manager and the hanging
protocol assistant. The thumbnail panel contains a sub-sampled rendering of each image, usually
grouped into series. The thumbnail panel exists to the left of the main viewing area, and is available at all
times. The layout manager is a popup window that consolidates the entire viewing area across all
configured monitors into a manageable popup window. From the layout manager, you can define the
viewing workspace, organize the images, and save the settings as hanging protocols. The hanging
protocol assistant automates the application of hanging protocols. It interprets study characteristics and
finds an appropriate hanging protocol to apply.

5.2.1 LOADING IMAGES FROM THE THUMBNAIL PANEL

The thumbnail panel lists the available series. When displayed, the thumbnail panel appears on the left of
the main viewing area of the primary monitor. See section 3.4 for details on the thumbnail panel.

Load a series of images from the thumbnail panel into the main viewing workspace by either double-
clicking on the thumbnail image, or clicking and dragging the thumbnail image to the viewing area using
the left mouse button. To overwrite an existing set of images, use the drag-and-drop method. If the
Persistent Frame Settings setting is enabled, the tile mode settings applied to the image frame are
applied to the thumbnail images. Otherwise, the default tile mode is applied.

To concatenate multiple series into a single frame in the viewing workspace, hold down the Ctrl key while
you drag and drop the series into the desired frame. When concatenating images and series into a single
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image frame, the cursor changes from the normal drag-and-drop cursor to one with a plus sign (+). This
cursor indicates the series being dragged will be added to the images that already exist in the frame.
To quickly load all of the series in a study into the main viewing area, double- o [ —— - o
click on the study’s header. This method for loading series into the viewing
workspace sets the viewers grid across all available monitors to — Study Gi
. . . . Header
accommodate all of the series, and then loads one series into each image
frame. The maximum number of image frames Practice Builder 1-2-3 creates = ‘
on a single monitor is based on the monitor size, but is generally 16. If more 1—‘
series exist than image frames, only the first few series are loaded. Use the drag and drop method of
loading series to replace the series displayed in one of the image frames.

Double click the study header while pressing the Ctrl button to load all the images in a study into the next
available image frame. If no image frame is available, empty one or more image frames to make room for
the global stack, and repeat the action.

To load the thumbnail in the next open image frame:
1. Position the cursor over the thumbnail image and double-click the left mouse button.

To load or overwrite the thumbnail in a specific image frame:
1. Click and drag the thumbnail image using the left mouse button to the selected image frame
and release.

To concatenate multiple thumbnails to a single image frame:
1. Load the first thumbnail series into an image frame.
2.  While holding down the Ctrl key, click and drag the second thumbnail image/series into the
same image frame.
3. Repeat as necessary, until all series are loaded into the selected image frame.

To load an entire study into a single image frame:
1. Position the cursor over the study header and double-click the left mouse button.

5.2.2 LAYOUT MANAGER

The layout manager consolidates the entire viewing area across one or more monitors into a compact
popup window. Depending on your configuration, the layout manager may appear automatically when you
load a study. When hidden, display the layout manager by selecting it from the View menu or press the
F6 key. For details on the layout manager, refer to section 3.6.1.

The first step in loading the images into the viewer workspace from the layout manager is to select the
grid layout. From the grid tools toolbar, select the number of image frames you want to appear on each
monitor. If you want a single grid to span across all your monitors, select the span button, . To apply
a different grid to each monitor, ungroup them. By default all monitors are grouped. The white frame

around each monitor in the layout manager notes this. Select each Colored title bar
monitor independently by clicking on the colored (blue or gray) title
bar in the monitor in the layout manager. When only one monitor iS s v / Tl

selected, assign the grid layout. To regroup all the monitors qmam@ﬂmmm@@m-|n|=|==|:::|aa|aaa\
together, press and hold the CTRL key when clicking on the
colored title bar.

The layout appears on the emulated monitors in the Layout
Manager. Each time you click on a predefined grid button, the
layout will change. You can resize the frames in the default grid by
placing the cursor over the boarder lines in the emulated monitor,
clicking the left mouse button, and dragging the line to obtain the BRI EEEELRE
desired size. ' ;
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Loading the images into the grid is the same from the layout manager as from the thumbnail panel. Refer
to section 5.2.1 for information on loading the series into the viewing workspace.

Practice Builder 1-2-3's default display mode is to display the layout manager when the study loads. If
you want to prevent the layout manager from appearing each time you launch a study, set it to remain
hidden until manually activated. Open the Customize Settings window and go to the layout page. Clear
the checkmark in the box labeled Show Layout Manager to hide it. A check in the box instructs Practice
Builder 1-2-3 to always display the layout manager. If the checkbox is disabled, it is because the hanging
protocol assistant is enabled. In this case, temporarily disable the hanging protocol assistant by clearing
the checkbox labeled Use hanging protocol assistant. Make your changes to the other settings, and then
re-enable the hanging protocol assistant by putting a check back in the box.

5.2.3 HANGING PROTOCOLS

Practice Builder 1-2-3 provides hanging protocols for reducing the time needed to organize the image
data in the viewer. A hanging protocol is a record of how the series and images in a particular study are
arranged in the main viewing workspace. You create hanging protocols by saving the current layout under
a defined template name. When you select the hanging protocol template, Practice Builder 1-2-3 applies
the grid layout, and then moves the series and images into the defined image frames. It also applies the
defined linking state, window and level settings, zoom factor and frame position. See section 4.3.2 for a
thorough description of hanging protocols.

Apply a hanging protocol by selecting the template from the Template toolbar.

The Template toolbar can exist in the layout manager or the main viewing workspace. Click on the arrow
button to display the list of available templates. The viewer applies the template to the current study to the
best of its abilities. If one or more series defined in the template do not exist in the open study, Practice
Builder 1-2-3 leaves the image frame empty.

Hanging protocol sets in the hanging protocol selection box are designated with an asterisk (*). To apply
a hanging protocol set, select it from the drop-down box in the Template toolbar. The buttons beside the

hanging protocol selection box change to 4, Modify Current Hanging Protocol Set, and |@ Go to Next
Layout in the Hanging Protocol Set. Repeatedly click the Go to Next Layout button to advance through
the hanging protocols in a sequence. When you reach the last hanging protocol, it loops and starts over.

The hanging protocol assistant is the tool that automatically checks the characteristics of the new study
against the defined hanging protocol templates, including hanging protocol sets, and selects one to apply.
If no good match is found, the hanging protocol assistant pops open the layout manager. Otherwise, it
displays the series and images as the template specifies. For detailed information on how the hanging
protocol assistant selects a template, refer to section 4.3.2.3.

When you end a study session, the hanging protocol assistant makes a note of the studies characteristics
and the template you have applied at that time. The assistant analyzes this information and adds it to its
rules base. Note that if you change the template before closing the study, the assistant will not learn how
to apply them correctly.

5.2.4 APPLYING USER-SPECIFIED PRIOR TO CURRENT LAYOUT

A hanging protocol contains rules for selecting the studies loaded into image frames. For example, it
might load the current (primary) study into image frames on monitor 1 and the first prior into image frames
on monitor 2. You can override the default prior defined by the hanging protocol, updating your layout
without affecting other image frames.

To replace a study loaded into image frames with a different study listed in the thumbnail panel, do the
following:
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1. Select a hanging protocol from the hanging protocol toolbar. The viewer might do this

automatically when it initiates the session.
2. From the thumbnail panel, left-click the study’s header and drag it into an occupied image frame.

The hanging protocol assistant replaces the study whose images occupy the target image frame with
images from the selected study using the same rules defined by the current hanging protocol.

5.3 The Viewing Area

The Practice Builder 1-2-3 viewing workspace displays the full-fidelity diagnostic images. This area makes
up the majority of the graphical user interface, and is generally clear of any formatting or obstacles. To
render the images in a manner conducive to each user’s individual preferences, the user can apply
different tools to manipulate the area’s layout. The user can apply a predefined or custom grid layout,
display images in a stack mode or in a tiled mode, create a common or disassociated environment across
all monitors, and quickly hide all screen objects except the image to eliminate any distractions the

interface may cause.
The tools for selecting and creating a grid pattern are available from both -
the main viewing workspace and the layout manager. The most common

tool used for choosing a grid layout is the Grid toolbar. Click on the button showing the grid layout you
want to apply to the main viewing workspace. You can also select a grid layout from the Grid layouts
submenu on the Settings menu. On Practice Builder 1-2-3 workstations with multiple monitors, you can
apply a different grid layout to each one. By default, all monitors use the same layout. To set just one,
open the layout manager, and click on the colored title bar of the graphic that represents the monitor you
want to make unique. The white border appears around the selected monitor only. Click the button on the
grid toolbar to set the monitor setting. To move to another monitor, select it by clicking on the colored title
bar. To group all the monitors again, hold the CTRL button while clicking on the colored title bar. A white
border appears around all the selected monitors.

5.3.1 GRID LAYOUTS

Practice Builder 1-2-3 uses a dynamic grid to display images in the main
viewing workspace. For example, a common grid layout is a 4-up
symmetrical grid, consisting of two rows and two columns, as shown here,
before adding the images. You can select from predefined grid
configurations, define custom symmetrical grids, and create asymmetrical
grids using the framing tool.

Each frame in a grid contains an independent instance of the images. This means when you place an
image or series in multiple frames, each instance has its own display characteristics, such as window and
level setting, zoom factor, orientation, and any characteristics. For example, you can render the
abdominal series of a CT study in two different frames, and apply a tissue window/level setting to one
frame and a lung setting to the other.

When you select a grid pattern, the defined frames always remain on the
screen. However, you can change the size of each to the frames by dragging Frame dragging hook
the borders to enlarge or reduce their size. When you place the mouse cursor
over the line separating the grid’'s individual frames, the cursor icon changes
to either a two-directional arrow or a four-directional arrow. The cursor
indicates the direction in which you can move the border. While holding down
the mouse button, drag the mouse and the grid changes size. If you have the
images displayed as Fit to Window, the image size changes in relation to the
grid size.

T Lllll/ _UNEUUT LU R SLILLLU

Level [ 8255 —J—

Once you have loaded the images into the image frames, you can rearrange
them by dragging them from one frame to another. When you move the
images to another frame, the images in the destination automatically move to
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the original frame. Basically, you are switching the data in the two frames. If the destination frame is
empty, the original frame clears after the move.

To move the images from one frame to another, position the mouse over the top left corner, over the two
diagonal lines. The cursor changes to a hand. Click and hold down the left mouse button. Drag the frame
to any other frame in the viewing workspace. Release the mouse when your cursor is situated over the
destination frame.

Copy the contents of one image frame into another by positioning the mouse over the diagonal lines in
the top left corner of the frame, holding down the Ctrl button, and pressing the left mouse button. The
cursor changes to include a “+” sign. Drag the mouse to a free image frame and release. A copy of all the
images in the source frame now exists in the target frame.

To clear the images from a frame, drag the frame back to the thumbnail panel (on the main viewing
workspace or in the layout manager.) You can quickly clear all the series by selecting a new grid layout
from the grid toolbar.

5.3.1.1 Customizable grid layouts
The grid toolbar offers the user a fixed set of grid layouts. These consist of 1-up, 2-up, 4-up, and other
symmetrical layouts, plus an asymmetrical 3-up. Two methods exist for creating custom grid layouts.

The custom grid button, @ on the grid toolbar enables you to create symmetrical grids that are not
already available. Click on the custom grid button. A popup window appears prompting you to enter the
number of rows and number of columns to apply to your grid layout. After entering the values, click OK.
Practice Builder 1-2-3 applies the defined row and column count. A limit to the number of rows and
columns does exist. The particular limit depends on the resolution of your monitor.

The second customization tool creates asymmetrical grid layouts. With the frame-splitting tool, you can
split existing frames in half. Each frame created has the same independence as any of the default grid
frames, meaning you can insert any group of images into customized frames and apply a window and
level, zoom factor, orientation, etc., to it. You can also save these customized layouts as templates.

To customize a layout, start with the best-fitting predefined grid layout from the grid toolbar, or use the
Grid layouts submenu on the Settings menu. To split any one of the available frames into two
independent frames, click to select the frame you want to split into two frames. From the Grid layouts
submenu from the Settings menu, go to Split selected cell, and choose the position of the new frame
relative the selected frame. A new, empty frame appears next to, above or below the original frame. To
remove one of the frames, repeat the procedure, except select Join selected cell from the Grid layouts
submenu.

5.3.2 TILELAYOUTS

By default, each grid displays the series in stack mode, meaning the image at the top of the stack takes
up all the space in the frame, with the other images behind it. This is actually a 1-up tile mode. You can
expand the stack into individual image slices by selecting different tile mode. For example, if you want the
images in a frame to appear similar to a common 12-up sheet of film, you would apply a 12-up tile mode,
with four rows and three columns. Practice Builder 1-2-3's tiles modes are on the Tile toolbar, which is
available in the main viewing workspace and the layout manager.

A tool exists for defining a custom tile layout. On the Tile toolbar, click the custom tile button, ™, and a
popup window appears prompting you to enter the number of rows and columns to apply to your frame.
After entering your preferences, click OK, and Practice Builder 1-2-3 applies the tile mode to the selected
frame. Note that the number of rows and columns you can use is limited. The particular limit depends on
the resolution of your monitor.
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5.3.3 FuLL SCREEN MODE

Practice Builder 1-2-3 provides a display mode that removes all screen objects, such as the toolbars,
menus, thumbnails, and Windows taskbar, and displays the selected frame as large as possible on the
monitor. This permits you to eliminate all potential distractions and extraneous light from the screen,
leaving just the pixel data in the image object.

To display an image in the full screen mode, click on the frame and then press the F5 function key. While
in full screen mode, you can apply most functions Practice Builder 1-2-3 makes available on the mouse,
including window and level, panning and zoom. To return to the normal display mode, press the ESC
button, click the close button in the top left corner of the image, or press F5 again.

To quickly maximize an image without removing the menus, toolbars, etc., double click the right mouse
button. The selected image appears in a 1-up frame. This applies when the viewer's grid layout is
anything other than 1-up and the selected image frame is not running a plug-in module. Double-click
again before making any significant changes to the 1-up display to restore the original grid layout.
Changes that drop the original layout include applying a new grid layout, loading a new series into the
image frame or applying a plug-in module to the image frame.

5.4 Managing Series

Practice Builder 1-2-3 groups all images into series, usually as defined by the imaging source. In some
cases, the series is defined as sequential images acquired as a result of a single pass through a scanner.
Other times, they may be a collection of seemingly random screenshots. Generally speaking, a series is
just a collection of one or more images. Each series in a study appears on the thumbnail panel and in the
layout manager.

The sections that follow contain information on how to organize and manage series of images.

5.4.1 GROUPING AND UNGROUPING SERIES

By default, Practice Builder 1-2-3 uses the series grouping defined when the study was created.
Sometimes, studies contain images grouped into series that users general prefer to view individually.
Practice Builder 1-2-3 provides tools for automatically separating images based on their orientation,
ungrouping series into single-image series, and manually splitting a series into one or more series.

5.4.1.1 Automatic Series Splitting

Imaging modalities group images together in a number of ways. For example, one vendor's CT may
group the localizer image together with the first sequence of axial images, while another vendor's CT
separate the localizer into its own series. Practice Builder 1-2-3 can look at the orientation of each image
in a series, and regroup them accordingly. If configured to perform this check, the studies from both CTs
in the example appear in the viewer with the localizer image in one series and the axial images in a
second series. Another example is when a modality embeds a multi-frame image into a series with single
image frames. Enabling Split Series separates the multi-frame image into its own series in the thumbnail
panel.

To enable this check, open the Customize Settings window, and select the

. ; ; . . Settings | Vi Layout ||
Layout page. In the Automatic Settings section, check the Split Series box. iz [z | Lese l magE

This setting can be assigned to any modality or to all modalities by selecting — Moritor setting

the modality label in the Settings For menu. W Multiple manitor
Another automatic series splitting function addresses the situation when an — Autoratic ssttings
imaging device puts multiple images into a series and the user prefers they be 'l sl
managed independently. An example of this is when a CR acquisition system
puts both the AP and lateral x-ray into a single series. Practice Builder 1-2-3 ¥ Sort series
can be configured to separate all images in a series into individual series. This Series spit langth: [0
is most useful when the number of images in the series is fairly small. For this e
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reason, Practice Builder 1-2-3 uses a threshold to define the point at which it will separate the images into
separate series, or keep them together.

To force all images in a series into separate series, open the Customize Settings window and go to the
Layout page. Insert a non-zero value into the Series Split Length field. The value refers to the point at
which the images remain in a single series in the Layout Manager and Thumbnail Panel. For example, if
the value is 4, Practice Builder 1-2-3 separates each series with 1 through 4 images into 1, 2, 3 or 4
series. For series with more than 4 images, Practice Builder 1-2-3 leaves the series intact. A value of 0
means the function is disabled. This setting applies to the selected modality type only. The Default setting
does not apply to this function.

5.4.1.2 Concatenating Series

When loading images into an image frame, Practice Builder 1-2-3 copies each series to a separate grid
location. To load two or more series into a single image frame, you must use the drag-and-drop
mechanism as described in section 3.4 while holding down the CTRL key. Series concatenation mode is
indicated by the cursor. With the CTRL key depressed, the icon includes a ‘+' marker, indicating you are
adding the selected series to the existing image frame, rather replacing it.

To quickly load all the series in a study into a single image frame, press and hold the Ctrl key while
double-clicking on the study header in the thumbnail panel.

5.4.1.3 Manually Splitting and Joining Series

Practice Builder 1-2-3 provides the tools needed to manually split one series into two or more series. Start
by scrolling through the thumbnail images, or the images in an image frame, until you arrive at the
position where you want to insert the break. Right-click on the thumbnail image to display the popup
menu. From the Tools menu, select Series, and then Cut series. A new series appears in the thumbnail
panel or in the layout manager. The original series contains the images up to the break point. The new
series contains the images from the break point to the end. These modified series remain defined until
you close the study. Note that any instance of the series left in the main viewing area contains the original
image series.

If you or Practice Builder 1-2-3 has separated a series and you want to join it together again, select the
frame. From the Tools menu, click on Series, and then choose Join series forwards or Join series
backwards. One of the two series will disappear from the thumbnail panel and layout manager. The
resulting series contains the images from both original series.

5.4.2 SORTING SERIES

By default, Practice Builder 1-2-3 displays images in the order in which the modality acquired them.
Unfortunately, scans frequently occur in both directions when the procedure calls for multiple series. In
these cases, the first and last images in the series are opposite each other. This makes linking series
irrelevant. To address the problem, Practice Builder 1-2-3 can sort the images based on slice position
(relative to the patient) so that the order of the images in each series is the same.

To set it, open the Customize Settings window from the Settings menu. Go to the Layout page, and check
the Sort Series box in the Automatic Settings section of the panel.

If you want to enable the sort for all modalities, first select Default from the Settings For: list. If you want to
override the default setting, choose the modality you want from the list and enable or disable the sort
setting in the checkbox. The setting will take effect the next time you launch a study.

5.4.3 LINKING SERIES

Practice Builder 1-2-3 has the ability to link together multiple series into independent groups of linked
series. For example, if you have four series rendered in the viewer, you can link two series together into
one link group, and link the remaining two together into a second link group, and have the two sets
operate independently from each other. Create up to 8 independent linked groups simultaneously.
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To link series, do the following:

1. Load two series into different image frames.

2. Select the Link cursor mode by clicking the Link button, o)
3. Position the cursor over the first series in the image viewing area.
4. Click and hold down the left mouse button, drag it to the second series, and release.

A link icon appears in the top left corner of each frame. To add a third frame to the group, repeat the
process, starting on either of the currently linked frames, and ending on the new frame. To create an
independent link group, perform the same steps on two frames that do not belong to any other link group.

To remove the link, select the frame you wish to remove from the link group, and then click on the link
icon on the image, or click the Link item in the Cine menu.

Practice Builder 1-2-3 only permits a frame to belong to a single link group. If you need to connect a
frame to two different groups, you need to remove the original link. If you attempt to attach the frame to
another link group, you will be prompted to acknowledge the ungrouping from the first group.

By double-clicking the Link button, the Viewer automatically links together all series from the same study,
in the same image plane and tagged as spatially related to each other by the imaging modality. When
finished, you can identify which series are linked together by matching up like-colored link icons (in the
top left corner of the frame). You can manually add additional series to the automatically defined links, or
unlink them.

The auto-link state instructs the viewer to automatically link series together. The default link state is
manual. Auto link state persists between viewer sessions. To enable the auto-link state, do one of the
following:

e Click and hold down the left mouse button on the Link Cursor button, E on the Toolbox toolbar
for 2 seconds.

e From the Settings menu, expand the Link Property menu and select Auto Link.

e From the Link Control toolbar, check the Auto box.

When auto link is active, the Link Cursor button in the Toolbar toolbar changes to # To disable the
auto-link state, repeat these steps. The button graphic will return to the original image.

Additional link properties are available under Settings/Link Property, or from the Link toolbar. The Mirror
setting sets the panning and rotation features to operate in opposite directions across the linked image
frames. The Magic Glass setting results in a separate Magic Glass window in each of the linked image
frames. The Unhook setting (Link control toolbar, only) temporarily disassociated the link settings so you
can apply an image manipulation tool to a single image frame.

5.5 Managing Images

Practice Builder 1-2-3 offers a number of image manipulation tools for enhancing the data. You can
change the image’s window width and center, apply a zoom factor, flip, rotate and pan the images, and
stack them to emulate a cine playback. Many of these settings can be applied automatically through
hanging protocol templates, but they are most flexible when applied manually to individual situations. The
sections below provide detailed information on applying image enhancement tools to the images loaded
in the Practice Builder 1-2-3 viewer.

Page 81



((e RAD Practice Builder 1-2-3
Viewer Manual
5.5.1 STACK MODE SCROLLING

Practice Builder 1-2-3 includes a 1-up, stacked frame tile mode. This tile mode can appear in any image
frame, as explained in section 5.3.2. A few methods exist for scrolling through the images in the frame:

e Using a three-button mouse with a wheel, left-click on the frame to select it, and then spin the
wheel to scroll through the images. Reverse the wheel direction to scroll in the opposite direction.

e When the image is display in Fit-to-window mode (section 0) scrolling is available from the left
mouse button. Press and hold down the left mouse button while the cursor is over the image
frame, and drag the mouse back and forth to scroll up and down the stack. Release the mouse to
end the scrolling. Note that the left mouse button controls the panning function when the image is
not in Fit-to-window mode. When this is the case, hold the CTRL key down while you drag the
mouse with the left mouse button pressed to scroll the image.

e The Up and Down arrow keys advance the image stack. Select the image frame using the
mouse, and then hit the Up or Down arrow key on the keyboard to move forward or backward
through the stack. The Home and End keys jump to the beginning and end of the stack,
respectively.

By default, scrolling through a series of images may skip some slices in order to keep up with the drag of
the mouse. This enables users to advance through a large series very quickly, but is problematic when
you wish to smoothly progress through every image in the series. The Continuous Image Scrolling setting
on the Customize Settings’ Settings page (section 4.1.1) toggles between skipping quickly through the
images and forcing every image slice to appear. When enabled, Practice Builder 1-2-3 displays every
slice in the series if you drag the mouse and continue to hold it down until it reaches the desired image
frame.

In addition to these manual scrolling tools, Practice Builder 1-2-3 supports a cine mode that automatically
cycles through a series of images in an image frame. The cine mode setting is available in any image
frame that contains more than one image. You can apply the cine mode setting to one or more of the
image frames simultaneously, and to linked image frames.

The cine mode controls are available from the Cine menu (section 0) and the Cine toolbar (section 3.1.9).
The cine mode controls include play/stop playback, step one frame forward or back, cycle/reverse mode
setting, and a speed adjustment.

To activate cine mode, select the image frame using the left mouse button, and select the Play option
from the Cine menu or toolbar. The images display at a rate defined by the speed control. To activate
cine mode in another window, repeat the process on the other image frame. If the frame is linked to one
or more image frames, all of them play back the images at the same display rate. To stop the cine mode
playback, select the image frame, and then the Stop option from the Cine menu or toolbar.

The Next/Previous functions in the Cine menu are equivalent to manually scrolling the image stack, as
described earlier in the section.

When the cine playback reaches the end of the image stack, the cycle/reverse mode setting defines how
Practice Builder 1-2-3 continues. In Cycle mode, cine playback cycles back to the beginning and repeats
the same sequence. In Reverse mode, cine playback reverses the direction and displays the images in
the reverse order until it reaches the beginning, at which time it reverses direction again, and continues.
By default, cycle mode is selected. Find and change the applied cycle/reverse mode setting from the Cine
menu or toolbar.

You can set the relative speed of the playback by adjusting the playback speed gauge in the Cine toolbar,
or selecting Faster and Slower from the Cine menu. The playback speed is not synchronized to any clock,
so there is no quantitative value to the speed setting. Use this feature simply to increase or decrease the
rate at which images in the stack appear in the frame.
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5.5.2 WINDOWING AND LEVELING

Practice Builder 1-2-3 provides multiple tools for adjusting an image’s window width and center values.
These include a sliding gauge, mouse control, predefined setting, explicit numeric definition, a region of
interest histogram, and greyscale inversion. The customize settings includes some configuration
parameters for assigning default values to images without a predefined window width and center, and for
overriding those assigned values.

The quickest way to adjust the window width and center values for an image is by applying a preset
setting to the image frame. On the Window/Level toolbar, click the pull-down list to display the available
presets. Select one of the entries. The settings are applied to the selected image frame. For instructions
on setting a preset window/level setting, refer to section 4.3.1.

The simplest tool for dynamically adjusting the window width and center values is the mouse control.
Place the cursor over the image. The image can be a thumbnail or one that is loaded into an image frame
in the main viewing workspace. Press and hold down the right mouse button while you drag the mouse.
Right and left movements increase and decrease the window width. Backward and forward movements
increase and decrease the window center. When you release the mouse, Practice Builder 1-2-3 updates
the other images in the series by applying the same offset.

The mouse window/level tool applies the offset resulting from the mouse movement to all the images in
the selected series. For example, after releasing the mouse, the new settings may have increased the
window width by 10 and the center by —50. Practice Builder 1-2-3 applies +10 and —50 to the current
window/level values of each image. If the other images in a series start with a different window/level
setting, they will be different after using the mouse tool. To quickly update all the images to the same
window and level value, first apply a preset window/level setting to the series, and then adjust it using the
mouse.

You can assign an explicit window width and center value to an image from the Window/Level toolbar.
Click in the text field next to the appropriate label, delete the present setting, and type a new value into
the area. Press the Enter key to apply it. If you enter in a value that is out of the range of pixel values,
Practice Builder 1-2-3 will set it to the maximum.

The other controls for setting window and level in the Window/Level toolbar are the sliders. Practice
Builder 1-2-3 distributes the possible range of values across the slider. By moving the slider left and right,
you can quickly change the respective value. Start by selecting the image. Then click and hold down the
window or level slider in the toolbar. Move the mouse left and right to move the slider. When you have
come to the desired value, release the mouse.

Practice Builder 1-2-3 provides a window/level tool that uses the pixel distribution within a defined region
of interest to calculate a window range with a center value set to the medium value, and then apply those
settings to the entire image. This is a quick method for applying a density-specific setting to the entire
image. For example, you can apply a bone window to an MRI object by selecting a part of the bone as the

region of interest. To define the region of interest, select the ROI with window/level cursor mode, ﬂ and
position the mouse cursor over the area in the image you want to define. Click and hold down the left
mouse button while you drag the mouse to define the region of interest. As you move the mouse, lines
outlining the region appear. Release the mouse to create the region. You can resize the region by
selecting one of the edges with the mouse and dragging it. Position the mouse cursor over the middle of
the defined region, click and hold down the left mouse button, and you can move the region around the
image. As you do, the window/level within the region continues to update, using the pixels within the
region to create the curve. Each time you release the mouse, Practice Builder 1-2-3 applies the window
width and center values from the region to the entire image. To remove the region of interest, click on the
image anywhere outside the region of interest area.

Practice Builder 1-2-3 supports an automatic inversion of the slope of the curve used to apply the window
width and center. The result is an inverted greyscale image. To apply this setting, select the image in the
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image frame, and click the Invert image button, H, in the Toolbox toolbar, or select Invert from the Tools
menu.

To reset the window width and center values of the images in an image frame, click on the reset

window/level button, ﬂ in the Toolbox toolbar, or select Window/level from the Reset submenu in the
Tools menu.

For color images, Practice Builder 1-2-3 can apply a greyscale color map in place of the color palette. The
result is a black and white rendering of the color image. To remove all color from a color image, click on

the Color/Greyscale button, @, in the Toolbox toolbar, or select Greyscale from the Tools menu. Note
that of monochrome images, this feature is disabled.

At times, the images Practice Builder 1-2-3 receives have improperly encoded window width and center
values, or the technologist may have inserted erroneous values into the image objects. To accommodate
these situations, Practice Builder 1-2-3 provides configuration settings it can use to override some default
values. On the Image page in the Customize Settings window, three settings exist for working around
problems that may exist in images.

Use W/L Range — When the image object contains no preset window and level setting, Practice
Builder 1-2-3 can define the default range to use for calculating the values. When this
setting is enabled, Practice Builder 1-2-3 uses the actual range of pixels values to define
the default window width, and positions the window center in the middle of the pixel
range. When disabled, the defined minimum and maximum values are used to set the
window width, with the window center set to the middle of the range.

Auto W/L Setting — Some image objects include unused bits in their definition of the pixel value,
resulting in a very wide window width, even though the pixel data is confined to a
considerably smaller area. When active, this setting overrides the study/series/image with
the actual pixel range as calculated by Practice Builder 1-2-3. Use this setting when a
particular modality’s images define a window range that is too large.

Auto W/L Range — Some images have noise at the extreme ends of the pixel distribution curve,
which can distort the calculated window width and center values. Use this setting to
eliminate the noise by defining how much of the pixel data to image include in the
automatic calculation of the pixel distribution.

5.5.3 VOILUTs

When a value of interest (VOI) look-up table (LUT) is present in the image object, the Practice Builder 1-
2-3 viewer applies it in place of the window and level setting. When present, the VOI LUT is included in
the list of available presets, identified by the VOI LUT label preceded by a pound character (#).

When a VOI LUT is applied, the linear window and level toolbar features are disabled. The viewer
denotes this by displaying Using VOI LUT setting in their place. When you use the mouse to change the
setting, Practice Builder 1-2-3 viewer deactivates the LUT, applies the best W/L setting it can, and
enables the window and level fields on the W/L toolbar.

To disable the automatic application of a VOI LUT, disable the Apply VOI LUT setting for the modality
type. Refer to section 0 for details.

5.5.4 PRESENTATION STATES

Presentation states represent the state of a modified image, such as window/level setting, magnification
and position, and annotation. You can create presentation states during a viewer session, save them so
they are available to future viewer sessions, or discard them when finished with the session. Presentation
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states created by the viewer or third party systems appear in the Presentation State section of the
thumbnail panel and can be loaded into the viewer like other series.

5.5.4.1 Creating Presentation States
Saved presentation states are the same as key images except they do not appear on the report. To save
a presentation state, do the following:

1. Select the frame containing the image.
2. Click the Create Presentation State button, ™, in the Presentation toolbar. Latel
A control window pops up. — -
3. Select the presentation state group label or enter a new label. - i
4. Choose to save the selected image, all images in the selected frame or all { ettenee
images in all frames.
5. Check the Send presentation states to the server box to upload the
presentation state to the server for permanent storage.
6. Click OK. A representation of the presentation states appear in the Presentation Group section of
the thumbnail panel.

I Send presentation states to the server

Cancel

The settings defined in the control window are saved as the default settings for the next presentation
state created.

To apply the default presentation state settings to the selected image(s) without displaying the control
window, double-click the Create Presentation State button.

To automatically create a presentation state when annotating an image, set the Generate Presentation
State setting on the Auto PS tab in the Customize Settings panel, and select the annotation tools. See
section 4.1.15 for details. The presentation state is created automatically when the user adds a selected
annotation to an image. By default, this feature is disabled.

5.5.4.2 Applying Presentation States

When presentation states exist for one or more images in a study, they are grouped together in the
thumbnail panel under a heading titled Presentation Groups. Each presentation state thumbnail is
overlaid with the presentation state indicator, <> display a presentation state image or group, drag
the thumbnail into an image frame as you would for any thumbnail series.

When a presentation state object exists for a specific image displayed in the main viewing area, a
presentation state indicator, ﬁ, appears in the top left corner of the image frame. Click this icon to apply
the presentation state. If more than one exists, a list of available presentation state descriptions pops up.
Select one of the listed descriptions and click Apply. When a presentation state is applied to the image,
the presentation state indicator changes, .

The partially applied presentation state icon, E, is used when some presentation settings are applied
and others settings are not. For example, the presentation state sets the zoom factor, W/L values and a
graphic annotation. If you change the W/L setting, the image no longer displays the presentation state’s
W/L value, but still displays the annotation.

To remove all presentation state objects from an image, reload the image or series from the thumbnail
panel, or click the icon and select the Delete Overlays from the list in the popup window.

5.5.4.3 Saving Presentation States
To save all presentation states to the server after creating it with the automatic upload setting disabled,
do the following:

1. From the File menu, select Send presentation states to server.
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To save a single presentation state or presentation state group (i.e., a thumbnail series) to the server
after creating it with the automatic upload setting disabled, do the following:

1. Right click the presentation state thumbnail to display the popup menu.
2. Select Send presentation state to server.

5.5.4.4 Showing Presentation States in the Thumbnail Panel
To display or hide presentation states in the Presentation Group section of the thumbnail panel, do the
following:

1. From the View menu, select Customize Settings
2. Check the box labeled Show Presentation State thumbnails to include presentation states in the
thumbnail panel. Clear the box to hide them.

5.5.5 IMAGE ZooM

Practice Builder 1-2-3 offers a variety of tools to magnify images. You can apply a predefined zoom factor
to the entire image, define a region of interest and zoom that area to fit the image frame, pop up a
magnifying glass window that magnifies the data behind it, dynamically magnify an image, and with some
image and monitor calibration tools, display the image in its actual size.

Within an image frame, the image appears with some magnification factor applied, or it is automatically
sized to fit inside the frame. When fit to the image frame (fit-to-window mode, section 0), the entire image
appears, and the zoom factor is optionally displayed as overlay text (section 6.1.) All other display modes
apply a magnification factor. When magnified, some of the image may exist outside the image frame.
When in this state, Practice Builder 1-2-3 activates a panning function that allows you to move the image
around within the image frame to center a particular section of the image that may otherwise fall outside
the display region.

When you apply a magnification factor to an image, the thumbnail images, if displayed, show the
viewable region. The coinciding thumbnail image contains a dotted white line indicating the selected area
of interest.

To quickly return the image to its starting point, use the reset buttons in the Toolbox toolbar. There are
buttons to reset the image size to its original display mode (fit-to-window or original size), reset the image
position after panning, plus additional reset functions to return the image orientation and window/level
settings.

5.5.5.1 Applying Magnification

Practice Builder 1-2-3 provides two different cursor modes to magnifying an image. Start by loading an
image thumbnail to an image frame, and then select the image frame. Activate general magnification
mode by clicking on the magnify cursor mode button, &. The cursor turns into a magnifying glass. When
in this cursor mode, there are two ways to zoom into an image. The first is to position the cursor over the
center point of the area you wish to magnify, and press and release the left mouse mutton. The behavior
differs depending on which buttons you hold down when you click the left mouse button, as follows:

None Increase magnification factor doubled

Shift Increase magnification factor quadrupled

Ctrl Decrease magnification factor by one half
Shift+Ctrl Decrease magnification factor by one quarter

The second way to use the magnification mode is to draw a region defining what portion of the image to
display in the image frame. After setting the cursor mode to magnify, position the cursor in the center of
the region you want to define, press and hold down the right mouse button, and drag the mouse. Dotted
lines appear to define the region of interest. When you release the mouse button, Practice Builder 1-2-3
fits the defined region in the image frame, applying whatever zoom factor is needed. Note that the Center
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Region Zoom setting on the Customize Settings’ Settings page toggles between defining the region from
the center out, as described here, or from the top left corner of the area. For details, see section 4.1.1)

After you right or left click the mouse, the cursor mode returns to the Normal cursor mode. If you want to
keep the cursor in magnification mode, hold down the ALT key as you click the left mouse button.

A dynamic zoom mode is available from the gauge on the Toolbox toolbar. When the toolbar is available,
select the image to magnify, and drag the gauge to increase or decrease the magnification factor.

The interpolation mode on the Customize Settings window’s Image page specifies the interpolation
algorithm used when the image is resized. There are various options for determining interpolation. The
Nearest Pixel (default) option uses a pixel replication algorithm to create new pixels. The Bilinear option
performs a first order interpolation using the bordering pixel values to replicate the missing pixels. While
bilinear interpolation results in a smoother image, there are more derived pixel values than there are
when using the nearest pixel algorithm.

To display the selected image frame on the entire monitor, press the F5 key, or click on the Tools menu,
select Zoom In/Out, and click on Full Screen. When in full screen mode, all of Practice Builder 1-2-3's
toolbars, menus and other graphics disappear, and the entire monitor is used to display the selected
image frame. Many of the same tools that are available in the normal mode are also available in full
screen mode, including window/level, scrolling, and panning. To return from full screen mode, press the
ESC or F5 key, or click on the close button in the top left corner.

When a frame displays images in tile mode other than 1-up, quickly enlarge one particular image to the
frame size by double-clicking on the image. To revert back to the NxM tile layout, double click again. If the
current tile mode is 1-up, double-clicking the image changes the grid mode to 1-up. Double-click the
image again to restore the original grid layout.

5.5.5.2 Dynamic Zooming

Dynamic zooming is an interactive function for enlarging or shrinking an image some indeterminate
amount. Hold down both the left and right mouse button as you drag the mouse forward to zoom in and
backward to zoom out. When zooming in, the region is centered at the cursor’s starting position.

5.5.5.3 Magic Glass

A magnifying glass tool exists for zooming in on images. The Magic Glass feature is a floating magnifying
glass that magnifies the image behind it. To activate the Magic Glass, select the Magic Glass entry in the
View menu, click on the Magic Glass cursor button, &, from the toolbar, or type Alt-M on the keyboard. A
popup window appears in the main viewing workspace. Move the popup window over the image(s) by
dragging it with the mouse. The area under the Magic Glass window is magnified by the zoom factor
defined on the Customize Settings’ Setting page. Be aware that while the mouse button is pressed,
Practice Builder 1-2-3 uses a pixel replication algorithm for magnification. When you release the button,
Practice Builder 1-2-3 applies the configured interpolation algorithm. Only image data is magnified. Clear
the magnifying glass by left-clicking anywhere outside the zoom area.

An enhanced magic glass allows the floating magnifying glass to be applied to multiple, linked images. To
use the enhanced magic glass, link two or more image frames. Check the Magic Glass check box in the
link control toolbar or from the Settings/Link Properties menu. When you apply the magic glass tool at this
point, a magic glass window appears in each of the linked image frames.

You can resize the Magic Glass window that floats over the images can by dragging the edge of the
window. Move the mouse over the edge of the window until it changes to a bi-directional arrow. Click the
left mouse button and drag to resize the window. A large Magic Glass window may result in ghosting as
you drag it around. If this is not acceptable, reduce the size of the Magic Glass window.
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5.5.5.4 Actual Size Mode

The Actual Size Zoom mode is a setting that affects the way an image is rendered when not displayed in
fit-to-window mode. The Actual Size Zoom button, I, appears in the toolbox toolbar. When depressed,
the Practice Builder 1-2-3 renders the images in real-world size. When not depressed, Practice Builder 1-
2-3 renders the images in pixel size, matching an image pixel to a monitor pixel. You can toggle the

actual size zoom mode by clicking on the button in the toolbar, or selecting it from the Tools menu, under
the Zoom submenu.

In order for actual size zoom mode to work, both the monitor and the images in the study need to be
calibrated. When you first enable actual size zoom mode, Practice Builder 1-2-3 automatically prompts
you to confirm the monitor calibration. If the selected image does not already contain pixel size and
spacing information, Practice Builder 1-2-3 automatically prompts you to define it. See sections 5.5.8 and
4.6.1. Note that if you apply the image calibration settings to the entire study, you are not prompted for
this information again, at least not until you open another study.

5.5.5.5 Image Panning

After magnifying an image, the part you are interested in may fall outside the image frame. Practice
Builder 1-2-3 provides a panning tool to let you reposition the image within the image frame. To pan a
magnified image, position the mouse cursor over the image and press and hold down left mouse button.
Then, drag the mouse to move the image to the desired location. When panning an image, the cursor
changes to the panning mode. Note that in order to pan images, the images must be displayed in some
mode other than fit-to-window.

Use the reset position button, ﬂ, in the Toolbox toolbar to reset an image position to the center. Use the
reset size button, O, in the same toolbar to reset the magnification mode.

5.5.6 FLIP AND ROTATE

Practice Builder 1-2-3's transform functions let you flip an image horizontally or vertically, as well as rotate
it to the right or left. This function works on thumbnail images as well as images displayed in an image
frame. Click to select the image you want to flip or rotate, and then apply the respective function from the
Orientation toolbar, from the Transform item on the Tools menu, or using the shortcuts: Ctrl-H to flip
horizontally; Ctrl-U to flip vertically; Ctrl-L to rotate left; and Ctrl-R to rotate right. To reset the image

orientation, use the reset button, £, in the Toolbox toolbar.

If the image information displayed on the image obstructs the image, flip the text horizontally in the image

frame. Use the Flip Image Information function, ﬂ in the Orientation toolbar or on the Transform
submenu of the Tools menu.

5.5.7 IMAGE CROPPING

Cropping an image allows the user to mask out unwanted parts of an image. To define a crop area, load

the image into an image frame. Select the Crop mode button, E, in the Toolbox toolbar, or select Crop
from the Cursor item on the Tools menu at the top of the screen. Position the cursor over the top-left
corner or the area you want to keep, press and hold down the left mouse button, and drag the cursor to
define the cropped image. When you release the mouse button, Practice Builder 1-2-3 hides everything
except what is within the defined area. A dotted-line frame appears around the entire image.

To resize the area, move the cursor over the edge of the dotted-line frame until the cursor changes to a
bi-directional arrow. Click and drag the mouse to position the edge of the crop area. To resize the image

to fit the frame, click on the Fit to Window button, ==, in the Toolbox tool bar.

Remove the crop area by moving a thumbnalil into the frame, or double-click on the image.
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5.5.8 IMAGE STITCHING

Stitching is the process of combining two or more images to make a single image that you can
manipulate. This is most commonly applied to spine images or extremities. For example, if you want to
take two CR images of the spine, one upper spine and one lower spine, you can stitch them together to
make a single image, and then calculate a Cobb angle based on the entire spine.

To stitch two images together, you must download and install the Stitching plug-in module, as defined in
Section 3.6.5. Once installed, the stitching control appears in the Post-processing menu. To activate the
stitching process, load an image into an available image frame, pull down the Post-processing menu and
select Stitch from the Stitching sub-menu. The selected image frame turns into a stitching frame, with the
stitching toolbar displayed along the bottom edge of the frame and the image fit into the frame size.

The stitching toolbar consists of tools to pan the images, individually =
and as a group, tack the image to the workspace, magnify and crop ﬁ' Qﬂ’|#|@alﬂ| Izﬂ il
the image, and automatically match the images up.

Function Button Description

Drag mode '@'?‘ Drag the image under the cursor around the image frame. Click on the image with the left
2 %1 mouse button and drag.

Pan mode dﬂ'ﬂ Move all the images in the frame. Click on the image with the left mouse button and drag.

Pushpin )? Tack the image to the workspace at a specified location. Left click to apply a pushpin. Multiple

mode pushpins lock an image’s position and angular orientation. To remove a pushpin, left click on
the pushpin in the image.

Magnify Ql Increase or decrease the size of the images in the image frame. Left click zooms in. Hold the

mode ALT key and left click to zoom out. Note that dynamic zooming (left+right button drag) works in
any mode.

Crop mode tﬂ Remove extraneous information from the image. Click and drag the mouse to define the crop
region. Release the mouse and the area outside the region is eliminated.

rotation rotates the image around the pushpin.
Allow When enabled (i.e., depressed), with a single pushpin inserted into the image, left-click-drag

Allow £ When enabled (i.e., depressed), with a single pushpin inserted into the image, left-click-drag
=)

scaling rescales the image size.

Auto align ) | When the two images are roughly lined up, click the auto align button to find the best overlap.

Stop auto @ | When auto-align is active, this button stops the alignment tool.
align

Undo auto ey | When auto-align is active, this button reverses the alignment results.
align

Start by loading the images into the stitching frame from the thumbnail panel. Since all the images default
to fit-to-window, size the image in the frame so there is enough room to work. Use the zoom mode button
on the toolbar, or dynamically alter the image size by holding down both the left and the right mouse
button at the same time and dragging the mouse. Click on the Drag mode button, and position the images
in their approximate location. Then click on the Auto Align button to have Practice Builder 1-2-3 find the
best fit. When finished, double click on the image to export it to an image frame. The stitching frame
disappears, leaving a single image in the viewer. The image is added to the thumbnail panel. You can
apply any tool to the new image, save it to the Practice Builder 1-2-3 server, and attach it to the report as
a key image.

To scale and rotate an image, lock down the image using a single push pin.
Enable and disable rotation via the Allow Rotation button. When depressed with
one pushpin applied to the image, Drag mode rotates the image around the
pushpin. The same applies to the Allow Scaling button. When depressed with
one pushpin applied to the image, Drag mode alters the size of the single
image as well. If you want to rotate without rescaling the image, apply a single
pushpin, press the Allow Rotation button, unselect the Allow Scaling button,
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and drag the image. Once the orientation is applied, remove the pushpin but clicking on it again.

To remove extraneous information from an image, use the crop tool. Left-click
on one of the corners of the image to identify the starting point of the region
you want to keep, and drag to the diagonal corner of the region. When you
release the mouse, the area outside the region is automatically removed.
Cropping applies to only one of the images at a time.

Drag the images to line them up. The signal-to-noise ratio gauge on the left
side of the stitching frame indicates the distortion between the two images.
The objective is to make this gauge as small as possible. When you get the
images close, use the Auto Align function to have Practice Builder 1-2-3 try to improve on the image
matching. While there is no guarantee the automatic alignment function will produce a better signal-to-
noise ratio than you can accomplish yourself, it can usually improve the result. The automatic alignment
tool does not try to resize the image.

55.9 MASK SUBTRACTION

Mask subtraction is used to eliminate the commonalities between two images,
leaving the differences behind to render on the monitor. This is often useful
when tracing some type of bolus or injected die through various parts of the
body. The modality generally provides this information so the workstation can
apply it. If Practice Builder 1-2-3 viewer detects mask subtraction information in
the image, it can automatically initiate the process to apply the parameters and
generate a post-processed series.

st

iton | Postprocessing Help To use the mask subtraction feature, you
must download and install the Mask
Subtraction plug-in module, as defined in Section 3.6.5. Once

Basic3D L4 | ([ ] |

Mask Subtraction Plugin  » Create

s . installed, the mask subtraction control appears in the Post-processing
Stitching y_ Confiaure menu. To activate the subtraction process, load a series of images

into an available image frame, pull down the Post-processing menu
and select Create from the Mask Subtraction sub-menu. The plug-in creates a new series and adds it to
the thumbnail panel and layout manager. To display the subtracted image series, drag it to an available
image frame.

Configure 3] The mask subtraction tool has configuration settings. From the
Postprocessing menu, select the Mask Subtraction submenu and

i A bl click on Configure. The mask subtraction configuration panel pops

I Display Noifications up. The Automatic Mode setting is to have the viewer automatically

perform the mask subtraction operation on images that contain the
required attributes. The Display Notifications setting pops up a
notice prior to applying the function to the images. By default, both
of these settings are enabled.

If configured to automatically create a subtracted series when
. . . e . sk Subtraction Plugin

the viewer opens the study, and displaying notifications is

enabled, you will see a notice pop up when you open a study. If task Sublraction objects detectst.

you select to process the images, the subtracted series are | Uktoprocess when allimages are dawnloaded?

automatically created. If you opt to skip this step, you can “rou cat disable this dialog in the Mask Subtraction

manually invoke the mask subtraction process at any time by | Flugin configuration dislog

selecting Create from the Mask Subtraction sub-menu in the

Post-processing menu at the top of the viewer.

Yes Mo
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A series of subtracted images has all the properties of a series in the original study. You can window and
level them, apply a zoom factor, measure the structures in the image, annotate the image, save the series

on the server for others to use, and attach one or more as a key image in a report. Be aware that before
you can attach a post-processed image, you must save it to the server first.

5.5.10 CALIBRATION

Some imaging modalities convey enough real-world pixel size and spacing information that Practice
Builder 1-2-3 automatically renders images using the correct aspect ratios, calculates distances and area
measurements, and displays objects at their actual size. For the imaging modalities that do not provide
this information, such as frame grabbed images and scanned film, the user can have Practice Builder 1-2-
3 generate the information by calibrating the image that appears on the screen.

When the pixel size and spacing information is available, whether supplied by the modality or entered by
the user, Practice Builder 1-2-3 still needs to have information about the monitor in order to render some
images properly. For this reason, the user has the ability to calibrate the monitor. While manual
calibration for images needs to be performed for each study, monitor calibration is only needed once for
each monitor. For safety reasons, the user is prompted to confirm the monitor calibration for each study.
Since Practice Builder 1-2-3 records the previous monitor calibration settings, if the monitor or display

S = resolution has not changed, then the user simply needs to
" Don't calibrate T : H H H M
confirm the setting. Section 4.6.1 contains instructions for
€ Use DICOM calibration data Horizontaly: U Viettioally 0 vam / pikel Calibratin the Vie\%/er monitors
& Use manual calibration data Horizontaly: |0-41658088  verticaly: |0-41658088 i ¢ pisel g )
I Use 1:1 aspect ratio . . . . . .
P — To perform image calibration, select the Calibration item on
This image currently has no calibration data.
has one calibration ruler.

This view has or % selected image
e

the Settings menu, and select Image. The image
calibration wizard window appears showing the current
[ i il pixel sizing information. If the Use DICOM calibration data
G | O | Addethemcobaimnier | [T setting is selected and contains non-zero values, it means
the image object already contains enough information for
Practice Builder 1-2-3 to use. The Apply To section of the window allows you to assign the calibration
information to an image, a series of images, the entire study, or to all the images loaded into the selected
image frame. The default setting is usually the best. If you need to override the default, click the option
you want to use for these parameters.

If the image does not contain DICOM calibration data, you need —
to calibrate the image manually so Practice Builder 1-2-3 can
determine the spacing information it needs to assign real-world
dimensions to the pixel data. To manually calibrate the image,
click on Add or Change Calibration Rulers. The viewer enters
image calibration mode, and displays the image and a new set
of tools.

The calibration tools lets you draw one or more rulers on the
image and then assign a length to each one. Using this
information, Practice Builder 1-2-3 calculates the pixel sizes.
When you first enter calibration mode, a full-screen window
appears with an image display. The cursor is now a ruler cursor,
similar to the linear measurement annotation tool. Click, drag
and release the mouse to place a ruler over the image. When -
you release the mouse, you will be prompted to enter in a §
distance, in millimeters. The objective is for you to draw the ruler
over an object in the image for which you know the distance. For
example, place the ruler over a measurement graph, or a lead
ruler/marker, that appears in the image. You can pan and zoom
the image to get a more accurate result by clicking on the
buttons in the top left corner of the window. The more rulers you

50 mi
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define at various angles, the more accurate the size calculations will be. When finished, click Done. When

back at the main calibration window, chose to apply this setting to the present image, the series, the
frame or the entire study, and then click on Finish.

5.5.11 MAGIC X POSITION LOCATORS

When a study contains multiple series in multiple orientations (axial, coronal and sagital), it is sometimes
necessary to display the same point in all three axes simultaneously. You can do this using Practice
Builder 1-2-3's Magic X function. Set the Magic X cursor mode by selecting the button, &, from the
Toolbox toolbar, or from the Cursor item in the Settings menu. Your cursor will change to a fat X. Place
the cursor over the point of interest on one of the images. Left-click and release the mouse and the slices
in the other frames that also contain this point are displayed. Left-click and drag the mouse to make the
Magic X cursor persist, and as you change the position of the cursor, the other images update to display
the intersecting point. If you have localizer lines enabled on these other images, you will see how the
entire slice intersects the other images. After clicking on the image, the cursor mode reverts back to the
normal mode. If you wish to reposition the images again, you need to reselect the Magic X cursor mode.

The Magic X cursor changes when the icon falls outside a defined distance from the intersecting image.
The purpose of this is to provide the user with a clear indication that the referenced image displayed
when using the Magic X tool (i.e., the closest intersecting image to the primary image) is far enough away
from the primary image that the intersection is really not relevant.

The user can define the distance from the intersection used as an indication that it is out of range by
setting the Magic X Limit values on the Hash Marks page in the Customize Settings window. The first
field, Dimmed Magic X after N millimeters, causes Practice Builder 1-2-3 to dim the Magic X icon in the
referenced images once the active Magic X icon moves more than N mm away from the closest slice.
This happens most often when you reach the end of the series. The second field, Disable Magic X after M
millimeters, erases the Magic X icon in the referenced image once the active Magic X icon moves more
than M mm way from the closest slice.

5.5.12 POST-PROCESSED IMAGES

Post-processing involves creating a new image from existing images. These new images may have the
same diagnostic quality as the original, and you can apply all of Practice Builder 1-2-3's image
manipulation functions to them.

5.5.12.1 Saving and Deleting Post-processed Images

A post-processed image created in the Practice Builder 1-2-3 viewer only exists during the viewer session
unless you explicitly elect to save it to the server. Uploading post-processed images to the server requires
Edit or Report privileges.

If you want to attach a post-processed image to a key report, you must first register it on the Practice
Builder 1-2-3 server.

When you create a new post-processed image or series of images, it appears in the thumbnail panel. To
save the image, load it into an image frame, or select the image frame if already displayed in one. Expand
the File menu and select Send image to server or Send series to server. The upload begins immediately.
Be aware that image transfers can take some time, especially on slow or congested networks. You will be
unable to close the viewer until the transmission completes. The Status toolbar displays the message
Sending Image while the transmission is in process.

If you close the viewer without saving the post-processed images to the server, they are deleted. To
restore them, you will have to process the original images again. If you want to remove a post-processed
image yourself, you can do so by loading the image into an image frame, expanding the File menu, and
selecting Delete image/series.
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5.5.12.2 Multi-planar Reconstruction Images

Practice Builder 1-2-3 supports multi-planar reconstruction as a plug-in module. Refer to section 7.1 for
complete details on the MPR plug-in.

5.5.12.3 Stitched Images

Stitched images are two or more independent images that are concatenated to create a single image. In
most cases, this is done to two or more CR images or scanned films. Practice Builder 1-2-3 treats the
resulting images as a post-processed image. For details on creating a stitched image, refer to section
5.5.8

55.124 AVI Images

Practice Builder 1-2-3 can create an AVI object from any series of images. The AVI object displays the
images at a defined frame rate. While an AVI object is a post-processed image, it does not possess
many of the same properties. AVI objects cannot be saved as a new series, attached to a report or stored
on the Practice Builder 1-2-3 server. For details on creating an AVI object, refer to the AVI plug-in section,
7.4.

5.5.12.5 Mask Subtracted Images

Practice Builder 1-2-3 can apply a mask subtraction algorithm to images that include the requisite
attributes. These attributes must be defined by the modality. Practice Builder 1-2-3 manages the resulting
images as a post-processed image. For details on applying mask subtraction to a series, refer to the
Mask Subtraction section, 5.5.9.

5.6 Warning Indicators

Practice Builder 1-2-3 viewer uses some graphics to inform the user of some condition that may be
medically relevant about the image in the image frame.

5.6.1 IMAGE COMPRESSION

When compression is used to download images from the Practice Builder 1-2-3 server to the viewer, the
image may contain bit errors that result in modified pixel values. This is common when employing
compression ratios that are not bit conserving. To inform the user when an image was downloaded using
a lossy compression ratio, a warning icon, A\ appears in the upper left corner of the image frame.

To eliminate this warning, select Uncompressed in the image settings page’s Compression section, or
select Wavelet and set the Wavelet Quality setting to Lossless. To request the remaining data for a
compressed image without changing your settings, double click on the lossy compression warning icon in
the image frame. The viewer downloads the rest of the wavelet data from the server, resulting in lossless
compressed image.

5.6.2 IMAGE NOT INTENDED FOR DIAGNOSTIC INTERPRETATION

A Not Intended For Diagnostic Interpretation Indicator e displays for any image not intended for
diagnostic interpretation. Different DICOM objects are used for conveying unprocessed data and
processed data. The warning appears if the image belongs to one of these object classes. For example,
this warning can be seen when opening an unprocessed mammography image.

5.7 Closing a Study

Practice Builder 1-2-3 uses the action of closing a study to perform a few maintenance operations. First, it
verifies that the user saved their work. A progress bar may appear while the data gets sent to the server.
After saving the work, Practice Builder 1-2-3 updates the user profile on the main server. As a final step,
Practice Builder 1-2-3 sees if there is a bookmarked study that needs to be reopened.

In the event the user recorded a dictation, created a report, attached key images, or changed the study
state, and did not save those changes, Practice Builder 1-2-3 notifies the user. The prompt asks if the
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user wishes to save his or her work. The user can update some of the information in the notice window.
One of the fields to update is the study state. The suggested state comes from the proposed states

setting. See section 4.1.1.1 for details. To select a state other than the proposed state, check the Set
Status to box, click on the menu, select the state you want, and click OK.

Close studies x|

BAUER, JACK - Apr 23,2007 - CT ¥ Send Report ¥ Set Status to |Preliminary 'I I~ Clear Changed Flag
Unviewed

Viewed

Read

Dictated

Final

kK I lgnare changes | Cancel |

You can close a study from the File menu by selecting Close Study. This leaves Practice Builder 1-2-3
viewer running, even though there is no open study.

Terminate the Practice Builder 1-2-3 viewer session entirely in one of the following ways:
e From the File menu by selecting Quit
e From the Windows application close button, ﬁ], in the top right corner of the viewer window on
the primary monitor
e Opening a new study from the worklist

Note: If you want to add a new study to the studies already loaded, you must return to the worklist or study
panel, and add the new study to the group of studies you want to open, and select a batch open.

5.7.1 TERMINATING THE VIEWER

To terminate Practice Builder 1-2-3, select Quit from the File menu. The conventional Windows close
button in the top right corner of the application performs the same action as the Quit function.
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6 Overlays and Annotations

Practice Builder 1-2-3 supports overlays and image annotations. Overlays are lines of text containing
details about the patient, the acquisition procedure, the image and other information usually defined by
the imaging modality or information system. When displayed, overlays appear in the corners of each
image frame.

Annotations are text and graphics that usually reference some detail in the image, such as a linear
measurement or an arrow pointing to some anatomical structure. When displayed, annotations appear on
top of the image. See the example of text labels and a measurement annotation in the picture below.

Overlay
Text
Measurement
Annotation
on
Text
Annotation

The sections that follow give details on creating, displaying, hiding and saving overlays and annotations.

6.1 Overlays

Overlays consist of textual and graphic information identifying the patient, exam type, acquisition data,
and image characteristics. Overlays appear on the image in the corners of each image frame, centered
along the edge of the image (in the case of orientation markers), and directly over the image (in the case
of hash marks). Overlay configurations are specific to each user account, and for each modality type. By
default, overlays as displayed in each image frame, but you can hide them at any time using the function
keys.

6.1.1 TEXT OVERLAYS

Text overlays contain information defined by the modality and encoded in the image object along with the
pixel data, plus some calculated values. To display the text overlays in the image frame, press the F10
button, or select Show Image Info from the View menu. To hide the text overlays, repeat the action.

The default user profile includes a general overlay configuration that is applied to all image types.
Customize these settings to your own preferences from the Customize Settings window.
1. Open the Customize Settings window from the Settings menu
2. Select the DICOM Fields tab
3. Select the modality type whose overlay configuration you want to modify, select the location on
the image, and use the Add, Remove and arrow buttons to insert, delete and move the identifiers
to the preferred location. See section 4.1.5 for additional details.
4. Save your settings.

By default, private DICOM attributes are unavailable from the viewer. To display private attributes, the

server must be configured to process them. This configuration does not have a GUI interface. Contact
support with the list of private attributes you wish to make available for overlays in the viewer.
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To set the font size for text overlays, return to the DICOM Fields page of the customize settings window.
The font size is configurable for each area of the image. Again, select the modality type and the location.
Set the font size in the Character Size field by deleting the current setting and entering in a new value, or

use the up/down arrows to the right of the text box to increase/decrease the font size. When you click on
OK, the changes will take place immediately.

6.1.2 ORIENTATION MARKERS

Orientation markers indicate the position of the imaged body. There are six orientation labels plus one
label to indicate an unknown value:

Anterior (or front)
Foot

Head

Left side

Posterior (or back)
Right side
Unknown

NXOOUrITIT>

Orientation markers appear in the center of each side of the image. Generally, one marker appears on
each side. If the gantry was tilted during the acquisition, there is a chance the direction increases in
multiple directions. When this is the case, the orientation markers are multiple values, and are listed in the
dominant order. For example, an orientation marker of LH indicates the primary direction of the vector
leading off to that side of the image is toward the patient’'s left side, but also progresses toward the
patient’'s head. Usually, when this appears, the mirror side of the image would contain the opposite
orientation markers. In this example, you would likely see RF on the other side of the image.

When the orientation marker contains multiple values, it is often beneficial to have a visual representation
of the image to understand the degree of tilt in the image. To assist in this visualization, Practice Builder
1-2-3 provides an overlay that shows how the image slice exists in the 3-dimensional space. It appears as
a cube along the lower edge of the image. The Alt-F11 key sequence toggles the display of this
orientation overlay. In the cases where the image is square to the patient, the overlay appears as one of
the letter labels encased in a square. However, if the image orientation is angled to any degree, the
overlay appears as a 3-dimensional box with the letter identifying each respective orientation.

Practice Builder 1-2-3 determines the orientation markers from information encoded in the image object.
When the image object does not provide enough information for Practice Builder 1-2-3 to accurately
determine this information, no orientation is provided. In this case, Practice Builder 1-2-3 displays
question marks (?) in place of the orientation marker.

To display the orientation markers, press the F11 key, or select Show Orientation from the View menu. To
hide the orientation markers, repeat the action.

6.1.3 SCALE RULERS

Ruler overlays exist for all calibrated images. Calibrated |
images are those that contain dimensional information in
the DICOM attributes, or have been manually calibrated
using the image calibration function. (Refer to section
5.5.9.) They appear on the outside edge of the image
frame. You can assign the location of the rulers, and
whether they exist for the vertical, horizontal or both
planes.

By default, rulers are hidden, but when enabled, appear
in successive viewer sessions if left enabled. Change
the current setting from the View menu by clicking Show
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Scale and selecting the location. A hot key, Alt-F10, is also available. Click repeatedly on the hot key to
advance through the locations. Change the color of the scale rulers from the Color tab in the Customize

Settings window. From the pull-down list, select Scale Markers, and assign the color. The change takes
place after clicking the OK button.

6.1.4 LOCALIZERS LINES AND HASH MARKS

Localizers lines and hash marks are overlays the show the intersection of a referenced image on an
orthogonal view. When they appear, they reference the image or images in the selected frame. If you
select a different image frame, the localizer lines and hash marks on the images change to reflect the
intersection of the newly selected image. In most cases, localizer lines and hash marks appear on
orthogonal images.

Note that localizer lines and hash marks appear only when the images are defined by the modality to be
in the same frame of reference. If the modality does not explicitly define all the image objects this way,
Practice Builder 1-2-3 cannot identify the relationship between the images, and therefore it cannot show
where one intersects the other. You can verify two images are in the same frame of reference by opening
the Information Panel, and comparing the value Frame of Reference UID. If the attribute is missing or the
value is different, localizer lines and hash marks are not supported.

While localizer lines and hash marks refer to the same information, Practice Builder 1-2-3 makes a small
distinction between the two. In Practice Builder 1-2-3, localizer lines refer to a single line showing the
intersection of the referenced image on the other views. Hash marks are the collection of localizer lines
showing the intersection of all the images loaded into the referenced frame on the other views. When
displaying a localizer line, a single line appears. When displaying hash marks, multiple lines appear.

If an image is encoded by the modality as a localizer, Practice Builder 1-2-3 automatically displays
localizer lines and hash marks on it. For all other image types, you must instruct Practice Builder 1-2-3 to
display them. If you want Practice Builder 1-2-3 to attempt to detect which images are localizers, go to the
Settings menu and select Localizers. Then click on Auto find localizers to mark it with a check. Repeat the
process to remove the check. When enabled (checked), Practice Builder 1-2-3 tries to identify images
that are orthogonal to the other images in the series or study, and separates it out as a localizer. When
identified as a localizer, Practice Builder 1-2-3 automatically displays the localizers lines on it.

To show localizer lines, press the F12 button, or go to the Settings menu, select Localizers and then click
on Show localizer lines on all images. To hide localizer lines, press the F12 button again, or select Hide
localizer lines on all images from the same Settings menu. You can make this setting permanent from the
Hash Marks page in the Customize Settings window. Select the modality type, and put a check in the box
to show or hide the localizer lines.

To display hash marks, press the Alt-F12 key combination, or go to the Settings menu, select Localizers
and click on Show hash marks on all images. To hide hash marks, press the Alt-F12 key combination
again, or select Hide hash marks on all images from the same Settings menu. When hash marks are
displayed, one line is highlighted. This line indicates the intersection of the image currently displayed in
the reference frame. You can make this setting permanent from the Hash Marks page in the Customize
Settings window. Select the modality type, and put a check in the box to show or hide the hash marks.

Displaying localizer lines in tiles frames takes on some of the properties of displaying hash marks. If two
image frames, each with a multiple image series in two different orientations (e.g., axial and coronal) are
displayed in stack mode, and you enable each series to show localizer lines and select one of them, the
other shows the intersection of the selected one as it intersects it. If you change the tile mode from stack
mode to two by three tile mode, you will see six localizer lines displayed on the image still rendered in
stack mode. These six lines correspond to all six images displayed in the tile frame. As you scroll through
the tile frame, the six localizer lines change to reflect the six displayed images.
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In the Customize Settings window, the Hash Marks page contains some configuration parameters that
affect localizer lines and hash marks. The hash mark spacing parameter defines the space between hash
marks. If the slice thickness is too small, Practice Builder 1-2-3's hash marks may run together, resulting
in a solid block of color and completely obstructing the image. To make sure there is enough space

between the hash marks so the image underneath can be identified, use the hash mark spacing field to
define the minimum distance between hash marks.

The localization criteria parameter in the Hash Marks page defines the angle Practice Builder 1-2-3 uses
to determine whether or not two images are in the same plane or not. If the angle between the image
planes is greater than the value defined, the two planes are considered orthogonal, and a localizer line
appears.

Section 4.1.6 contains details for setting the hash mark spacing and localization criteria parameters.

6.1.5 EMBEDDED OVERLAYS

Embedded overlays are overlays created by third-party devices, such as the imaging modality, and
encoded in the image object. When applied to an image, the corresponding image pixel is replaced by an
overlay pixel, which when combined with other overlay pixels, result in a graphic displayed on top of the
image. Overlays can exist for any object, but are frequently found on summary images or localizer
images.

By default, overlays are displayed if they exist for an object. To toggle the embedded overlay setting, use
the Ctrl-F9 function key, or select Show Overlays from the View menu.

6.1.6 ORTHOGONAL IMAGE OVERLAYS

Orthogonal image overlay is used to display a localizer image as an overlay on an image, serving as a
position reference. The user specifies which overlay image to use. The user can overlay an orthogonal
image with hash marks on printed images. Orthogonal image overlays also appear on key images when
displayed in the viewer, but not when the key image is rendered as a JPEG image on the report page
from the browser.

The orthogonal image overlay setup is controlled under
Settings/Customize Settings/View. Under Orthogonal Overlay,
set the size and default location of the overlay image.

To apply orthogonal image overlays to an image frame, follow
these steps:

1. Select Show Scout Overlay from the View menu.

2. Drag the image you want to display as the orthogonal
image into the lower right or left corner of the image
frame, and drop it. When positioned over the appropriate
area, the image drag cursor changes to an orthogonal
image overlay icon.

3. To move or remove the orthogonal image overlay from
an image frame, click on it and drag it to the desired location, or back into the thumbnail panel.

6.1.7 MAMMOGRAPHY CAD OVERLAYS

A CAD marker provides computer-aided diagnosis to mammography images. Practice Builder 1-2-3
supports the Hologic Image Checker™ (formerly R2) and iCAD Second Look™. Refer to the respective
product’s user manual to learn more about them.

If a study includes a CAD marker, the presentation state icon appears in the top left corner of the image
when it is displayed in an image frame. To apply a CAD marker, perform the following steps.
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. Click the presentation state icon, ﬁ in the top left corner of the image.
2. If more than one presentation state option exists, the presentation state selection window
appears. Select the CAD marker you want to display, and click on Apply.
3. The presentation state, including annotations and markers appear on the image.
4. The icon changes to a partially applied presentation state icon, .
5. Repeat this process for each CAD marker and each image.

The number and type of marker is listed beside the CAD product’s logo at the top of the image. CAD
markers are displayed as defined by the CAD object and cannot be modified by the Viewer in any way.
Refer to the CAD product’s user manual for more information if necessary.

6.2 Annotations

Annotations provide you with the ability to attach text and graphics to an image. The Annotation Toolbar

contains a series of eight buttons for working with annotations. The Annotation button, ﬂ, puts you in the
annotation mode, providing you with the ability to create, move, modify and delete an annotation. The
available annotations are adding text strings, linear and angular measurements, area measurements
using circular and free-form regions of interest, Hounsfield units, a pointer graphic, key image numbering
and spine labels. When a specific annotation tool is selected, the cursor changes to identify it. Set the
specific annotation tool by selecting it from the annotation toolbar, or if already in annotation cursor mode,
spin the middle mouse button to advance through the available tools.

Most annotations consist of a graphic such as a line representing a rule for linear measurement, or a ring
representing the area defining a region of interest, a value such as the measured length, or a text string,
and an annotation index number. The index number starts at one (‘1’) for each image, and increments by
one for each annotation you add to an image. When displayed, these indices can be used as references
to the annotations in the report, or when discussing the data during a collaboration session. The value
and index components float independently from the graphic. If one is obstructing part of the image, click
on the component with the left mouse button, and while holding the button down, drag it to another
location. To move all three at the same time, move the graphic component.

You can hide all the annotations using the F9 function key, or by selecting Show annotations from the
View menu. When hidden, the annotations still exist, but do not appear on top of the image. To display
the annotations again, repeat the sequence.

To set the font size of annotations, open the Customize Settings window from the Settings menu and go
to the Advanced page. The font size is specified in the field labeled Annotation font size. To change the
setting, delete the value and type in a new size, or use the up/down arrows to the right of the edit box to
increase/decrease the font size. When you click on OK, the changes get applied to all existing and future
annotations.

To modify or remove an existing annotation, click on the Annotation button to enter P
annotation mode, and then click to select the annotation you want to change. When Fort size ..
selected, you can drag the annotation around, or adjust its settings. Right click on the  chagecoor..
annotation to pop up a menu (shown here) containing annotation commands. From this ¥ Z°" e
menu, you can remove the selected or all annotations, show or hide the annotation index

number, numerical value such as the length or area or the tick marks in a linear ruler, or
change the font size or color.

Shiow bick marks

Cancel

6.2.1 TEXT ANNOTATIONS

Use the Add Text button, ﬂ to create or add text to an annotation that you want subsequent viewers to
see. Click on the image where you want to insert the text string. A window appears with a field for
entering the text string. This field is also pull-down list containing the previously entered annotation
strings. If you have entered the text string before, you can select it from this list. The feature supports an
auto-completion capability such that Practice Builder 1-2-3 automatically fills in the value once you have
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entered enough for it to find a match. By default, the history file retains the last 20 values. Enter the text

and click on OK. To remove unwanted values from the history list, select the value from the text
annotation window and click on the Delete button.

6.2.2 MEASUREMENT ANNOTATIONS

Practice Builder 1-2-3 supports linear measurements, ﬂ angular measurements, Q Cobb angle
measurements, “L, and area calculations on oval, Q, and free-form, @l, regions. Linear measurement
values are displayed in millimeters. Angles are displayed in degrees. Area values are in square
millimeters. If the image object does not contain pixel size and spacing information, Practice Builder 1-2-3
displays measurements in pixels. To convert pixels to real-world dimensions, you must calibrate the
image. (See section 5.5.8.)

To use the linear and ROl measurement tools,
1. Select the respective annotation button
2. Left-click with the mouse on the image.
3. While holding down the left mouse button, drag the cursor to expand the measurement ruler or
region.
4. Release the mouse button to get the measurement value.

For the angle measurement,
1. Select the angle tool
2. Left-click with the mouse on the image and drag.
3. The initial application of the graphic defines only one leg of the angle graphic. Click and drag the
second leg of the graphic to set the angle properly.

The Cobb angle tool measures angles whose vertex exists outside the image.
This is useful in measuring very small angles, such as spine curvature. The
angle created when the two lines intersect is displayed.
1. Select the Cobb angle tool
2. Click on the image and drag the mouse. The line connecting the two
vectors of the angle appears.
3. To cast each vector, click on the end point of the line perpendicular to
the connector and drag. Position along the axis you need to measure.
4. Repeat with the perpendicular line at the other end of the connector.

The free-form region of interest tool defines a geometric area that cannot be
enclosed using the other ROI tools. . 7k
1. Click on the free-form ROI button. e ~o I

2. Move the cursor to a starting point on the image and click the left mouse button

3. While holding down the left mouse button, drag the mouse to define the region. When you
release the mouse button, the viewer automatically closes the region by connecting the end point
with the start point. The viewer calculates the area within the defined space and displays it on the
image.

4. To correct the region outline, move the mouse until it crosses over the point to want to move. The
cursor changes to either a two-directional or four-directional arrow.

5. Click the left mouse button and drag the mouse to move the line. If you hold the Shift key while
dragging, the line will move in an arc. Without the Shift key, you will just move the point under the
cursor.

6. Release the mouse button. The viewer recalculates the area inside the region.

To adjust the annotation graphic using the mouse,
1. Click on the Annotation button to enter annotation mode
2. Select the annotation you want to change.
3. Toresize the graphic, left-click on one of the grab points along the edge or ends of the graphic
and drag the mouse.
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4. To move the graphic, left-click the edge of the graphic that is not a grab point and drag the
mouse.

To adjust the annotation graphic by small amounts using the keyboard,

1. Click on the Annotation button to enter annotation mode

2. Select the annotation you want to change

3. Press the Tab or Shift+Tab key to select the side, edge or other object you want to adjust. When
you press the Ctrl key (see next step), the selected side, edge or other object is highlighted.

4. Press the Ctrl+<direction> key to move the selected side, edge or other object. The <direction>
key can be ©t to move up, ¥ to move down, < to move left, = to move right, Home to move up
and to the left, End to move down and to the left, Page Up to move up and to the right, and Page
Down to move down and to the right.

6.2.3 HOUNSFIELD UNIT ANNOTATIONS

The Hounsfield annotation tool creates a region of interest and calculates its average pixel value and the

standard deviation on the distribution. To perform this calculation, select the Hounsfield ROI button, ﬂ,
click on the image, and drag the mouse to define the region of interest. When you release the mouse,
Practice Builder 1-2-3 calculates the values and displays them. Resize the region by clicking on one of
the edges of the graphic, and drag it.

To get the value of a particular pixel anywhere in the image, select the Hounsfield annotation tool and
position the cursor over the pixel of interest. The pixel value is displayed in the lower right corner of the
Status bar, along the bottom of the screen. If the Status bar is hidden, display it by going to the View
menu at the top of the screen, select Toolbars, and click on Status Bar.

6.2.4 REPORT IMAGE NUMBERING

When attaching key images to a report, it is useful to label each image so you can reference them in the
report. With the text annotation tool, you can manually add a textual identifier to each key image before
attaching it to the report. With the Report Image Numbering annotation tool, Practice Builder 1-2-3 can
drop a sequential numeric label onto each image in the report, eliminating the need to explicitly type in a

text annotation. To use the report figure numbering tool, click the button, E, open the full-size report
panel, and click on a key image. The next number in the sequence appears where you clicked. To move
the numeric label, select the annotation and drag it to another location on the same key image. To delete
the annotation, right-click on the selected annotation and select Delete.

6.2.5 POINTER GRAPHIC ANNOTATION

The pointer graphic tool draws an arrow on the image. Select the pointer annotation button, ﬂ, and click
on the image. Drag the mouse to adjust the size of the pointer. You can rotate the graphic around its
head by clicking on the end of it and dragging it around.

The pointer graphic tool can contain a text string. The advantage of adding text to the pointer graphic over
using the text annotation tool is that Practice Builder 1-2-3 manages the two annotations as one.
Therefore, if you move or adjust the point graphic, the text automatically follows. To assign a text string to
a specific pointer annotation, first drop the pointer annotation onto an image. Hold the Ctrl key when you
click to place the pointer annotation on the image, and the text box automatically appears. Alternatively,
right-click on the pointer to display the popup menu and select Edit text. The text list appears. Select a
text string from the pull-down list, or type a new string into the text window. Click OK.

6.2.6 SPINE LABELING ANNOTATION

The spine-labeling tool is for labeling vertebrae and disk interspaces. The result is similar to adding text
annotations to an image of a spine, except the spine-labeling tool uses predefined labels, and displays
them in their corresponding location on images in all orthogonal planes.
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Select the spine-labeling tool by clicking on the spine label annotation button, 3 . When active, a spine
labeling control panel appears, listing the predefined vertebral and disk interspaces. To apply a label,
select the starting point from the control panel, and then click on the image to place the label. The label
automatically advances to the next label after you place each one, so left-click again to drop the next
label. To automatically advance in the opposite direction, check the box labeled Reverse Direction in the
spine labeling tool window. Continue until you are done. To skip a label, change the p= 5|
next label in the pull-down list in the popup window. To toggle between vertebral 1
labels and disk interspace labels, press and hold the Alt key while clicking on the | Labelveiebiaz

mouse. For disk interspaces, and when you drag vertebrae labels away from their Next: |L5 hd
default location, a line appears. To display the line after you are done labeling the | ™ Label disk interspace
image, check the box labeled Show Lines in the spine labeling tool window. Mext |L3-L4 =

To customize the spine-labeling tool, use the Spine page in the Customize Settings | ' fieverse drection
window. You can set the default starting point for both disks and interspaces, and | | Showlines
select which one is enabled initially. You can include or exclude L6, and define the Resst
default labeling direction. You can also modify a default label used, and the spacing
between vertebral bodies when placing the spine labels on orthogonal views. See section 4.1.11.2 for
details.

When placing the specified labels in the orthogonal images, Practice Builder 1-2-3 uses the label's focus
point. If the graphic intersects the image within the defined distance from the focus point, it appears in
intersecting plane. The spine labels appear in all orthogonal images automatically, as long as the images
belong to the same Frame of Reference, as defined by the original images modality. If the Frame of
Reference is not predefined, you will have to label each of the images individually. If the focus point falls
outside the distance specified, no label appears.

The center point of the annotation is identified by the little dot next to the label. This is the focus point,
referenced when identifying the point on other images. You can add or remove a line connecting the dot
to the label by dragging the text away from its default location. To make the lines persist after exiting the
annotation mode, select Show Line in the control panel. Move the label by selecting annotation cursor
mode, and dragging the label where it needs to go. To remove a single label, select annotation cursor
mode, right-click on the label to pop up the annotation menu, and select Delete Selected. Select Delete
All from the same menu to remove the spine labels and all other annotations. To remove all spine labels,
including all the labels in intersecting planes, and leave other annotations, click Reset on the spine label
popup window.
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7  Plug-in Modules

Practice Builder 1-2-3 uses plug-in modules to add packages that perform specific functions. Plug-in
modules are individually licensed. When you log in and open the Practice Builder 1-2-3 viewer, it checks
the server to see which plug-ins are licensed. The viewer then loads the licensed modules, which may
result in the addition or modification of menus, popup windows, and toolbars. The sections below provide
instructions on using a particular plug-in module.

7.1 Multi-planar Reconstruction Plug-in

Practice Builder 1-2-3 supports multi-planar reconstruction (MPR) as a plug-in module. The MPR plug-in
is available for the active-X and standalone versions of the viewer. When the viewer starts, it obtains the
plug-in licenses from the server. If the viewer finds a valid license for the MPR plug-in module, it
automatically downloads and installs the plug-in on the workstation. If the MPR plug-in was installed using
one server and the user switches to a Practice Builder 1-2-3 server that does not contain a valid MPR
plug-in license, the viewer does not initiate the plug-in and MPR is unavailable.

Like the general Practice Builder 1-2-3 viewer, if a newer version of the plug-in is available, the viewer
downloads and installs the update automatically. Since a plug-in does not require a formal installation
process, Windows administrator privileges are not necessary to install or upgrade a plug-in.

MPR allows a user to create a completely artificial view of the available image data. For example, if an
axial series exists, and you wish to view the images in a coronal orientation, MPR can create the coronal
view. Additionally, you can use MPR to create a view at an oblique angle. The MPR module creates a
volume using the available data, and allows the user to select the plane that cuts through the volume. The
result is a series of images that the user can view, save to the server, archive, and attach as a key image.

To create the MPR volume, load a series into the main viewer and select Create from the Reconstruction
submenu of the Post-processing menu at on the top of the Practice Builder 1-2-3 GUI. Use the series with
the most slices to obtain the best results.

When you create an MPR frame, the volume is created and the image frame separates into four smaller
frames. Each frame contains a single orthogonal view (sagittal, coronal, and axial) plus an oblique angle
view. The oblique image frame is the
results window, and is represented by the
purple localizer in the coronal view. The
other three frames are control windows.

If the series is particularly large, creating
the volume may take a little time. A
progress bar appears to show you how
much additional time is needed to create
the data volume.

Using the color-coordinated localizers
(i.e., the color of the line matches the
color of the frame containing the image in
that plane), move and rotate the oblique
image. You can window and level the
image using the regular window/level
tools. The other tools are unavailable in
an MPR image frame.

Oblique (generated) view / When you have the results you want,
export the series to EP by double-clicking

Page 103



@_ RAD Practice Builder 1-2-3
e Viewer Manual
on the oblique image, or selecting Export from the Reconstruction menu. Once the

series is exported back to the viewer, it is available from the thumbnail panel and = Humberof siees

you can perform any available function on the image. From the Reconstruction b
menu, the Export Setup item opens the exporting control panel. From this control s,”,aceba.weensﬁceffmm]
panel, you can define the number of slices to include when you export the —
regenerated series (default is 9 slices) and define the spacing you want to use ° 100
between the slices (default is the same as the original series). To change the e e
default, uncheck the box, and enter the number in the respective field.

¥ Adiust spacing to series

Cancel | 0K I

Users with Edit or Report permissions can upload exported MPR images and

series to the server so other users can use them. From the File menu, select Send Image to Server or
Send Series to Server. Once an exported image is saved to the server, you can attach it to a report as a
key image.

7.2 AVIPlug-in

Practice Builder 1-2-3 creates audio +osima 1:TOSHIBADEMO O 2/20/2006
TOSHIBA

- OPE - Adult Heart-1 0Bdbpm  B:20:44 AM

video interleaved (AVI) images via a .
plug-in module. The AVI plug-in is & o
available for the active-X version of the :
viewer. When the viewer starts, it
automatically downloads and installs
the plug-in on the workstation. If the
AVI plug-in was installed using one
server and the user switches to a
Practice Builder 1-2-3 server that does
not contain a valid AVI plug-in license,
the viewer does not initiate the plug-in
and AVI creation is unavailable.

Like the general Practice Builder 1-2-3
viewer, if a newer version of the plug-in
is available, the viewer downloads and
installs the update automatically. Since

Practice Builder 1-2-3 plug-in modules N = E——
do not require a formal installation v

process, Windows administrator

privileges are not necessary to install Stc’pv\

or upgrade it. Play/Pause  previous/Next Frame

AVI allows a user to create a movie from the available image data. If the series does not contain a
recommended frame rate, the plug-in module prompts the user to enter one. The images are then
n | postpracessing Help converted into an AVI file that the viewer can play back at the specified
N fﬂfs‘f's'jubtrmnplugin frame rate. Unlike the results of other post-processing plug-in modules,

AVI objects cannot be annotated, saved to the server, or attached as a key
image.

Reconstruction

Al Create
Stitching Delete
Save as

To create an AVI object, load the selected series into an available image
frame. To combine multiple series into a single AVI object, concatenate
(Ctrl-drag) the additional thumbnail series into the image frame. From the
Post-processing menu, select AVI Player, and
then Create. The plug-in prompts you to confirm  [EUEECIEEY
the applied frame rate. Enter the value in the

popup window and click on Continue. A progress Framerate: | 30 fps
bar appears indicating when the process will

complete. On large data sets, it could take a

Configure

Play
Stop

Previous Frame
Next Frame

Zoom 1:2
Zoom 1:1
Zoom 2:1
Fit o Window

Half Speed
Mormal Speed
Double Speed
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couple of minutes to create an AVI object. When the process is complete, the AVI object appears in the
frame.

The AVI plug-in plays the image back at the defined frame rate. Frequently used tools are displayed in a
toolbar at the bottom of the AVI frame. These and other tools are also available in the AVI Player
submenu from the Post-processing menu. Tools include buttons to start, pause and stop the playback.
When the playback is paused or stopped, you can manually advance the AVI image by dragging the
progression bar or by clicking on the next and previous frame buttons on either end of the progression
bar. The applied frame rate is displayed on the toolbar as well. From the AVI Player submenu, you can
apply a zoom factor to the AVI images.

AVI images cannot be exported to the viewer, meaning they cannot be stored on the Practice Builder 1-2-
3 server. You will have to recreate the AVI object each time you want to display it. You can save the AVI
file to the local workstation as an AVI file. Use the Save As item on the AVI Player submenu to bring up a
Windows panel to select a folder in which to save the data.

Configure

The AVI plug-in configuration panel is available from the AVI Player
menu in the Postprocessing pull-down menu at the top of the viewer. |~ DB e el ey
Click on Configure to pop up the configuration window. The AvVI || Ceeeemenkidoaionese
configuration allows you to define a default frame rate to use when the
series does not contain a recommended value and to override the | &t |

5 Default frame rate [frames/sec)

recommended frame rate when one is defined.
Setting Description
Use DICOM frame rate  When checked, the value in the image object is used automatically. Enabled
without prompting by default.
Override recommended  When checked, the defined default will be proposed for all series. Disabled by
display rate default.
Default frame rate The default frame rate (frames/sec) to propose when no recommended frame

rate exists, or Override Recommended Display Rate is enabled.

Select codec Select the preferred codec to use for creating the AVI images. The list comes

from the codecs available to Windows on the workstation.

7.3 Image Fusion Plug-in

The Practice Builder 1-2-3 image fusion tool is a plug-in module for superimposing PET/CT and
SPECT/CT structural and functional images into a single volume. Tools include orthogonal and volume
oriented view controls, alpha blending, color spectrum application, and MIP view. The plug-in applies to
studies whose largest, contiguous segment of images share complementary spatial resolution
characteristics, meaning they were acquired on a single machine as part of a single procedure.

The image fusion plug-in module has the following workstation requirements.
Processor speed: greater than 2GHz
RAM: minimum is twice the size of the series loaded into the fusion frame
Display controller:
Video RAM: minimum of 256MBs
Support for Direct X v9.0 drivers dated August, 2008 or more recently
Support for PixelShader 2.0 or later.

Attempts to invoke the fusion plug-in module on a machine with insufficient resources may display one or
more warnings or error messages. If so, the plug-in may appear to process the data correctly but
performance may be poor and results cannot be guaranteed. Do not use the fusion plug-in until you are
able to load the plug-in without receiving any popup notices.

When the EP viewer starts, it searches the server for the fusion plug-in license. If a valid license exists

and the user account is configured to use the plug-in module, the viewer prompts the user to download
and install it on the workstation. Once downloaded the plug-in installs automatically and is ready to use.
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To invoke the fusion plug-in module, drop a series from the thumbnail panel into an image frame. From
the Post-Processing menu, expand the Image Fusion submenu and chose Create. The plug-in is ready to
use when the progress bar disappears, the data is 100% downloaded, the image frame becomes a plug-
in frame with toolbar displayed on the border, and the default layout appears.

To fuse the loaded series with another, drag and drop another series into the image frame running the
plug-in module. A progress bar pops up while the plug-in module processes the data. When finished, the
progress bar disappears and all series loaded into the plug-in frame appear fused together on the screen.

7.3.1 FUSION FRAME LAYOUT
The fusion plug-in consists of a viewing area and a toolbar.

:
%I

7.3.1.1 Image fusion toolbar
The toolbar defaults to the right side of the image frame. It can be detached and floated anywhere in the
image frame.

Tool Button  Description

4-up “ Four image cells containing orthogonal and MIP views

9-up l! Nine image cells containing each series in orthogonal views
Show/hide . Show/hide the structural image in individual cells

structural —

Show/hide E Showr/hide the functional image in individual cells

functional

Move g Manually line up the images by manipulating the structural
structural image

Move ﬂ Manually line up the images by manipulating the functional
functional image

Save image D Export the highlighted image

Save series ﬂ Export a series of images from the highlighted cell

Show/Hide ﬂ Toggle to show and hide the hash marks

hash marks —

Show/hide ! Toggle to show and hide the SUV overlay and SUV ROI
SUV values annotation

7.3.1.2 Display layouts
The two primary layouts display the images in different views.
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Layout Description

4-up Displays the individual or fused series in all three orthogonal views, plus one
MIP view.

9-up Consists of three rows showing the series in all three orthogonal views. The

first row shows the structural image. The second row shows the functional
image. The final row displays the fused images.

7.3.1.3 MIP Image View
A MIP view of an individual or the fused image is available in 4-up display mode.

7.3.2 IMAGE MANIPULATION

Image manipulation tools include scrolling, zooming, windowing/leveling, color palette adjustments, alpha
blending, rotating and panning.

By default, the fusion plug-in renders all loaded series. To display the image in a single series, load only
one series into the plug-in frame, or deselect the Show Structural or Show Functional button from the
toolbar.

7.3.2.1 Window/level
To adjust the window and level settings for the displayed image, apply the following sequence:

1. Position the mouse cursor over any image in the fusion plug-in frame.

2. To adjust the window width and level of the primary/structural image, press and hold down the
right mouse button. To adjust the width and level of the secondary/ functional image’s palette
range, press and hold the Shift button and the right mouse button.

3. Drag the mouse to the left to decrease the window width, right to increase the window width,
forward to decrease the window center and backward to increase the window center.

7.3.2.2 Scrolling
To scroll through the image stack, position the mouse cursor over any image in the fusion plug-in frame
and press the left mouse button to select it. Then apply one of the following sequences:
1. Scroll the mouse wheel backward to advance and forward to return one frame at a time
2. Press and hold the wheel button, and move the mouse backward to advance and forward to
return one frame at a time.

7.3.2.3 Zooming
To magnify the images, apply the following sequence:
1. Position the mouse cursor over any image in the fusion plug-in frame.
2. Press and hold down both the left and right mouse button, and drag the mouse forward to
increase the image size and backward to decrease it.

7.3.2.4 Orbiting MIP view

You can rotate the default MIP volume around a center point by applying the following sequence:
1. Position the mouse cursor over the MIP image.
2. Press and hold down the left mouse button, and drag it to orbit the image.

7.3.2.5 Cross correlation

Cross correlation is the ability to identify the same point in all orthogonal images. There are two modes.
The cross correlation tool finds the intersecting point on all images and displays it in each cell. The Magic
X version is the same function and includes the images displayed in the main viewer frames as well.

The tool applied to the image depends on the selected cursor mode. If the cursor mode is the normal

mode, %, the cross correlation tool is applied. If the cursor mode is Magic X, &, the Magic X tool is
applied.

After selecting the cursor mode, apply the following sequence:
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1. Position the cursor over the point in an image.
2. Press and hold down the CTRL button, and click the left mouse button to display the intersecting

point in all image cells, or hold down the left mouse button and drag the mouse to dynamically
refresh the point under the cursor in each of the other cells.

7.3.2.6 Color schemes
A number of predefined color schemes are available. The default scheme is red, and can be changed by
the user. The other options include blue, red glow, blue glow, hot metal, ice water, rainbow, and none
(grayscale). To apply a selected color scheme to a functional or fused image, apply the following
sequence;

1. Position the mouse over the fusion plug-in frame and click the right mouse button.

2. Click Color Scheme to display the submenu.

3. Select the color scheme from the submenu.

When a color scheme is applied to the functional or fused image, adjust the palette range as follows:
1. Position the mouse cursor over any functional or fused image in the fusion plug-in frame.
2. Press and hold the Shift button and the right mouse button.
3. Drag the mouse to the left to decrease the window width, right to increase the window width,
forward to decrease the window center and backward to increase the window center.

To change the default color scheme,

Drop a function (PET) image in the fusion plug-in frame.

Select the color scheme you want as the default, as instructed above.

Position the mouse over the fusion plug-in frame and click the right mouse button.
Select Color Scheme to display the submenu.

Click Save Current as Default.

agrLONE

7.3.2.7 Alphablending
Alpha blending is combining the alpha layer with other layers in an image in order to show translucency.
Alpha blending modes include Constant and Linear. Select the alpha blending mode as follows:

1. Position the cursor over the fusion plug-in frame and click the right mouse button.

2. Click Alpha to display the submenu

3. Select the alpha blending mode

Mode Description

Constant Alpha blending adjustments alter the alpha constant. The initial alpha constant is 0.5.

Linear (Default) Alpha blending adjustments alter the alpha scaling factor. The initial alpha
scaling factory is 2.0.

Reset Reset the alpha constant and scaling factor to system defaults

When the alpha blending mode is Constant, the transparency is independent of the image’s
color/intensity value. When the alpha blending mode is Linear, the transparency is a linear function of the
image’s windowed intensity.

Alter the alpha constant or scaling factor as follows:
1. Select the alpha blending mode as described above.
2. Press and hold down the CTRL key and the right mouse button
3. Drag the mouse forward to decrease the value and backward to increase the value.

7.3.2.8 Manual registration

The image series are automatically registered if they were acquired on the same device and are encoded
with a shared frame of reference identifier. Other series can be manually registered. To do this, load both
series into the fusion plug-in frame and follow the steps below.
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1. To keep the structural image fixed and adjust the functional image, select the Move Functional

button, ﬂ in the fusion toolbar. To keep the functional image fixed and adjust the structural

image, select the Move Structural button, @ in the fusion toolbar.
2. Position the cursor over the fusion cell containing the image you want to adjust.

To move the affected image:
e Press and hold down the left mouse button, and drag the mouse.

To rotate the affected image around the starting point:
e Press and hold down the right mouse button, and drag the mouse.

To resize the affected image centered around the starting cursor position:
e Press and hold down the left and right mouse buttons, and move the mouse forward and
backward.

7.3.3 ANNOTATIONS

The fusion plug-in module supports a number of annotations and overlays, including hash marks and
SUV values.

7.3.3.1 Hash marks
Orthogonal images in the fusion frame include hash lines of the interesting image planes. They appear as
cross hairs on the images. To show and hide the hash marks, apply the following sequence.

e Press the Show/Hide Hash Marks button, E in the fusion toolbar.

7.3.3.2 SUV values
When the functional image contains the standard uptake value (SUV) data, the information is displayed in
the image cell by default. The uptake value for the point under the cursor is displayed.

If SUV information is available, SUV values are displayed by default. To hide the SUV data overlay, apply
the following sequence.

e Press the Show/Hide SUV Values button, ﬂ in the fusion toolbar.

SUV values are only displayed when specific values are present in the PET or SPECT series. Some
values depend on the modality vendor. In general, the following attributes are required. The value in
parentheses is the DICOM tag value.

Injection Dose (0018,1074)

Injection date (0018,1078) and time (0018,1072)
Acquisition date (0008,0022) and time (0008,0032)
Half life (0018,1075)

Patient weight (0010,1030)

SUV values are normalized for body weight (SUV,,), and displayed in g/ml. Some modalities produce
data using other scales. To convert to other units, the conversion information is required. For these
modalities, vendor-specific attributes are needed, which may or may not be present in the data.

7.3.3.3 SUV regions of interest
To display the maximum SUV value in a region of interest, apply the following sequence.
1. Position the cursor over the center of the SUV ROI sphere you want to draw.
2. Press and hold down the Shift key and the left mouse button, and drag the mouse away from the
center point. A circle appears on the image.
3. Release the mouse and keyboard once the circle defines the region. The maximum SUV value in
the sphere appears on the image.

Page 109



@ RAD Practice Builder 1-2-3
_ e Viewer Manual
To remove or redefine an SUV ROI

1. Position the cursor within the boundaries of the SUV ROI. The annotation is highlighted.

2. Press the Delete key.

7.3.4 SAVING IMAGES

Images created by the fusion module can be exported to the main viewer and sent to the archive for
storage. Exported images can be attached to reports as key images on they are uploaded to the server.
Uploading exported images requires Edit or Report permissions. See section 5.5.12.1 for details on
uploading post-processes images.

Annotations applied to a fused image when it is exported remain on the image after exporting, but they
cannot be modified outside the plug-in frame. To make adjustments to an annotation, reload the exported
image into a fusion plug-in frame and edit it.

7.3.4.1 Exporting fused images
To export a single fused image, apply one of the following sequences.
e Double click the fusion cell containing the image, or

e Select the fusion cell containing the image to export and click the Export Image button, ﬂ on
the fusion toolbar.

7.3.4.2 Exporting fused series
To export a series of fused images, apply the following sequence.
1. Select the fusion cell containing the images to export.

2. Click the Export Series button, ﬂ

3. In the Export Options window, select the number of slices to include in the series plus the slice
spacing (fused images) or incremental rotational angle (MIP).

4. Click OK.

7.3.5 CONFIGURATION

The fusion module configuration panel is available from the Image Fusion item &= .
under the Postprocessing menu at the top of the viewer. Click on Configure to pop

I Dont Use 326k Testuse D30 compatiblity]

up the configuration window. e
Dielznlt Functional Oy Cokorg  [Sum : Futmd =
Fusion configuration allows you to define default color schemes, alpha blending ™™ o =]
mode and associated parameters, a slice space limit and some D3D compatibility Tiee =
parameters. Default color schemes can be different when applied to the fused — cosmsmrmm g
image, the PET-only image and the MIP image. i e _—

Section Setting Default Description

General Maximum slice 5% Defines the maximum spacing between slices
spacing error accepted as belonging to the data volume.

Don't' use 32-bit  Disabled If the data cannot be rendered in 16 bits, the data is

textures expanded to 32 bits to preserve precision. Some
D3D drivers and devices do not support this.
Checking this box avoids this issue, but may result in
rounding errors in the data.

Coloring Fused coloring Red Default color scheme applied to fused images.
Functional only Same as Fused Default color scheme applied to functional (PET)
coloring Coloring images when rendered non-fused.

MIP coloring Same as Fused Default color scheme applied to MIP image.
Coloring
Blending  Blending mode Linear Alpha blending mode. Can be Linear or Constant.
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Section Setting Default Description
Blending Scaling factor: 2.0 When mode is linear, this parameter is the alpha
parameter Scaling constant: 0.5 scaling factor. When mode is constant, this
parameter is the alpha constant.
Auto Fused image 100% Color saturation intensity applied to fused images.
Palette The default is full intensity, 100%.
Range

7.3.6 KEYBOARD CONTROL SUMMARY
The following tables summarize the keyboard and mouse commands.

7.3.6.1 Normal mode

Key Mouse Action Result
Right Drag left/right Window structural/primary image
Right Drag forward/backward Level structural/primary image
Shift Right Drag left/right Change palette range width of functional image
Shift Right Drag forward/backward Change palette range center of functional image
Middle Scroll forward/backward Scroll through images
Middle Drag forward/backward Scroll through images
Left+Right  Drag forward/backward Resize image
Left Drag Orbit MIP image
Shift Middle Drag Tilt the reconstructed planes
Ctrl Left Click or drag Set cross correlation point
Ctrl Right Drag forward/backward Adjust alpha blending setting
Shift Left Drag Define SUV ROI

7.3.6.2 Magic X cursor mode

Key Mouse Action Result
Ctrl Left Click or drag Apply Magic X
7.3.6.3 Manual registration mode

Key Mouse Action Result

Shift Left Drag Moves the structural image
Ctrl Left Drag Moves the functional image
Shift Right Drag Rotate the structural image
Ctrl Right Drag Rotate the functional image
Shift Left+Right  Drag Resize the structural image
Shift Left+Right  Drag Resize the functional image
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8 Reports

Practice Builder 1-2-3 includes reporting functions that enable a user to record a text or dictated report
and addenda, and to attach selected images to a report along with their presentation state. Reports from
prior studies are available for display as well.

The patient folder displays a presentable form of a prior study’s report. The layout is templated, meaning
it can be customized for presentation and content. Details on defining a report template and assigning it
to your user account are found in the Practice Builder 1-2-3 Operator's Manual.

The compact report panel is suited for dictating a report or addendum. It contains basic study
identification information plus controls for recording a voice clip. Section 3.6.3 contains details on the
compact report panel.

The full report panel provides access to all report components for each loaded study plus tools for
creating, editing and reviewing reports. Section 3.6.3 contains details on the full report panel. The full
report panel contains the key images as well. The key image panel appears at the bottom of the report
panel. See section 8.3 for details.

Documents tagged as scanned paperwork, denoted by DICOM attribute (0008,0064) set to WSD or SD in
SC Image or Encapsulated PDF objects, may appear in the report panel, depending on the applied XML
template. Scanned documents can be dragged to an image frame in the viewer for manipulation, if
necessary.

8.1 Displaying Reports

Reports consist of text, key images and attachments. Each of these can be displayed in the report panel.

8.1.1 DISPLAYING REPORT TEXT

When a study loads into the viewer, it includes the report if one is available on the server. Report text for
prior exams come from a variety of sources: entered directly from the Practice Builder 1-2-3 viewer;
entered into the report editor from the web page; created on a third-party device such as a Radiology
Information System (RIS) and imported into the PACS server. Once the server has the report data, it
makes it available in the viewer’s report panel.

To display a report in the patient folder, do the following:
1. Click the report icon in the Reports carousel in the patient folder. The report appears in the view
area of the patient folder.

To display a report in an image frame in the main viewer, do the following:
1. Drag the report icon in the Reports carousel into an image frame. The report replaces the
previously displayed contents of the image frame.

To display a report in the report panel, do the following:
1. Click the Report Panel button, €, from the toolbox toolbar or select Report Panel from the View
menu.
2. If not already selected, click the tab for the study you want to display.
3. If not already displayed, click the sub-level tab for the report or addendum you want to display.

8.1.2 DISPLAYING ATTACHMENTS

If the study includes scanned documents or other forms of attachments, they appear in the Attachments
section of the patient folder, in the thumbnail panel and in the report panel under a tab labeled
Attachments.
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In the patient folder, scanned documents are listed in the Attachments carousel. Click the attachment icon

to display the document in the patient folder’s view area. Drag the attachment icon into an image frame to
display the document in the main image area.

If configured to display documents in the thumbnail panel, each attachment appears as an icon in the
thumbnail panel. Drag the thumbnail to display the attachment in the main image area.

On the report panel, scanned documents are listed under the Attachments tab. Click the tab to see all the
attachments. Click the attachment to load it into the report panel’s attachment view area.

Note: The patient folder’s view area, the main image area and the report panel’s attachment tab’s view
area launch the application appropriate for the attachment'’s file type. The results are embedded
into the designated area or launched in a separate window. The setting to embed PDF
documents into the browser window is in Adobe Reader. From the Edit menu, select Preferences.
In the Categories list, select Internet. Check the Display PDF in browser box.

If the attachment is an image (e.g., a JPEG file or DICOM obiject), position the mouse over the thumbnail
to display the attachment at a readable resolution. For non-image file types (e.g., a PDF file), the
attachment’s file name appears.

The respective attachment view areas support three display modes.

Display Mode Description

Fullimage mode Display the image at full resolution, adding vertical and
horizontal scroll bars to reposition the viewable area.

Page-width mode Fit the page width to the image area, adding a vertical scroll bar
if necessary.

Full page mode Fit the entire image to the image area.

To change the display mode, position the cursor over the image view area and click the left mouse
button. The modes advance from page-width to full image to full page to page-width.

8.2 Creating a Report

Creating a report means entering text or a recording to a report, attaching a key image and changing the
study state. To create a report you must have report editing and maybe dictation privileges. If the report
panel has no editable fields, you may not have the requisite permissions. Speak with your system
administrator if you need to change the settings on your account.

To create a report, open the report panel by clicking on the Report button, €, in the toolbox toolbar. If you
press the Record button on a Philips Speechmike, you will open the compact report panel.

A report may consist of an observation, an impression, addenda, key images, and the dictated wav data.
Any one of these components makes a report, although a report can consist of all of them. Creating an
observation, impression, addendum and a dictation are described in the following sections. Attaching key
images is described in section 8.3.

8.2.1 TEXT REPORTS

Use the full report panel to enter a text report. The default report format consists of an observation section
and an impression section. Practice Builder 1-2-3 does not apply any restrictions to the use of these fields
other than they remain separate, both in the viewer and from the web page report. To enter text into
either of these fields, click in the window and type.

The Notes section of the report panel contains radiologist notes. The text in this field is entered by and
displayed for users with notes privileges. Other users, typically referring physicians, technologists, and
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administrators, do not have access to the contents of the Notes field. The notes field is for submitting
comments to the radiologist. If a note exists and the Impression and Observation fields are empty, the
note automatically pops up when the study is loaded into the viewer. To disable this popup, clear the

Show Report Note setting on the Settings page in Customize Settings. Notes are retained in the Practice
Builder 1-2-3 database and can be edited any time prior to signing the report.

8.2.1.1 Formatted Text

The Observation and Impression text fields support rich text. The available tools include text font type and
size, bold, italic, underline, strike-through, superscript, subscript, text alignment, bulleted and numbered
lists, indentation, color, separator and tables. Rich text fields expand dynamically as you enter text.

For a detailed description of the formatting toolbar, refer to section, 3.1.9.

8.2.1.2 Spell Checking

If you have not installed the Practice Builder 1-2-3 spell checker, you will be prompted to do so when you
first load the viewer. This process installs an application on your PC, which means you must have
Windows administrator privileges on your workstation if the install is to work. If you do not have Windows
administrator privileges, contact your local PACS administrator.

To use the spell checker, click the spell check button,  Notinbictionay e
¥, on the report toolbar in the full report panel. The L“‘“““?‘“ Ignore Al
spell checker checks all text fields in the report panel. If e S [ oo |
it finds errors, it displays the spell check panel. Click | Change Al |'
the Change button to replace the misspelled word with v A - add |
. A . Add words to:
the highlighted suggestion. The Change All button [ =1 swoen |
changes all occurrences of the misspelled word. o | Heb | Dictonsios. | Opims. | comcs |

To add the word to your dictionary, click on Add. When done checking the text, click Cancel to close the
spell checking window.

To override the spell checker’s default dictionary, create a new dictionary file named precorrect.tix in the
c:\program files\practicebuilder\plugins\spellex directory. Restart the viewer to pick up the changes.

To use the spell checking function from the Practice Builder 1-2-3 web-based report editor page, you
must have previously installed the Practice Builder 1-2-3 viewer and the spell checker plug-in module.
The EP viewer must also be running in standby mode.

8.2.1.3 Normality Flag
The normality flag allows a user to tag a report so the study is visually highlighted on the worklist. To set
the normality flag to Alert, clear the Normal flag field on the report panel.

The presence and label of the normality flag on the report panel is configurable. It is a server setting,
editable by the system admin. Refer to the Server Configuration section of the Operator's Manual for
more details.

8.2.1.4 BIRAD Values

BIRAD values can be assigned to a study
in the report, but are only displayed for Radiologist:| # BI RADS: [n/a |
mammography images. To assign a

BIRAD value to a report, open the Report panel and use the drop down box to select a value. Accepted
values are n/a, 0, 1, 2, 3, 4, 4a, 4b, 4c, 5, and 6.

BIRAD values are displayed on the worklist if the column is included in the layout. User can search for
studies with a defined BIRAD value.
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8.2.2 CANNED REPORT TEMPLATES

Create a collection of predefined reports and apply them in place of dictating a report or typing a custom
report. Each report template belongs to a user’s profile and can be defined as a general template or a
modality-specific template. The administrator can copy canned report templates between user accounts,
after which the new user can further customize the report template.

When saving a canned report template, the user specifies the text, state, flags fields are affected, and
then combine multiple templates to compose a single report. The individual fields making up a report
template are note, status, normality flag, observation, and impression.

To save a report template, follow these steps:

1. Open the Full Report panel.

2. Select Edit from the Template menu. The report panel changes to the report template editor.

3. Enter values into the fields to be saved in the report template.

4. Check the Overwrite checkbox for the fields you wish to replace when importing the canned
report template. If the Overwrite checkbox is unchecked, the contents in that field will be
concatenated to any existing contents when importing the canned report template. Check the
Overwrite checkbox in the status field to replace the status with that of the template.

5. Select Save from the Report Template menu. The template saving panel pops up.

6. Enter the name of the canned report template. Valid characters are: alphanumeric (a-z, A-Z, 0-9),

underline (), hyphen (-), pound (#), period (,) and space.

7. To create a modality-specific canned report, check the box labeled Available for specific
modalities and select the modalities from the list. Leave the box unchecked to create a generic
canned report.

8. Click Save.

When a study is loaded into the viewer, canned report templates with the same Modality setting as
defined by the study’s Modality attribute are combined with the general canned report templates into a
single list. If multiple studies with different modality values are loaded into a single viewer session,
templates for all modalities plus the general ones are available in a single list from the toolbar.

To apply a canned report to a study,

Open the report panel in the Practice Builder 1-2-3 viewer

From the Template menu, select Load.

From the list of saved report templates, select the one you want to apply.

Click OK. The viewer downloads the report from the server and enters the text into the respective
fields.

rpONPE

8.2.3 DICTATION

Practice Builder 1-2-3 records dictations in the viewer using any Windows compatible microphone and
sound card. Follow the manufacturer’s installation instructions for these components before attempting to
record a report in Practice Builder 1-2-3.

The recording controls are located in the Audio toolbar, which you can attach to the report panel by
selecting Audio Controls from the View menu in the report panel. The recording controls contain a
play/stop button, and record button and a delete button. There is also a progress gauge showing your
current recording position.

Dictating a report requires dictation permissions.

Start recording a dictation by selecting the Record button on the Audio Toolbar, or from the Audio menu.
After you finish recording, click on the Stop button. Play back the dictation by rewinding it to the beginning
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of the recording and pressing the Play button. Use the speed control gauge on the Audio toolbar to adjust
the speed of the playback.

‘F|O|K|}|—3 —  —— [

If multiple editable studies are loaded in the viewer when you start dictating, Practice Builder 1-2-3
prompts you to select the report you want to dictate. By default, the system chooses the report that
corresponds to the primary study, which is the first study listed in the thumbnail panel. Choose the study
you want to dictate and click OK.

trol gauge

Opened studies x|
Patient Name Patient ID Study Date Modality Accession No. Description Body Part Report Status
Bob, Billy 9219 Mar 12, 2007 XA 3647 xray chest film Chest Unviewed
Bob, Billy 51344 Jan 30, 2003 oT 003694 Pathology Slides Final
Bob, Billy 12345 Jun 01, 1999 oT 3989 xray chest film Chest Read
I Make selection permanent for this viewer session Cancel

If you start dictating when the selected image frame is from a study other than the one you previously
selected, the Viewer prompts you to confirm you are dictating into the correct report. You can disable this
prompt by checking the Make selection permanent for this viewer session box. To change the target
study after making this assignment, open the Settings menu and uncheck Permanent Report Selection.
The next time the image frame focus changes and dictation is started, the study selection window
appears.

To disable the study selection prompt, deselect Enable Dictated Study List in the Customize Settings’
Settings page. When disabled, dictation applies to the primary study.

Remove part of a recording by positioning the locator at the start of the unwanted section and clicking on
the Delete button in the Audio Toolbar. The entire recording from the present location to the end is
purged. Deleting removes everything to the end of the report.

It is not possible to delete any part of a dictation if the report component (observation, impression or
addendum) has been approved and is in the Final state.

8.2.3.1 Philips SpeechMike™ Support

The Practice Builder 1-2-3 viewer supports tighter EOL\ L_'_ RECORD
integration with the Philips SpeechMike than it does
for other microphones. Practice Builder 1-2-3 << .—,‘J‘, * INS/OVWR

supports the following Philips SpeechMikes.
>

Philips LFH-30x0 SpeechMike AIR Pro ; ’

Philips LFH-32x0 SpeechMike 11l Pro N

Philips LFH-35x0 SpeechMike Premium

Philips LFH-36x0 SpeechMike Premium

Philips LFH-5262/LFH-5272 SpeechMike Pro

Philips LFH-5274 SpeechMike Pro

Philips LFH-5276 SpeechMike Pro

i ili o TM
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The following models are supported on Windows XP, 2000 and Vista as well.

= Philips LFH-6174 SpeechMike Pro
= Philips LFH-6274 SpeechMike Pro

Figure 8.2.2.1-1 shows the SpeechMike and the buttons available from Practice Builder 1-2-3.

SpeechMike integration requires driver 2.3.190.7 or later. Install the SpeechMike device and driver
according to its instructions, and then restart the viewer. Set up your SpeechMike configuration in the
Customize Settings’ Dictation panel. See section 4.1.13 for detalils.

State Based Control Mode

When set for State Based control, the SpeechMike has two functional states. When inactive, the indicator
light is off and the device is used to adjust the current position in the recording (rewind, fast forward) and
to play back the recording. When the SpeechMike is activated, the indicator light turns on, the compact
report window appears on the screen, and the device is ready to record a dictation. Toggle between the
two modes by pressing the Record button.

To start recording, press the Record button to activate the SpeechMike, then the Play button to start
recording, and speak. To stop recording, press the Play button again. Depending on the state of the Keep
SpeechMike Active setting in the customize settings window, pressing the Play button will either return to
Pause mode, or disable the SpeechMike.

To add to an existing dictation, press the Play button to append the voice to the existing recording. If you
select Rewind or Fast Forward, you can reposition the starting point for recording more data.

When the control mode setting is State-based, the SpeechMike controls are as follows:

Button Start Mode Condition Action
EOL N/A Button not used by Practice Builder 1-2-3
RECORD OFF Enter PAUSE mode
PAUSE Turn SpeechMike OFF
RECORDING Keep SpeechMike Active is disabled Turn SpeechMike OFF
Keep SpeechMike Active is enabled Enter PAUSE mode
INS/IOVWR _Any Delete from current position to end
RECORDING _Delete remainder of dictation: No Insert audio
Delete remainder of dictation: Yes Overwrite audio from current position to
end
<< Any Rewind mode: Steps, press and release Rewind for configured Step Time
Any Rewind mode: Steps, press and hold Rewind to beginning of recording
Rewind mode: Continuous Rewind until released
>|| OFF Play dictation from current location
PLAY Stop playing dictation
PAUSE Enter RECORDING mode and record
RECORDING Keep SpeechMike Active is disabled Turn SpeechMike OFF
Keep SpeechMike Active is enabled Enter PAUSE mode
>> Any Fast forward mode: Steps, press and Fast forward for configured Step Time
release
Any Fast forward mode: Steps, press and hold  Fast forward to beginning of recording

Fast forward mode: Continuous

Fast forward until released

Persistent Control Mode
When set for Persistent control, the SpeechMike is activated automatically when you press a button, and
deactivated automatically when you release the button. If the SpeechMike type is set to 4-position switch,
persistent mode is the only control mode available.

Page 117



((e RAD Practice Builder 1-2-3
' Viewer Manual

If your SpeechMike’s control mode setting is Persistent, the SpeechMike controls are as follows:

Button Condition Action

EOL Button not used

RECORD Record until released

INS/OVWR Delete remainder of dictation: No Insert audio
Delete remainder of dictation: Yes Overwrite audio from current position to end

<< Rewind mode: Steps, press and release Rewind for configured Step Time
Rewind mode: Steps, press and hold Rewind to beginning of recording
Rewind mode: Continuous Rewind until released

>|| Play recording from current position

>> Fast forward mode: Steps, press and release Fast forward for configured Step Time
Fast forward mode: Steps, press and hold Fast forward to beginning of recording
Fast forward mode: Continuous Fast forward until released

If you need audible feedback to know what mode the SpeechMike is in, check the SpeechMike Button
Click, SpeechMike Pause Click and Record Start/Stop Tick boxes in the Settings page of the customize
settings window. When the button click setting is enabled, each time you press a button on the
SpeechMike, you hear a soft click. When the pause click setting is enabled, a click is sounded every two
seconds while the SpeechMike is in pause mode. The click sound continues until you either start
recording or deactivate the SpeechMike. The Record Start/Stop Tick setting results in audible click played
back when the user enters or exits record mode.

The assigned clicking sound and volume is managed by Windows. By default, the click sound is
start.wav. To change the click sound file, go to the Windows Start button, select Settings and then Control
Panel. Double click on Sounds or Sounds and Audio Devices, depending on the version of Windows you
have loaded. Select the Sounds tab. In the Program Events list, find the Windows event for the
SpeechMike and select it. The Sounds list activates. Select any of the available sound files, of select
Browse to load a custom sound file. When you've selected the sound file, click on OK to save.

8.2.4 SPEECH RECOGNITION

Speech recognition (SR) is the function of converting spoken language into editable text without manual
transcription. Instead of using a keyboard to type text into an editor package, the user talks and the words
appear in the text area. The converted text has the same properties as text entered manually into
Practice Builder 1-2-3, whether it was from the viewer’s report panel, the transcriptionist’s report panel, or
the RIS.

Practice Builder 1-2-3 provides optional embedded SR support, where the SR tools are integrated into
EP’s basic reporting function. The embedded SR functions are described in section 8.2.4.1.

For users running an integrated SR application on the workstation, Practice Builder 1-2-3 includes an
optional interface to use it as an alternative to its embedded solution. This interface is described in
section 8.2.4.2.

8.2.4.1 Embedded Dragon Naturally Speaking

The embedded Dragon Naturally Speaking package is provided as an optional plug-in module. It requires
a plug-in module license, plus a licensed copy of Dragon Naturally Speaking (DNS) installed on each
workstation. The embedded SR package is intended to be used with a Philips SpeechMike. Other
microphones are supported, but the integrated controls are only available on the SpeechMike.

To configure the EP viewer to use embedded SR, open the Customize Setting window from the Settings

menu, and click on the Speech Recognition tab. See section 0 for details. If the Dragon Naturally
Speaking option is available, it means the license has been installed on the server, and a valid copy of
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Dragon exists on your workstation. Select it, and click OK to set the embedded speech recognition as
your default report recording tool.

When using SR, it is possible to retain a copy of the WAV file created when dictating the report. This
would be unnecessary if the user is responsible for editing the resulting text. However, if the results of the
SR processing need editing by a third party, such as by a transcriptionist, save the original recording for
validation. Check the box labeled Auto record WAV when dictating in the Customize Settings’ Speech
Recognition panel to save the WAV file.

When Dragon Naturally Speaking is selected as the default dictation mode, the Speech Recognition
menu appears at the top of the EP viewer. This is the where you will find all the Dragon controls and
tools. For detailed information on each of these tools, refer to the Dragon Naturally Speaking user
manuals.

Menu ltem Description

User Displays the current user account name
Microphone Enable/disable the microphone

Open User Open an existing user account

New User Create a new user account

Close User Close the current user account

Roaming User Options

Set up roaming user configuration

Manage Users

Edit DNS user accounts

Audio Setup Wizard

Set up the microphone and sound controller

General Training

Train DNS to understand speech patterns

Train Words

Train DNS to understand specific words

Vocabulary Editor

Add and edit the DNS dictionary

My Commands

Add and edit custom commands, including EP commands

Accuracy Center

Tools to help you improve how DNS hears and understands what you say

Recognition History

Display most recently used words recognized by DNS

Option

Set DNS options

Practice Builder 1-2-3 has integrated a set of voice commands specific to the features available in the EP
viewer. These commands must be downloaded from the Practice Builder 1-2-3 server and uploaded into

the Dragon vocabulary. The available EP-specific commands are given in the following table.

Voice Command Description Comments
approve Approve a report and set state to

Final
bold font Set selected text to bold font Applies to selected text only
close study Close the current study Leaves the viewer open
close views Close the image views

compact report panel

Display the compact report panel

customize settings

Open Customize Settings window

end dictation

End the dictation and disable the
microphone

end study End the current viewer session
exit from viewer Close the study and the viewer
fit image Set image zoom to fit-to-window Requires a selected image frame
focus to addendum | impression | | Set cursor focus to the report’s | Available with the full report panel is
note | observation Addendum, Impression, Note or | open
Observation field
full report Display the full report panel
full screen Display selected image in Full | Requires a selected image frame

Screen mode

help contents

Pop up the Help window
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Comments

hide report panel

Close the compact or full report
panel

invert image Invert the selected image’s greyscale | Requires a selected image frame
setting

italic font Set selected text to italics font Applies to selected text only

layout manager Display the layout manager

next frame Scroll to the next image Requires a selected image frame

OK Select the OK button Available when the close prompt

notice is displayed

open next study

Open the next study on the worklist

open previous study

Open the previous study on the
worklist

overlays Show/hide overlays

play cine Start recursive cine mode Requires a selected image frame
previous frame Scroll to the previous image Requires a selected image frame
record Start recording dictation

record stop

Stop recording dictation

report templates

Set focus to the report templates
toolbar

Available if the full report panel is
open and it has the report templates
toolbar displayed

reset image size | orientation | | Reset the selected image’s size, | Requires a selected image frame

position orientation, or position

reset window level Reset the  selected image’s | Requires a selected image frame
window/level setting

send report Send the report to the server

set state read | dictated | preliminary | Set the study state to Read,

| final

Dictated, Preliminary or Final

show hash marks

Display hash marks on all images

show localizers

Display localizer lines on all images

show report panel

Display the default report panel

stop cine

Stop recursive cine mode

Requires a selected image frame

underline font

Set the selected text to underline font

Applies to selected text only

To download the commands, follow the following steps.

Open the Customize Settings window from the Settings menu, and select the Speech

Click the button labeled Download Voice Commands. A popup window appears describing the
install process. Click OK. A window appears allowing you to select where to save the file you are
about to download. Select the folder, or choose Desktop, and click Save.

After the file transfer completes, click on the Speech Recognition menu at the top of the EP
viewer, and select My Commands. This starts the DNS command browser.

In the DNS Command Browser window, click the Manage button

Click on the Import button. From the Windows browse window, find the folder where you saved
the command file in step 2, select the file (you may need to change the File Type to show All

If you want to remove some of the EP commands, uncheck the ones you want to exclude. When

bedded SpeechMagic package is provided as an optional plug-in module. It requires a plug-in

1.
Recognition tab.
2.
3.
4.
5.
Files) and click Open.
6. Click Yes to validate the command file.
7
ready, click on Import to import the remaining commands.
8. Close the DNS Command Browser when you are done.
8.2.4.2 Embedded SpeechMagic
The em
module

license, plus a licensed copy of SpeechMagic installed on each workstation. The embedded

package is intended to be used with a Philips SpeechMike. Other microphones are supported, but the
integrated controls are only available on the SpeechMike.
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To configure the viewer to use embedded SR, open the Customize Setting window from the Settings
menu, and click on the Speech Recognition tab. See section 0 for details. If the SpeechMagic option is

available, it means the license has been installed on the server, and a valid copy of SpeechMagic exists
on your workstation. Select it, and click OK.

When using SR, it is possible to retain a copy of the WAV file created when dictating the report. This
would be unnecessary if the user is responsible for editing the resulting text. However, if the results of the
SR processing need editing by a third party, such as by a transcriptionist, save the original recording for
validation. Check the box labeled Auto record WAV when dictating in the Customize Settings’ Speech
Recognition panel to save the WAV file.

When SpeechMagic is selected as the default dictation mode, the Speech Recognition menu appears at
the top of the viewer. This is the where you will find the SpeechMagic controls and tools. For detailed
information on each of these tools, refer to the SpeechMagic user manuals.

Menu Item Description

Synchronize on init Synchronize user file. Startup is faster with the synchronization disabled.

Adapt on save If enabled, self-learning is triggered when saving a report. If enabled,
custom report templates are disabled.

Auto-init on login Automatically log in and load user profile.

Initialize Manually log in and load user profile. Disabled if Auto-init is enabled.

Uninitialize Manually log out and unload user profile.

8.2.4.3 Embedded Fluency Direct™
M*Modal's Fluency Direct speech recognition engine translates dictated reports into text and drives
speech-driven mouse controls. The viewer supports Fluency Direct version 7.83.0.508 and later. The
interface is supported for Windows 7.

The Fluency Direct plug-in module requires a Practice Builder 1-2-3 Speech Recognition plug-in module
license. When licensed, Fluency Direct is downloaded and installed on your workstation as a plug-in
module. The package is about 50MBs, not including the dictionaries. Fluency Direct is intended to be
used with a Philips SpeechMike. Other microphones are supported, but the integrated controls are only
available on the SpeechMike.

To configure the viewer to use embedded SR, open the Customize Setting window from the Settings
menu, and click on the Speech Recognition tab. See section 0 for details. If the Fluency Direct option is
available, the license has been installed on the server and a valid copy of Fluency Direct exists on your
workstation. Enter your Fluency Direct user account ID, password and author OID in the repective fields.
Select it, and click OK.

After configuring the viewer for Fluency Direct, the installation wizard walks you through the install. When
you are successfully logged in, the floating Fluency Direct panel appears. It contains controls to configure
and test the engine.

Before using Fluency Direct, you must select and download a dictionary. This is available from the
Fluency Direct panel under Tools/Domains. The Radiology dictionary is recommended. You must also
calibrate your microphone. This tool is available from the Fluency Direct panel under
Tools/Microphone/Calibration.

For full details and troubleshooting assistance, refer to the Fluency Direct installation manual.
When using SR, it is possible to retain a copy of the WAV file created when dictating the report. This

would be unnecessary if the user is responsible for editing the resulting text. If a transcriptionist is
expected to edit the result of the SR process, save the original recording for validation. Check the box
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labeled Auto record WAV when dictating in the Customize Settings’ Speech Recognition panel to save
the WAV file.

8.2.4.4 Integrated Speech Recognition Systems

Many speech recognition systems provide an interface to pass control between a PACS viewer and the
speech recognition client application. The interface consists of an XML file written to the local file system
by the viewer and picked up by the speech recognition system. The XML file contains study details, user
IDs and other information.

Some systems using this interface are eRAD’s VR1 and VR2, and Nuance Powerscribe. In some cases,
an additional component is required. For example, Powerscribe supports this interface via its PACS
Bridge software. Check your speech recognition system’s documentation for information on setting up this
interface.

To configure the EP viewer to use this interface as the default dictation mode, the Practice Builder 1-2-3
Integrated Speech Recognition plug-in module must be licensed, the user must have permissions to load
the plug-in module, and the speech recognition’s client application plus interface module, if necessary,
must be installed and running on the workstation. Set the dictation mode as follows:

Opening the Customize Settings window from the Settings menu in the EP viewer.

Click the Speech Recognition tab.

If the plug-in license exists on the server, XML Interface Speech Recognition option

is available in the Speech Recognition System list. Select it.

Confirm your user account and password. By default, the Practice Builder 1-2-3 account ID and

password are used. If these do not match your speech recognition system’s ID and password, set

them to their correct value.

6. The speech recognition system looks for control (XML) files in a folder on the workstation. The
default file is C:\Dictaphone\study.xml. Check with your speech recognition system for the
location and file name it uses. Set the folder and filename in the XML File field.

7. Click OK to save them.

agrwONE

Note that the list of available speech recognition systems displayed on the pull down list in the Customize
Settings panel is configurable. If your system is not displayed, talk with your system administrator about
adding it.

With the speech recognition client running and the EP viewer _ Record button
configured to use it as the default dictation mode, activate it CLEMSO%T_ May 15, 2008 - MR =
by clicking the Record button in the EP viewer. The Record

button is on the Audio toolbar. You might consider creating a » J -
keyboard macro to provide a shortcut to a button on your [
microphone. The accession number and other configured Preiminary | ] Sendrepﬂﬂ| Ful |
values of the selected study are written to the configured
XML file. The speech recognition system should detect the file, read its contents, remove the XML file and
then take over the recording process.

il
L
o

At this point, consult your speech recognition’s user manual for further information. Mouse and keyboard
control generally remain with the Practice Builder 1-2-3 viewer, unless you display the speech
recognition’s user interface and give it the mouse and keyboard focus.

The report created by the speech recognition system does not appear in the EP viewer report panel
immediately. The system sends the report to Practice Builder 1-2-3 server directly, or indirectly through
the RIS.

The information written to the XML file passed from Practice Builder 1-2-3 to the speech recognition

system is configurable. Refer to the Practice Builder 1-2-3 Speech Recognition Configuration Manual for
details.
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8.2.5 ADDENDUMS

Correct or modify approved (Final) reports from the report panel by attaching an addendum to the report.
If a report or an addendum is unapproved, you can modify it. When a report or addendum is in the Final
state, the text is not editable and a new addendum section appears at the bottom of the report panel or on
a separate tab in the report panel. Enter the addendum text as you would for the initial report. Click on the
Record button to dictate an addendum, or enter text into the editable text field on the full report panel to
type an addendum.

When a user presses the Record button to start dictating, the viewer [ ]
checks to see if the report component is an addendum. If it is, the
viewer pops up a notification. The user must indicate if the viewer el B o
should insert the dictation into the addendum. Select Yes or No. This T Dorit show this warring again

setting applies to this entire session.

The main repart has already been approved

Yes No |

In the popup natice, disable this warning permanently by checking the
Don't show this warning again box. Once checked, re-activate the prompt from the Settings menu. Click
the Warn when dictating to an addendum item on the menu to clear the checkmark.

To play back an addendum’s dictation, open the full report panel, scroll down to the addendum section or
select the addendum'’s tab, and click on the Listen or Play button.

8.2.6 RESTORING A REPORT

Practice Builder 1-2-3 provides two methods for restoring a report. The first method restores the report
with the version that is presently stored on the Practice Builder 1-2-3 server. Provided you have not saved
any changes, click on the Reload Report button in the full report panel. Practice Builder 1-2-3 retrieves
the last stored report from the server.

After creating a report, communications problems between the workstation and server prevent you from
saving it to the Practice Builder 1-2-3 server. Another problem may be another user took the write
permissions (ie, the lock) from your edit session. (You would have received a notice indicating this.) To
save your work, make a temporary copy of the report on your local workstation’s disk, and restore it at a
later time so you can submit it to the Practice Builder 1-2-3 server. To save a report to your workstation,
select Save to hard disk from the report panel's Report menu or from the report toolbar. To restore it,
open the study from the worklist at a later time, open the full report panel, and click Restore saved report.
The text, dictation, key images and study state you previously saved are loaded into the report panel. You
can now submit it to the server using Send report.

8.3 Key images

Save the presentation state of a rendered image to a report by making it a key image. Key images
selected for a particular study are displayed at the bottom of the full report panel. Depending on the report
panel template, scroll to the key images or click the Expand button, |* , to expand the key image panel.
Key images can be available in the Presentation Group section of the thurmbnail panel if Show Key Image
Thumbnails is set under the Settings tab in the Customize Settings panel.

Practice Builder 1-2-3 indicates an image has been marked as a key image by displaying a key image
icon in the top left corner of the image when it is displayed in an image frame. Clicking on the icon opens
the report panel and displays the image attached to the report.

The viewer contains two key image icons: a paper clip and a key. A paper clip icon, 8 denotes that a
particular image is attached to the report and viewable on the report panel. The key icon, T, indicates
that the marked image is rendered using the same display characteristics (window/level, annotation, etc.)
as the image attached to the report. These icons allow the user to discriminate between multiple
instances of the same images attached to a report, each with a different set of parameters.
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8.3.1 ATTACHING KEY IMAGES

To save a key image in the main viewing area, do the following:

1. Select the key image attachment cursor mode button, E, in the toolbox toolbar. The cursor
changes to a paper clip.

2. Position the cursor over the image you want to save

3. Click the left mouse button. The key icon appears in the top left corner.

Make changes to the key image presentation state from the report panel. Changes made to the original
image do not change the key image.

To save the image as a second key image, modify the original image's presentation state. The icon in the
top left corner of the original image changes to a paper clip, indicating the image in the frame no longer
matches the one in the report panel. Set the cursor to key image mode and click on the image again. In
the report panel, two images appear, each with their individual display characteristics.

To automatically create a key image when annotating an image, set the Generate Key Image setting on
the Auto PS tab in the Customize Settings panel, and select the annotation tools. See section 4.1.15 for
details. The key image is created automatically when the user adds a selected annotation to an image. By
default, this feature is disabled.

To select multiple images without having to reset the cursor mode between each click, hold down the Alt
key while you click on mouse button.

In the full report panel, the number of key images attached to each report segment (main report and
each addendum) is listed in each segment’s header.

When attaching key images to a report, it is useful to label each image so you can reference them in the
report. With the text annotation tool, manually add an identifier to each key image before attaching it to
the report. It automatically drops a sequential numeric label onto each image in the report, eliminating the
need to explicitly type in a text annotation. To use the report figure numbering tool, see section 6.2.4.

8.3.2 MODIFYING KEY IMAGES

Images in the full report panel are editable, as if they were in an image frame. Open the full report panel
and change the window or level, add an annotation, change the zoom factor, etc. When modifying the
image in the report panel, there is no need to reassign it as a key image.

Alternatively, drag and drop the key image from the full report panel into any image frame to manipulate
its settings. Settings changed in an image frame are not saved unless you reselect the image as a key
image and resubmit the report. To drag an image, position the cursor over the diagonal lines in the top left
corner of the image until the cursor changes to a hand. Press and hold down the left mouse button, and
drag the image to its destination. When the cursor is over the destination image frame, release the mouse
button.

Once a report is approved, i.e., the study state is Final, images attached to a report cannot be modified.
Add an additional key image reflecting the updated settings to the addendum.

8.3.3 PRINTING KEY IMAGES

To quickly add all the key images in a report to the print panel, open the report panel, click on the Images
menu, and select Add All Key Images to Print Panel. When you open the print panel, the key images
appear in the display area. You can edit or remove any image from the print panel.

8.3.4 REMOVING KEY IMAGES
To remove a key image from the full report panel, do the following:

Page 124



((e RAD Practice Builder 1-2-3
' Viewer Manual

1. Open the full report panel.

2. Select the image

3. Press the Delete key.

4. At the prompt, confirm the delete.

To remove a key image from an image frame, the key image icon must be the key icon, T If this icon is
not displayed on the image, move it from the full report panel to an image frame. Then do the following:

1. Place the cursor over the key image icon in the top left corner of the image. The cursor changes
to a key with an ‘X’ through it.

2. Click on the icon.

3. At the prompt, confirm the delete.

It is not possible to remove a key image attached to a report segment that has been approved and is in
the Final state.

8.4 Submitting Reports

After you create any report component, including recording a dictation, adding text to the report
impression, attaching a key image, amending a report or just changing the report state, submit the report
using either of the following methods:

e Click the Send Report button, "’.
e Close the study. In the close prompt, check the Send Report box to submit the report to the
server.

When the status toolbar displays Report Sent, the server has acquired and stored the changes.

When the viewer encounters a network problem while saving a report, store it locally for submission at a
later time. Select the Save to hard disk option from the Report menu or report toolbar. Be aware that this
is not the equivalent to submitting the report to the Practice Builder 1-2-3 server. It simply saves your
work on your local machine so you can come back to it at another time. When the network problems are
resolved, open the same study. Practice Builder 1-2-3 detects the saved report, and notifies you that you
have a copy of a report on your machine. From the prompt, click Yes to import the saved report.
Everything you saved is now stored to the viewer, and can be saved to the Practice Builder 1-2-3 server.
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9 User collaboration

When multiple users need to consult with each other while viewing a study, Practice Builder 1-2-3 allows
them to share a common instance of the viewer. When a user initiates a collaboration session, his/her
viewer appears on the workstation of the invited participants, and the actions applied by any one of the
users is rendered on the other’s workstation. There is dual-cursor support so that each user can see what
the other is doing. When used in combination with a telephone, the participants can communicate and
review the same study as though they were sitting together at the same workstation.

Collaboration requires that the other participant(s) have the Practice Builder 1-2-3 viewer installed on their
workstation and running in standby mode (see section 4.1.1), and are presently logged into the same
Practice Builder 1-2-3 server under his or her own account.

Xl To establish a collaboration session, select the Connect option on
Enter session name. the Collaboration menu. A window appears, with a list of users

| connected to Practice Builder 1-2-3. At this point, there are two
options. If all the intended participants are directly accessible from
Creste new ssssion_ | the network by the server, meaning they are on the same local area
- _ network, or the network does not consist of NAT devices or other

Join existing session . . . . . . ..
—I redirection devices, the collaboration host can invite users to join. If
Invite: user fram list | Disconnect | the server cannot reach one or more of the participants, the host
must explicitly create a collaboration session and the participants

Users loggedin o server must individually join it.

Lois Laine

In the case where the server can address the workstation of each
participant, select the user you want to add to the collaboration
session and click on Invite User From List. The other user will
receive a prompt notifying him that you wish to establish a
collaboration session. If they accept the session, Practice Builder 1-
2-3 launches itself on the other user’'s workstation, and displays
what is presently displayed on your workstation.

In the case were the server cannot address the workstation, or when
the invite request fails with a message indicating the server could
not connect to the workstation, the host will have to create a session and each user will have to join it.
Start by having the host create a session name and click on Create New Session. Then have each
participant type in the same session hame and click on Join existing session. When everyone has joined
the session, the workstation screens will contain the information displayed on the host's screen.

When the connection is accepted, you will see a second cursor appear on your workstation. The white
cursor is yours. The red cursor is the cursor on the other user’s workstation. As each of you moves your
cursor, the other will see it move on his workstation. Any action you take to change the image display,
including window/level settings, scrolling, series selection, zooming, annotations, etc., will appear on the
other workstation. The collaboration session only affects the main viewing workspace. The popup
windows, including the report panel, settings windows, notices, layout manager, and print panel, are not
shared on other participant’s workstations.

At all times during a collaboration setting, one of the users is the master, meaning they have control of the
session. By default, the host is the master. For security purposes, none of the other users can obtain
control of the session without the master granting it to him. To request control, the other user simply clicks
their mouse on the workstation. A notice appears on the master’s workstation indicating that the other
user requested control of the session. The master user can either turn over control to the other user, or
deny the request. If control is passed over, then the original master must request it back using the same
technique.
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The user creating the session grants permission to users to join the session, but does not define access
restrictions to the study data. Practice Builder 1-2-3 global restrictions for the user who opened the study

are temporarily granted to all collaboration session participants. When a user leaves the collaboration
session and when the session is terminated, each user’s global restrictions revert to their usual settings.

When the session is over, either user can request to terminate the session by selecting the Disconnect
option from the Collaboration menu, or the user who established the session can close the viewer. Once
the session is terminated, the users revert to the same access to the studies as they had prior to the
collaboration session.
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10 Saving data

The Practice Builder 1-2-3 viewer allows the user to save the image data to files on the local workstation
using a limited number of standard formats.

10.1 Saving JPEG images

Users can save a copy of an image or series of images to the local file system in a JPEG formatted file by
using the Save function. Under the File menu, select Save Image to save the selected image, or Save
Series to saves all the images in the selected series to individual JPEG files. After requesting one of
these options, Practice Builder 1-2-3 pops up a window from which the user can select a destination
directory and a file name. If saving a series of images, Practice Builder 1-2-3 automatically appends a
numeric increment to the base file name and places one image in each file. The resulting file represents
the presentation state of the image when saved, including the annotations, zoom factor, window/level
setting, and all other display characteristics as they appear on the screen.

A user can also copy the selected image into the system clipboard so the image can be pasted into
another application. Select the image and choose Copy from File menu. To paste the image, open the
other application and select the paste option as defined by that application.

10.2 Saving DICOM images

To save a copy of the original DICOM image, you must use the browser interface. The Practice Builder 1-
2-3 viewer cannot save DICOM objects. From the browser interface, you can create a DICOM-conformant
media by using the Export function, downloading the resulting 1SO file to your workstation, and then
writing this to a CD or DVD using the CD/DVD writing software installed on your PC. Practice Builder 1-2-
3 does not provide an application to write the data to the CD/DVD media. Refer to the Practice Builder 1-
2-3 Operator’'s Manual for additional information.
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11 Printing

From the Practice Builder 1-2-3 viewer, you can print full-resolution images to DICOM conformant
imagers, or to ordinary printers supported by your Microsoft Windows operating system. The printing
procedure starts by selecting one or more images that are currently loaded into the Practice Builder 1-2-3
viewer, and arranging them in the print panel. For information on the print panel, see section 3.6.4 and
the section below.

You can print or hide the image overlays when you print images to either a Windows printer or a DICOM
printer. If the overlays are displayed on the screen when you request the print job, the resulting images
will display them as well. If the overlays do not appear on the images, they will not appear on the film or
paper. To display the overlays, select Show Image Information from the View menu, or hit the F10 key.

When printing images from the Practice Builder 1-2-3 viewer, if hash marks are displayed on the image,
they will appear on the printout.

If the user has defined a print header for Windows printouts, it also appears on DICOM printouts.

11.1 Print panel

To display the print panel, select Print from I E

the File menu. If no image frame or ™=

h b .l . | d h . | * Windows € DICOM Dropimage: ¢ Single % Seres ¢ Study ¢ Prompt
thumbnail is selected, the print panel opens || ot | co| 7
with no images loaded. If you have an ———" ) I._:,' —
. . Elete I=:ar Al OlE: ANCEl
image frame selected when calling up the N = Lo

Frint layouts ———————————————

print panel, Practice Builder 1-2-3 (szemoefam =]
automatically loads the images into the
panel. The number of images Practice i i i -
Builder 1-2-3 loads depends on the Drop
Image setting. Practice Builder 1-2-3 either
loads the selected image, the entire series,
the entire study, or prompts the user to
select an image range.

To load additional images into the print
panel, position the cursor over the drag
icon (diagonal lines in the top left corner of
the image) in the image frame. The cursor
changes to a hand. Hold down the left ! - % A “\
mouse button, drag the image over the print =l

panel and release the mouse button. You can also drag the frame from the thumbnail panel into the print
panel. The images in the print panel appear in a tile mode, meaning they are not stacked. Use the scroll
bar on the right of the window to see all of the images.

When adding images to the print panel, you can insert every N" image. Set the X
selection type to Prompt. When you drop a series onto the print panel, a popup window & ssectinage rangs

appears. The viewer loads the image specified in the From field, and then every N e =

image based on the Skip value, until the number in the To field is reached. By default, = mel
the Skip value is set to 1, meaning every image is included in the print panel. To -
include images that were skipped, change the upload selection to Single, find the ' #
specific image in the main viewer area or thumbnail panel, and drag and drop it in

place. Carcel |

" Drop imagels] on top
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To remove any or all images in the Print window, click to select the image and then click on the Delete

button. If you want to clear all the images, click on the Clear All button. It is not possible to delete more
than one image at a time with the exception of deleting all the images.

If you need to reorganize the images in the Print window, click on the image’s top left corner and drag it
from its current location and drop it into the destination position.

11.2 Print Layout Templates

Two methods exist for defining print layouts. Users with administrator permissions can define system-
wide print layouts for DICOM printers, available in all viewer sessions to users with printing privileges.
Details for this method are contained in the Practice Builder 1-2-3 DICOM Print Configuration Manual.

Users can customize their own print layouts using the print layout templates. These are user-specific
templates stored in the user’s profile. They define specific options such as film sheet layout, film type and
a specific printer.

11.2.1 CREATING A PRINT LAYOUT TEMPLATE
To create or modify a print layout template, load a study into the viewer and perform the following steps:

1. Select File->Print to open the print panel. Save Print Loyout =
2. Select the printer type: Windows or DICOM. Enterthe name o he i
3. From the printer list, select the printer. [124p 1617 Bk
4. Define printer-specific settings. The available options and procedure for 7 Avaablefor spectic modslts
setting them depend on the printer type and default printer. Refer to the
print panel documentation for additional details.
5. Click the Save button, E in the Print Layouts toolbar in the print panel. Use o defat o these modltes
6. Inthe Save Print Layout window, enter the label assigned to the current i
settings.
7. If this layout applies to specific modality types, check the box labeled
Available for specific modalities and select the modalities from the list. |

8. If this layout is the default layout for one or more modality types, select
them from Use as default for these modalities list.
9. Click OK.

Print layouts save the following information:

Printer type
Printer
For Windows printers
o0 Rows
o Cols
o0 All settings defined by clicking the Settings button
For DICOM printers
0 All settings defined by clicking the Settings button

Print layout templates can be copied from one user account to another. See the Practice Builder 1-2-3
Operator’'s Manual for details.

11.2.2 APPLYING A PRINT LAYOUT TEMPLATE

To apply an existing print layout template, including the built-in system default (labeled *System Default),
do the following:

1. Select File=>Print to open the print panel.
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2. From the Print Layouts toolbar, select the template you want to apply. The assigned settings are
applied.

3. Modify the templates settings by editing them. These changes apply to this current print session
and will not be saved.

11.2.3 DELETING A PRINT LAYOUT TEMPLATE
To remove a defined print layout template from your profile, do the following:

1. Select File->Print to open the print panel.
2. From the Print Layouts toolbar, select the template you want to delete.

3. Click the delete button, ﬂ in the Print Layout toolbar.

11.3 DICOM Printing

When printing to a DICOM printer, select DICOM in the print panel. This enables all of the DICOM printing
options. The pull-down menu lists all of the available DICOM printers. Select the printer you want to send
the print job to, and the Layout. The Layout shows the number of columns and rows on a printed sheet of
film. The options are represented as column, row.

To review the default printer parameters as defined in the printer configuration file on the server, click on
the Settings button. In most cases, the default settings are defined to work with the selected printer and
changes should not be necessary. However, there are times when you may want to change a setting for a
single print job. Modifying the parameters from this window changes them for the current print job. If you
wish to make the change permanent, you must have the system administrator change the setting on the
server.

The DICOM print settings consist of three tabbed pages. The Film page contains the settings that apply to
the film itself. The Session page contains the settings that apply to the entire print job. The Others page
contains miscellaneous settings. Each of these settings is described in the table below.

Many of the settings contain an option to use the default. The default is a value defined in the DICOM
printer configuration file. This file is created by the systems administrator, and is available from the Server
page in the browser interface. The default settings are usually the best option. Only override the default
when you know how it will affect your results.

Page Setting Parameters Description
Film Film Orientation  Portrait, Landscape Specifies the orientation of the film. Default is usually portrait.
Trim Trim, No Trim Specifies whether the film sheet is to contain trim. The default
is usually no trim.
Layout Rows, Columns Layout options configured for this printer.
True Size Printer specific Print the images at their true dimensional size.
Decimate/Crop Request crop, Request Specified what happens to the image when it does not fit
behavior decimate, Request fail within the defined boundaries of the image box.
Presentation LUT Identity Not used.
lllumination Set presentation LUT illumination field to the defined value.
Default is 2000.
Reflection Set presentation LUT reflection field to the defined value.
Default is 10.
Session Film session Copies The number of copies to request.
options Destination If the DICOM printer supports multiple destinations, indicate
which one to request.
Priority Specify the print priority, if supported.
Owner Indicate the owner of the print job.
Annotation Annotation Submit this value to the printer to use as annotation. The
options application of this string depends on the printer.
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_Page Setting Parameters Description
Prepend date Prepend the date to the annotation added by the printer.
Prepend printer name  Prepend the printer name to the annotation added by the
printer.
Prepend illumination Prepend the illumination information to the annotation added
by the printer.
Medium type Blue film, Clear film, Specifies the type of medium to use in the print request. The
paper application of this value depends on the capabilities of the
printer.
Film session Print this value as a header to each sheet printed. By default,
label this contains the information specified in the print header
defined on the Customize Settings’ DICOM field page.
Others  Film size ID Printer specific Specify the default film size.

Magnification

Printer specific

Specify the default zoom factor applied. This is in addition to
any zoom factor already applied to the image when it is
loaded into the print panel.

Smoothing type

Printer specific

Specify the smoothing algorithm to use when interpolating the
data.

Border density

Printer specific

Specify the density of the border. Usually a value of BLACK or
WHITE is sufficient.

Resolution ID

Printer specific

Specify the resolution identifier.

Config info Printer specific Printer-specific configuration parameter to send to the printer.
Empty image Printer specific Optical density to use in areas where no image exists.
density

Max density Printer specific Maximum density to use when printing.

Min density Printer specific Minimum density to use when printing.

Image box Printer specific Override the default magnification for a specific image.
magnification

type

Image box Printer specific Override the default smoothing type for a specific image.

smoothing type

Image box config Printer specific Override the default printer-specific configuration parameter
info for a specific image.

The one notable print setting is the header used on the printed sheet. The default print header is defined
on the Customize Settings panel, under the DICOM Fields tab. Change the default string by editing it in
the print panel. Whatever appears in this field will appear at the top of each sheet of film. In order to
appear on the film, the DICOM printer must support the Field Session Label feature.

After selecting the printer, the layout and confirming the printer settings, if necessary, click on Print to
initiate the print job. A popup window appears notifying you that the print request is in process. Depending
on the type of printer, a print request may take a long time. When the printer confirms it has received all
the information and can proceed with the print job, Practice Builder 1-2-3 pops up a notice indicating the
reguest is complete. If any errors occurred, an error message appears.

It is possible to obtain detailed information exchanged between the Practice Builder 1-2-3 viewer and the
printer during a DICOM print session. This is only necessary when some anomaly occurs, and the print
request failed. To enable print logging, open the Customize Settings window from the Settings menu, and
go to the Advanced page. Make certain the value in the Keep the last N DICOM print log files is greater
than zero. Print logs are stored in the c:\Program Files\PracticeBuilder\dicomprint\logs directory. If print
problems exist, a customer support representative may request these files.

11.3.1 TRUE SIZE PRINTING

Practice Builder 1-2-3 supports true size printing via its DICOM print interface. The parameter in the
printer-specific section(s) of the DICOM Print configuration file, TrueSize, controls this setting. Refer to
the the Practice Builder 1-2-3 DICOM Printer Configuration Manual for details on DICOM printer
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configuration. When set to “true”, print jobs submitted to this printer will be printed true size. To override

this setting, open the print panel click on the DICOM Settings button, and on the Film tab, check the True
Size box to print the image(s) in true size, or clear it to let the print size the images accordingly.

11.4 Windows Printing

When printing to a Windows printer, select Windows in the print panel. The printer and printer settings are
available from the Windows print panel that appears after clicking the Print button. The print layout
settings are available from the print panel.

The rows and columns settings applied to the print request are available on the print panel. Select the
number or rows and columns you want to appear on the printed sheet. Note that the images displayed in
the print panel do not necessary conform to this setting.

The default Windows printer settings are configurable for each modality type. To modify the built in default
values, do the following:

1. Select File>Print to open the Print Panel. I g
2. Select Windows as the printer type.
3. To configure default settings, click the Settings button. The Windows .
Printer Settings panel pops up. ; o
a. Inthe Settings For list, select the modality. Use Default to e [ 73]
configure the system default values.
b. To use the modality-independent values for the selected T o |

modality, check the Use Default Settings box. Otherwise,
define the settings for the selected modality. The available settings are:
i. Cols — number of columns on each sheet of film/paper.
ii. Rows —number of rows on each sheet of file/paper.
4. To override the default rows and columns settings, select them from the Rows and Cols fields on
the print panel.
5. Click OK.

To preview the print results, click on the Preview button. In the popup window, select the printer and click
on OK. A new popup appears showing you what the results should be on the selected Windows printer.
You can either select to continue the print from this point, or cancel out to return to the Practice Builder 1-
2-3 print panel and click on Print to execute the print job.

11.5 Printing Reports

Practice Builder 1-2-3 can print a copy of the report directly from the viewer to a printer connected to your
PC. To print the report, open the full report panel. From the top of the report panel window, select Report
and then click on Print. Your standard print window will appear. Click on OK to send the report and the
attached key images to the printer.
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12 Online Help and Troubleshooting

Practice Builder 1-2-3 viewer has integrated help files explaining the features and functions of the
software, plus data collection capabilities when more in depth assistance is required.

12.1 Online Help

Practice Builder 1-2-3 provides an online help system that provides assistance to users while they are
using the interface. The online help contains a searchable database containing information on many
topics and features, plus a summary of the latest features available in the viewer. From the online help,
you can also obtain details on the version of the Practice Builder 1-2-3 viewer you are running, which can
be requested if you need to contact support for assistance.

In the event the online help does not provide enough information on the requested topic, please consult
the written documentation.

To display the release news, select News from the Help menu. A window appears containing links to a
number of subjects, arranged in functional groups. To obtain details on any particular topic, click on the
link.

To display the complete help system, select Contents from the Help menu. A window appears consisting
of some tabbed pages. The Contents section is an organized collection of the help subjects. This
information is useful if you need to obtain an overview of some area of Practice Builder 1-2-3. For
information on a single topic, select the Index tab, and type the subject in the field provided. When you
find the specific, double click to open the detailed information on the topic. To get back to the Index,
select Help Topics from the details page.

To obtain details about the specific version of the Practice Builder 1-2-3 viewer installed on your
workstation, select About Practice Builder 1-2-3 from the Help menu. If asked by a customer support
representative which version of the Practice Builder 1-2-3 viewer you have installed on your machine,
provide the version number (and the build revision if specified) listed in the popup window.

12.2 Activity Logs

Activity logs record every action performed during a viewer session, including user profile details and
information about studies loaded into the viewer, and ending when the session ends. This information is
used by support to play back the entire viewer session, to determine what actions were performed and
reproduce an anomaly, if present.

Since activity logging can negatively impact the viewer's performance, it is disabled by default. Enable it
from the Settings page in Customize Settings. Check the box labeled Create Log Files. Log files are
stored in C:\Program Files\PracticeBuilder\PBLogFiles. The filename contains the starting date and time
of the viewer session. Log files are purged when they are four days old, or one day after being uploaded
to the server.

Practice Builder 1-2-3 servers version 6.0 and later automatically upload activity logs to the server when
the viewer encounters an ungraceful termination, i.e., when the viewer crashes. The viewer takes longer
to load the first time after a crash because these logs may be large, or the network upload speed may be
slow. Uploaded log files are appended with the extension .sent. Support can access uploaded files from
the server. Files that were not uploaded, specifically when using a Practice Builder 1-2-3 server prior to
version 6.0, have to be collected by the user and sent to support, when requested.
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12.3 Crash Logs

When the Practice Builder 1-2-3 viewer experiences an ungraceful termination, it can create a crash log.
This log file contains details about the viewer session and the point at which it terminated. Crash logs are
useful for support in identifying causes for unexpected anomalies in the viewer.

Crash log generation is enabled by default. To change this setting, clear the checkbox labeled Create
Crash Dump on the Settings page in the Customize Settings window. Crash logs are stored in
C:\Programe Files\PracticeBuilder\PBLogFiles. The crash log contains the starting date and time of the
viewer session. Log files are purged one day after being uploaded to the server, or not at all.

Practice Builder 1-2-3 servers version 6.0 and later automatically upload crash logs to the server when
the viewer restarts. Uploaded crash logs are appended with the extension .sent. Support can access
uploaded files from the server. Files that were not uploaded, specifically when using a Practice Builder 1-
2-3 server prior to version 6.0, have to be collected by the user and sent to support, when requested.
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